Investigation of Pathogenic Determinants in *Vibrio harveyi* and Screening of Antagonistic Bacteria for Control of Its Infection

Pimonsri Rattanama

A Thesis Submitted in Partial Fulfillment of the Requirements for the Degree of Doctor of Philosophy in Biomedical Sciences
Prince of Songkla University
2010
Copyright of Prince of Songkla University
Thesis Title: Investigation of pathogenic determinants in *Vibrio harveyi* and screening of antagonistic bacteria for control of its infection

Author: Miss Pimonsri Rattanama

Major Program: Biomedical Sciences

Major Advisor:  

Examining Committee:  

Chairperson  
(Asst. Prof. Dr. Channarong Rodkhum)  

(Assoc. Prof. Dr. Varaporn Vuddhakul)  

(Asst. Prof. Dr. Decha Sermwittayawong)  

The Graduate School, Prince of Songkla University, has approved this thesis as partial fulfillment of the requirements for the Doctor of Philosophy Degree in Biomedical Sciences

(Assoc. Prof. Dr. Krerkchai Thongnoo)  
Dean of Graduate School
ABSTRACT

Vibrio harveyi is the causative agent of luminous vibriosis, which leads to a massive loss in shrimp industry worldwide. However, virulence factors of this bacterium are not completely understood. In this study, V. harveyi from marine samples were isolated and confirmed by PCR targeted to gyrB gene. Thirty-six out of 40 bacterial isolates were positive. These V. harveyi, V. harveyi HY01 isolated from a shrimp that died from vibriosis and an ocean isolate of V. harveyi BAA-1116 were investigated for their pathogenicity in shrimp. Correlations between shrimp mortality, hemolysis, the presence of a hemolysin gene (vhh), and a gene involved in the type III secretion system (the Vibrio calcium response gene vcrD) were also determined. Thirteen isolates including V. harveyi HY01 caused shrimp death within 12 h after injection. Most V. harveyi isolates in this group (designated as Group A) caused hemolysis on prawn blood agar. None of the shrimp died after injection with V. harveyi BAA-1116. Molecular analysis of all V. harveyi isolates revealed the presence of vhh in all V. harveyi isolates however some isolates did not cause hemolysis, indicating that vhh gene expression might be regulated. Moreover, vcrD was detected in both pathogenic and non-pathogenic strains. Analysis of the V. harveyi HY01 genome revealed a homologue (86% homology) of hlyA gene (designated as hhl), encoded for hemolysin, of the human pathogenic bacteria V. cholerae. Specific primers designed for hhl detected this gene in 3 additional V. harveyi isolates but the presence of this gene was not correlated with pathogenicity in shrimp. This is the first report to demonstrate the presence of hlyA–like hemolysin gene in V. harveyi, although our result indicated that presence of this gene did not correlate at least with fatality in shrimp. The presence of this gene and its correlation in V. harveyi pathogenicity should be further investigated. Random amplified polymorphic DNA (RAPD) analysis revealed a high degree of genetic diversity in all V. harveyi isolates, and there were no correlations among the hhl–positive isolates or the pathogenic strains. To confirm correlation between hemolytic activity and mortality of shrimp caused by V. harveyi, transposon mutagenesis was performed. Out of 1,764 mutants screened, five mutants caused low hemolytic activity on sheep blood agar and exhibited virulence attenuation in the shrimp.
Sequence analysis revealed that the gene encoding RseB, a negative regulator of the sigma E factor ($\sigma^E$), was interrupted in 2 out of 5 mutants. Therefore, rseA, rseB and rpoE mutants were constructed by gene disruption technique and were evaluated for their hemolytic activity and virulence in shrimp. In vitro, rseA and rseB mutants exhibited low hemolytic activity in sheep blood agar. In vivo, using competition assay, shrimp were injected with mixed culture of wild-type and the mutant strains, virulence of rseA and rseB mutants was three- to seven-fold lower than V. harveyi wild type. 2-D gel electrophoresis of whole cell extracted proteins from rseA mutant revealed a decreased protein (outer membrane protein N), which probably involved in reduction of hemolytic activity of the mutant. This is the first report of the role of rpoE operon in the hemolytic activity of V. harveyi. Its involvement in hemolytic activity should be confirmed in other pathogenic Vibrio spp. such as V. cholerae, V. vulnificus and V. parahaemolyticus.

Bacteria isolated from marine sediments at Koh Yor, Hat Yai were investigated for inhibitory activity against V. harveyi using cross streak and co-cultured techniques. Two isolates designated as PB15 and PB42 could inhibit growth of V. harveyi completely. By 16S rRNA gene sequence analysis, they were identified as Bacillus subtilis and B. amyloliquefaciens, respectively. Using these bacteria to control V. harveyi will benefit shrimp industry.
ชื่อวิทยานิพนธ์  การศึกษาปัจจัยก่อโรคในเชื้อ Vibrio harveyi และการคัดเลือกแบคทีเรียปฏิปักษ์เพื่อควบคุมการติดเชื้อ

ผู้เขียน นางสาวพิมลศรี รัตนมา
สาขาวิชา ชีวเวชศาสตร์
ปีการศึกษา 2552

บทคัดย่อ

เชื้อ Vibrio harveyi เป็นสาเหตุของโรคเรืองแสง ซึ่งก่อให้เกิดความเสียหายอย่างรุนแรงในอุตสาหกรรมการเลี้ยงกุ้งทั่วโลก อย่างไรก็ตามปัจจัยที่เกี่ยวข้องกับการก่อโรคของเชื้ออย่างไม่เป็นที่ทราบแน่นอน การศึกษาครั้งนี้จึงได้ทำการคัดแยกเชื้อจากตัวอย่างอาหารทะเล และนำเชื้อด้วยวิธีปฏิบัติการคอลลิเซ็มไปติดตาม (PCR) โดยใช้เทคนิค A2B3 ซึ่งมีจีน gyrB เป็นจีนเป้าหมายได้เชื้อ V. harveyi ทั้งหมด 36 โคลีน จากนั้นทำการศึกษาความสามารถในการก่อโรคของเชื้อ V. harveyi ที่คัดแยกได้ทั้งหมด รวมทั้งเชื้อ V. harveyi สายพันธุ์ HY01 ที่คัดแยกได้จากกุ้งที่ตายจากโรค vibriosis และเชื้อ V. harveyi สายพันธุ์ BAA-1116 ที่คัดแยกได้จากน้ำทะเล นอกจากนี้ยังได้ทำการศึกษาความสัมพันธ์ระหว่างการตายของกุ้ง การปรากฏของจีนควบคุมการสร้างฮีโมไลซิน (vhh) และจีนที่เกี่ยวข้องในระบบ type III secretion system (Vibrio calcium response gene vcrD) ในเชื้อ V. harveyi จำนวน 36 โคลีน และสายพันธุ์มาตรฐาน 2 โคลีนที่กล่าวมามาด้วย พบว่าเชื้อ V. harveyi จำนวน 13 โคลีนสามารถทำให้กุ้งตายภายใน 12 ชั่วโมงหลังฉีดเชื้อ ซึ่งเชื้อ V. harveyi ที่จัดอยู่ในกลุ่ม (กลุ่ม A) จำนวน 13 โคลีนสามารถทำให้เม็ดเลือดของกุ้งแตกได้ และไม่พบกุ้งตายหลังการฉีด เชื้อ V. harveyi สายพันธุ์ BAA-1116 จากการตรวจสอบพบเชื้อ vhh ในเชื้อ V. harveyi ทุกโคลีน แต่บางโคลีนไม่สามารถทำให้เม็ดเลือดของกุ้งแตก จึงคาดว่าจะมีการควบคุมการแสดงออกของจีน vcrD ที่สามารถตรวจสอบได้ในเชื้อ V. harveyi ทุกโคลีน ไม่ว่าจะเป็นโคลีนที่ก่อโรคเรืองแสง หรือไม่ก่อโรค นอกจากนี้การศึกษาจีน vhh ในเชื้อ V. harveyi สายพันธุ์ HY01 พบเชื้อ hhl ซึ่งมีลำดับเบสคล้ายคลึง (ความเหมือน 86%) กับจีนควบคุมการสร้างฮีโมไลซิน hlyA ในเชื้อ V. cholerae ซึ่งก่อโรคในมนุษย์ และมีการตรวจพบจีน hhl ในเชื้อ V. harveyi อื่น ๆ อีกจำนวน 3 โคลีน แต่ไม่พบความสัมพันธ์ระหว่างการปรากฏของจีน hhl กับความสามารถในการก่อโรคของเชื้อ การศึกษาพบว่าเชื้อทุกโคลีนที่มีการตรวจสอบได้ในเชื้อ V. harveyi นี้มีวัฏจักรที่ไม่เหมือนกันที่ก่อการตายของกุ้ง แต่ก็จำเป็นที่จะต้องศึกษาความสัมพันธ์ของจีน vhh ที่เกี่ยวข้องกับการก่อโรคของเชื้อ V. harveyi ซึ่งมีการศึกษาด้วยเทคนิคพีอาร์ที่ได้รับผลดีที่สุดในเชื้อ V. harveyi ที่มีการเน้นกลุ่มผู้ก้าวร้าว ซึ่งได้ชื่อว่าเป็นกลุ่มผู้ก้าวร้าวที่มีการควบคุมการติดเชื้อ V. harveyi ไม่พบในเชื้อที่ไม่ก่อโรค แต่ก็จำเป็นที่จะต้องให้กุ้งตายหลังการฉีดเชื้อ V. harveyi ทุกโคลีนที่มีการตรวจสอบได้ hhl กับกุ้งเม็ดเลือดเชื้อ ที่ก่อโรคในกุ้ง การศึกษาดังกล่าวจึงนำไปสู่การทดสอบยืนยันความสัมพันธ์ระหว่างความสามารถของเชื้อ V. harveyi ในการทำให้เม็ดเลือดแตก และการทำให้กุ้งตายได้เร็วกว่า
transposon mutagenesis วิธีดังกล่าวสามารถสร้างเชื้อ V. harveyi กลายพันธุ์ได้ทั้งหมด 1,764 ไอโซเลทซึ่งพบว่าเชื้อจำนวน 5 ไอโซเลท มีความสวยงาม ในการทำให้มีมิติเลือดแตกที่กว่าเชื้อ wild type และเชื้อกลางพันธุ์นั้นยังมีความสามารถในการก่อโรคในฉลามแดงเมื่อเปรียบเทียบกับเชื้อ wild type จากการวิเคราะห์เชื้อกลางพันธุ์โดยการทดลองพบว่าเชื้อกลางพันธุ์จำนวน 2 ไอโซเลทจาก 5 ไอโซเลท มีการแทรกด้วยทรานสโพซอนอย่างต่อเนื่องที่ควบคุมการทำงาน RseB ซึ่งทำหน้าที่เป็น negative regulator ของโปรตีน sigma E (σE) ดังนั้นจึงได้ทำการสร้างเชื้อกลางพันธุ์ในส่วนของจีน rseA, rseB และ rpoE โดยวิธี gene disruption จากนั้นศึกษาความสามารถในการทำให้เม็ดเลือดแตก และการก่อโรคในฉลาม จากการศึกษาพบว่า การกลายพันธุ์ในส่วนของจีน rseA และ rseB ทำให้ความสามารถในการทำให้เม็ดเลือดแตกลดลง การทดสอบความสามารถในการก่อโรคในฉลามโดยวิธี competition assay ทำได้โดยการเรียงลำดับระหว่างเชื้อ V. harveyi wild type และ V. harveyi ที่กลายพันธุ์เข้าไปในฉลาม ซึ่งเชื้อที่มีการกลายพันธุ์ในส่วนของจีน rseA และ rseB มีความสามารถในการก่อโรคในฉลามน้อยกว่าเชื้อ wild type 3-7 เท่า การศึกษาความแตกต่างของโปรตีนในเจลสองทิศทาง (2-D gel electrophoresis) พบว่าเชื้อ V. harveyi ก่อนที่จะมีการลดลงของโปรตีน outer membrane protein N ซึ่งอาจเกี่ยวข้องกับการลดลงของความสามารถในการทำให้เม็ดเลือดแตก การศึกษาเป็นการศึกษาเบื้องต้นที่อธิบายบทบาทของจีนในกลุ่ม rpoE โดยเปรียบเทียบการทำให้เม็ดเลือดแตกในเชื้อ V. harveyi ซึ่งความเกี่ยวของกลุ่มทำให้มีความแตกแยกนั้นเป็นสิ่งที่มีการศึกษาเพิ่มเติมในเชื้อกลุ่ม vibrio ก่อโรคอื่น ๆ เช่น V. cholerae, V. vulnificus และ V. parahaemolyticus

ในการศึกษาขึ้นได้ที่การคัดแยกเชื้อแบคทีเรียจากตะกอนดินบริเวณเกาะยอหาดใหญ่ จ. สงขลา และศึกษาความสามารถในการยับยั้งเชื้อ V. harveyi ก่อโรคโดยวิธี cross streak และ co-culured พบรดาเชื้อ V. harveyi ได้ทั้งหมด 2 ไอโซเลทคือ PB15 และ PB42 สามารถยับยั้งเชื้อ V. harveyi ได้ทั้งหมด จากการจำแนกเชื้อแบคทีเรียจากแตกต่างของจีน 16S rRNA พบว่าเป็นเชื้อ Bacillus subtilis และ B. amyloliquifaciens ตามลำดับ ทั้งนี้เชื้อทั้งหมดถูกนำมาทำการคัดแยกเชื้อ V. harveyi เพื่อ可用于控制 V. harveyi 的应用。
CHAPTER 1

INTRODUCTION

BACKGROUND AND RATIONALE

_Vibrio harveyi_ is one of several closely-related species of _Vibrio_ reported to cause luminous vibriosis worldwide (Alvarez et al. 1998; Jiravanichpaisal and Miyazaki 1994; Pizzutto and Hirst 1995). Highly virulent _Vibrio_ strains have caused disease outbreaks with up to 100% mortality in the shrimp, _Penaeus monodon_ (Harris and Owens 1997; Liu et al. 1996a) and _Penaeus japonicus_ (Liu et al. 1996b). However, the mechanisms of pathogenesis in luminescent vibrios are not clearly understood and are likely mediated in part by strain-specific virulence factors. Many virulence factors implicated in vibriosis especially the extracellular products (ECPs) such as cystein proteases, cytotoxin, lipase, phospholipase, chitinase and hemolysin (Liu et al. 1996b; Montero and Austin 1999). Differences in pathogenicity between isolates of _V. harveyi_ have been reported, however the role of ECPs in the virulence of _V. harveyi_ has not been fully determined. Hemolysin has been proposed as an important mechanism in promoting virulence in _V. harveyi_. _V. harveyi_ isolated from diseased penaeids were more virulent to tiger prawns and showed higher hemolytic activities against sheep and fish erythrocytes compared with non-virulent isolates from seawater or diseased _Talorchestia_ sp. (Liu et al. 1996a). _V. harveyi_ hemolysin (VHH) is encoded by the _vhh_ gene (Zhang et al. 2001) and homologous to hemolysin in TLH family including lecithinase LEC of _V. cholerae_ (64.3%) (Fiore et al. 1997), Lecithinase PHL of _V. mimicus_ (65.3%) (Kang et al. 1998), TLH or LDH of _V. parahaemolyticus_ (85.6%) (Shinoda et al. 1991) and VPL of _V. vulnificus_ (75.6%). Purified VHH protein is virulent to fish and the disruption of the VHH active site results in loss of hemolytic activity (Sun et al. 2007). However, Zhang et al. (2001) demonstrated that although _V. harveyi_ (VIB645) containing a duplication of the _vhh_ gene caused highest hemolytic activity to fish erythrocytes, VHH production did not increase implicating additional virulence factors in the mediation of _V. harveyi_ virulence (Zhang et al. 2001). Recently, Parvathi et al. (2009) demonstrated that the _vhh_ gene is detected in _V. harveyi_ isolates from both healthy shrimp, and those manifesting luminescent vibriosis suggesting that the _vhh_ hemolysin is not specifically associated with disease. Further study is needed to resolve the controversies between the pathogenicity of _V. harveyi_ and its ability to cause hemolysis. In addition to the ability of _V._
*V. harveyi* to cause hemolysis, virulence of *V. harveyi* may be controlled by quorum sensing mechanism involving the type III secretion system (TTSS) (Henke and Bassler 2004a). TTSS is a bacterial system that transfers effector virulence proteins across the membrane of the bacterial pathogen into the cytoplasm of the host cells and has a crucial role in host–pathogen interactions. The TTSS gene cluster in *V. harveyi* includes *vop*, *vsc* and *vcr*, which encode a *Vibrio* outer membrane protein, *Vibrio* secretion and *Vibrio* calcium response protein, respectively (Henke and Bassler 2004a). *vcrD* is homologous to the low calcium response gene *lcrD*, a conserved gene encoding an essential component of the secretion apparatus in *Yersinia* spp., and *lcrD* homologs are present in all known TTSSs (Hueck 1998). In this study, the correlations between *V. harveyi* pathogenicity in a shrimp model, hemolysis and the presence of *vhh* hemolysin genes and *vcrD* gene, a gene involved in the TTSS of *V. harveyi* were investigated. To identify the additional factors that may mediate the hemolytic activity of *V. harveyi*. The genes that control hemolytic activity in *V. harveyi* were investigated by transposon mutagenesis. To investigate this further we have carried out targeted mutagenesis, *in vitro* and *in vivo* activity assays and proteomic analysis to identify genes differentially expressed in wild-type strain and non-hemolytic mutants.

Use of antibiotics in aquaculture for treatment of diseases leads to the development of drug resistant bacteria and reduced efficacy of antibiotic treatment for human and animal diseases (Moriarty 1997). Therefore, the alternative prevention methods, including the use of non-pathogenic bacteria as probiotic biocontrol agents were suggested (Austin et al. 1995; Moriarty 1997). Several studies have suggested that marine bacteria can be used to combat epizootics in aquaculture systems (Abraham et al. 2001; Douillet and Langdon 1994; Maeda and Liao 1992; Maeda et al. 1997). The present study investigated the inhibitory activity of bacteria isolated from marine sediments, against pathogenic *V. harveyi* under *in vitro* condition.
LITERATURE REVIEWS

Family Vibrionaceae

The family Vibrionaceae has been classified in order γ-proteobacteria (Veron 1965). Previously, this family comprised of eight genera, Vibrio, Allomonas, Catenococcus, Enterovibrio, Grimontia, Listonella, Photobacterium and Salinivibrio (Garrity et al. 2002). However, on the basis of concatenated 16S rRNA, recA, rpoA gene sequences and phenotypic data, this family now comprises of only genus Vibrio (Thompson et al. 2005). Bacteria in this genus Vibrio are halophilic and are described as gram negative, oxidase-positive (except Vibrio metschnikovii and V. gasogenes), motile with polar flagella (Krieg and Holt 1984). They are predominantly in seawater, planktons and marine animals. In addition, some species of Vibrio are important pathogens for humans and animals (West et al. 1986).

Genus Vibrio

Taxonomy

Previously, identification of vibrios used phenotypic characteristics (Baumann et al. 1984; Farmer III and Hickman–Brenner 1992). However, there is a huge variation of phenotypic features of vibrios, therefore, other techniques such as 16S rRNA and housekeeping genes analysis have been applied for differentiation species of vibrios (Sawabe et al. 2007). The genus Vibrio includes more than 70 species and its taxonomy is continuously being updated as new species are being detected by molecular taxonomic techniques. In vibrios, strains of the same species share more than 95% gene sequence similarity in Multilocus sequence analysis (MLSA) and more than 99.4% amino acid identity based on the eight protein-coding housekeeping genes (Sawabe et al. 2007). Those genes were encoded for 16S rRNA, recombination repair protein (recA), urytidate kinase (pyrH), glyceraldehyde 3-phosphate dehydrogenase (gapA), actin–like cytoskeleton (mreB), cell division protein (ftsZ), DNA gyrase B subunit (gyrB), and topoisomerase I (topA). Using MLSA, 13 distinct clades of vibrios have been proposed (Table 1).
Table 1 Clades of vibrios proposed by MLSA.

<table>
<thead>
<tr>
<th>Clade</th>
<th>Species included</th>
<th>Habitat</th>
</tr>
</thead>
<tbody>
<tr>
<td>Anguillarum</td>
<td><em>V.anguillarum</em>, <em>V. aestuarianus</em>, and <em>V. ordalii</em></td>
<td>Brackish water, seawater, and fish</td>
</tr>
<tr>
<td>Cholerae</td>
<td><em>V. cholerae</em>, <em>V. cincinnatiensis</em>, <em>V. furnissii</em>, <em>V. fluvialis</em>, <em>V. metschnikovii</em>, and <em>V. mimicus</em></td>
<td>Brackish water and seawater</td>
</tr>
<tr>
<td>Coralliilyticus</td>
<td><em>V. coralliilyticus</em> and <em>V. neptunis</em></td>
<td>Seawater, bivalves, and rotifers</td>
</tr>
<tr>
<td>Diazotrophicus</td>
<td><em>V. diazotrophicus</em> and <em>V. hispanicus</em></td>
<td>Brackish water and seawater</td>
</tr>
<tr>
<td>Gazogenes</td>
<td><em>V. aerogenes</em>, <em>V. gazogenes</em>, and <em>V. ruber</em></td>
<td>Estuary and salt mud</td>
</tr>
<tr>
<td>Fischeri</td>
<td><em>V. fischeri</em>, <em>V. logei</em>, <em>V. salmonicida</em>, and <em>V. wodanis</em></td>
<td>Seawater, squid, and fish</td>
</tr>
<tr>
<td>Halioticoli</td>
<td><em>V. halioticoli</em>, <em>V. ezurae</em>, <em>V. gallicus</em>, <em>V. neonatus</em>, and <em>V. superstes</em></td>
<td>Gut of abalone</td>
</tr>
<tr>
<td>Harveyi</td>
<td><em>V. harveyi</em>, <em>V. alginolyticus</em>, <em>V. campbellii</em>, <em>V. mytili</em>, <em>V. natriegens</em>, <em>V. parahaemolyticus</em>, and <em>V. rotiferianus</em></td>
<td>Seawater, salt marsh mud, and marine animals</td>
</tr>
<tr>
<td>Nereis</td>
<td><em>V. nereis</em> and <em>V. xuii</em></td>
<td>Seawater and shrimp</td>
</tr>
<tr>
<td>Nigripulchritudo</td>
<td><em>V. nigripulchritudo</em> and <em>V. penaeicida</em></td>
<td>Seawater and shrimp</td>
</tr>
<tr>
<td>Orientalis</td>
<td><em>V. orientalis</em>, <em>V. brasiliensis</em>, <em>V. hepatarius</em>, and <em>V. tubiashii</em></td>
<td>Brackish water and seawater</td>
</tr>
<tr>
<td>Scopthalmi</td>
<td><em>V. scophthalmi</em> and <em>V. ichthyoenteri</em></td>
<td>Gut of flat fish</td>
</tr>
<tr>
<td>Splendidus</td>
<td><em>V. splendidus</em>, <em>V. chagasii</em>, <em>V. crassostrea</em>, <em>V. cyclitrophicus</em>, <em>V. fortis</em>, <em>V. gigantis</em>, <em>V. kanaloaei</em>, <em>V. lentus</em>, <em>V. pelagius</em>, <em>V. pomeroyi</em>, and <em>V. tasmaniensis</em></td>
<td>Seawater and marine animals</td>
</tr>
<tr>
<td>Vunficus</td>
<td><em>V. vulnificus</em> and <em>V. navarrensis</em></td>
<td>Sewage, seawater, eel, and oyster</td>
</tr>
</tbody>
</table>

[Source: From Sawabe et al. (2007) with slightly modification]
Occurrence, important and ecological roles

Vibrios are widely distributed in aquatic environments including estuaries, marine coastal waters and sediments worldwide (Ortigosa et al. 1994; Rehnstam et al. 1993; Urakawa et al. 2000). Some *Vibrio* spp. cause diseases of humans who consume contaminated seafood or water. Recently, a number of reports have highlighted pathogenic vibrios toward humans and marine animals (e.g. corals, gorgonians, and shrimp), which may be related to rising of seawater temperature (Kushmaro et al. 2001; Martin et al. 2002; Rosenberg and Ben–Haim 2002). The most well-known human pathogenic vibrios are *V. cholerae*, a causative agent of cholera, that causes a devastation diarrheal disease; *V. parahaemolyticus*, a causative agent of seafood–borne food poisoning; and *V. vulnificus*, a causative agent of septicemia, wound infections, and gastroenteritis mostly in immunocompromised hosts (Janda et al. 1988; Tacket et al. 1984; Yeung and Boor 2004). More recently, *V. fluvialis* and *V. mimicus* have been implicated as causes of diarrhea (Davis et al. 1981; Huq et al. 1980; Lee et al. 2008). In addition, *V. furnissii* has been isolated from a few individuals with diarrhea, but there is no evidence that it can actually cause diarrhea (Brenner et al. 1983). *V. alginolyticus* has been isolated from several types of soft tissue infections (Blake et al. 1979). *V. metschnikovii* is usually an environmental organism, but has been isolated from a case of peritonitis in a patient with an inflamed gallbladder and from a few other specimens (Jean–Jacques et al. 1981; Lee et al. 1978).

Some *Vibrio* spp. are known as pathogens of marine animals in aquaculture and some are normal microbiota of aquatic animals such as flatfish, jackmackerel (*Trachurus japonicus*), salmonids, larval and juvenile sea bream, blue crabs, shrimps (*Penaeus merguiensis* and *Litopenaeus vannamei*), and oysters (*Crassostrea gigas*) (Aiso et al. 1968; Davis and Sizemore 1982; Liston 1957; Muroga et al. 1987; Olafsen et al. 1993; Vandenberghe et al. 1999; Yoshimizu et al. 1976). Pathogens of aquatic animals are *V. harveyi* that causes luminous vibriosis in shrimp; *V. anguillarum* that has been recognized as a pathogen for sea bass, sea bream, mullet and rainbow trout; and *V. salmonicida*, a causative agent of cold water vibriosis in Atlantic salmon, rainbow trout and cod (Egidius et al. 1986; Lavilla–Pitogo et al. 1998; Pedersen et al. 1994; Soorum et al. 1988; Wiik et al. 1989). In addition, *V. shilonii* and *V. coralliilyticus* have been associated with coral bleaching (Rosenberg and Ben–Haim 2002). Distribution of vibrios in oysters originated from the Brazil coast was investigated. It was found that 81%, 77%, 31%, 27%, 19%, 12%, and 12% of them contained *V. alginolyticus*, *V. parahaemolyticus*, *V. cholerae* non–O1, *V. fluvialis*, *V. furnissii*, *V. mimicus*, and *V. vulnificus*, respectively (Matté et al. 1994). V.
shilonii (V. mediterranii) are able to colonise gut of turbot larvae and prevent colonization of the gut by opportunistic pathogen (Huys et al. 2001). V. fisheri is associated with the development of the light organ in squid (Visick et al. 2000). In addition, V. halioticoli, V. superstes, V. gallicus, V. neonatus, and V. ezurae are commonly isolated from the guts of Haliotis abalones (Tanaka et al. 2004). Large numbers of vibrios attach to the external surface of zooplankton and can form biofilms that may play and important role in survival during starvation or environmental stress (Wai et al. 1999).

Halophilic vibrios can represent as much as 40% of the total microbiota of the subtropical coastal waters but distribution of vibrios in freshwater has been limited because most of the bacteria require Na+ for their growth (Chan et al. 1986; Oliver et al. 1982). Some Vibrio spp., V. cholerae and V. anguillarum are frequently isolated from freshwater (Miyamoto and Eguchi 1997). Vibrios play an important role in the degradation of chitin (the main structural polysaccharide of the crustacean exoskeletons) to its constituent sugars for recycling by other marine animals (Svitil et al. 1997). Temperature plays an important role in the numbers of vibrios in aquatic environment. In general, the numbers of vibrios were highly detected in summer when the water temperature increased, especially those above 20°C (Baffone et al. 2000; Oliver and Kaper 1997; West 1989). In the Chesapeake Bay, V. parahaemolyticus and V. vulnificus could not be detected in the water column during the winter months, whereas bacterial cells were detected from sediment throughout the year (Kaneko and Colwell 1973; Wright et al. 1996). In conditions of environmental stress, for instance low temperature or nutrient deficiency, some vibrios e.g. V. cholerae, V. vulnificus, and V. parahaemolyticus, change to a viable but non-culturabl (VBNC) state (Linder and Oliver 1989; Oliver and Kaper 1997; Varnam and Evans 1991). These VBNC cells have a slightly thickened periplasmic space and are resistant to hot and cold including desiccation. In such a state, cells are viable, but they do not grow on the media routinely employed for their isolation. The virulence decreases significantly when cells enter the VBNC state, however the bacteria remain virulent and capable of causing fatal infection after resuscitation in vivo (Oliver and Bockian 1995).

**General characteristics, isolation and identification**

Bacteria in genus Vibrio are gram negative, facultative anaerobic rods or curved rods and possess a fermentative metabolism. Cells are 0.5–0.8 µm in width and 1.4 to 2.6 µm in length (Farmer III 1992). They usually motile (except V. gallicus and V. halioticoli) by at least one polar flagellum (V. fisheri possesses multiple polar flagella). The
The difference between vibrios and enteric bacteria is that most vibrios are oxidase-positive and they are halophilic. Most vibrios utilize D-glucose, dextrin, glycogen, N-acetyl-D-glucosamine, D-fructose, maltose, D-trehalose, methyl pyruvate, L-asparagine aconitate, L-proline, or inosine as the sole source of carbon. Most vibrios reduce nitrate, produce acetoin, and are susceptible to the vibriostatic agent O/129 (2,4-diamino-6,7-di-isopropylpteridine). Most vibrios do not utilize N-acetyl-D-galactosamine, L-erythritol, m-inositol, xylitol, α-hydroxy-butyric acid, D-saccharic acid, D, L-carnitine, and phenyl ethylamine as sole carbon source. Most vibrios show leucine arylamidase, acid and alkaline phosphatase activity, but not urease, tryptophane deaminase, α-mannosidase, α-fucosidase, and β-glucoronidase (Baumann et al. 1984; Farmer III 1992; Thompson et al. 2004).

Vibrios are easy to be isolated from both clinical and environmental material, though they are easily inhibited by normal intestinal flora or contaminated organisms. A scheme for isolation of vibrios often includes enrichment prior to plating on a selective agar especially when their number are in low levels. An enrichment medium recommended by the U.S. Food and Drug Administration (FDA) is alkaline peptone water (APW) (DePaola and Kaysner 2004). The high pH of this medium (pH 8.6) and sodium chloride (NaCl) concentration inhibit many other bacteria and favor vibrios. Most vibrios do not grow in media without NaCl but require 2 to 3% NaCl (w/v) for optimal growth except V. cholerae, V. mimicus, V. hispanicus, V. fluvialis, V. furnissii, and V. metchnikovii that can grow with a minimum NaCl concentration (0.5%) (Alsina and Blanch 1994a; Alsina and Blanch 1994b; Gomez-Gil et al. 2004b). Vibrios are generally able to grow on tryptic soy agar (TSA) with an adequate concentration of salt (NaCl) added, marine agar, and on the selective medium, e.g., thiosulphate citrate bile salt sucrose agar (TCBS) or CHROMagar Vibrio (CV) agar (Figure 1). Bile salts in TCBS can inhibit the growth of Gram positive–bacteria, coliform bacteria, and some Gram-negative bacteria but not members of the Enterobacteriaceae (Kobayashi et al. 1963). Although some vibrios do not grow on TCBS, e.g., V. penaeicida, or some vibrios grow poorly, e.g., V. cincinnatiensis, V. metschnikovii, and Grimontia hollisae (reclassified from V. hollisae), those that grow well and are able to use sucrose will form yellow colonies while sucrose–nonfermenting strains will form green colonies. However, the acids produced by sucrose–fermenting bacteria can diffuse into the agar, changing the color of the agar from green to yellow. The color of sucrose–nonfermenting bacterial colonies is then covered by the yellow color and changes from green to yellow–green, leading to difficulties in the differentiation of sucrose–nonfermenting bacteria from other bacteria. Thus, a new chromogenic agar (CV agar) was developed (Hara–Kudo et al.
The generation of colony color depends on the reaction of the bacterial beta-galactosidase and the substrate contained in the medium.

Isolation of vibrios from aquatic animals is an important diagnostic tool in aquaculture because vibriosis is a common disease that affects many marine animals. To isolate vibrios from fish, an anterior kidney is the most common target. In crustaceans, the main tissue used for determination of vibrios is the hemolymph and hepatopancreas (Gomez-Gil et al. 1998). To isolate vibrios from mollusks, samples must be rinsed to remove mud from the shells and the isolation can be made from hemolymph or internal organs (pooled or an individual organ).

**Figure 1** Illustrate colonies of some *Vibrio* spp. on TCBS and CV agars. [Source: From Hara-Kudo et al. (2001)]

For identification, biochemical test is required for presumptive classification and molecular techniques are used for confirmation. Many laboratories use specific keys for routine identification of vibrio isolates (Alsina and Blanch 1994a; Alsina and Blanch 1994b; Noguerola and Blanch 2008). The initial identification key start with the results from three tests: arginine dihydrolase (A), lysine decarboxylase (L), and ornithine decarboxylase (O) (Figure 2) followed with the keys for the cluster of A+/L+/O+ (Figure 3) or A+/L+/O− (Figure 4) or A+/L−/O− (Figure 5) or A−/L+/O+ (Figure 6) or A−/L+/O− (Figure 7) or A−/L−/O+ (Figure 8) or A−/L−/O− (Figure 9). However, some environmental vibrios can be biochemically diverse but clinical isolates have more standard characteristics and need less complicated identification. Human pathogenic *Vibrio* spp. can be separated into 6 groups (Table 2) based on 1% NaCl requirements, oxidase production, nitrate reduction, myo-inositol fermentation, arginine dihydrolase, lysine decarboxylase, and ornithine decarboxylase production (Forbes et al. 2007; Kelly et al. 1991).
The main key to identify vibrios using arginine dihydrolase, lysine decarboxylase, and ornithine decarboxylase (A/L/O). Every cluster leads to next identification key (Figure 3–9), with exception of A+/L−/O+, which leads to a unique species (Noguerola and Blanch 2008).

**Figure 2** The main key to identify vibrios using arginine dihydrolase, lysine decarboxylase, and ornithine decarboxylase (A/L/O). Every cluster leads to next identification key (Figure 3–9), with exception of A+/L−/O+, which leads to a unique species (Noguerola and Blanch 2008).

**Figure 3** Identification key for cluster A+/L+/O+ (Noguerola and Blanch 2008).

**Figure 4** Identification key for cluster A+/L+/O− (Noguerola and Blanch 2008).
Figure 5 Identification key for the cluster A+/L−/O−. Threshold exceptions: the indole test has a threshold for positive results of ≥75% (positive) for V. anguillarum, V. fluvialis, V. nereis and of ≤15% (negative) for V. furnisii and V. metschnikovii. The sucrose acid and ONPG tests have thresholds for positive results of ≥75% (positive) for V. splendidus I. CS, corn steep-based medium (Noguerola and Blanch 2008).
Figure 6 Identification key for the cluster A-/L+/O+. Threshold exceptions: the VP test has a threshold for positive results of ≥89% (positive) for *V. alginolyticus* (Noguerola and Blanch 2008).
Figure 7 Identification key for the cluster $A^-/L^+/O^-$ (Noguerola and Blanch 2008).

Figure 8 Identification key for cluster $A^-/L^-/O^+$ (Noguerola and Blanch 2008).
Figure 9 Identification key for the cluster A-/L- /O-. Threshold exceptions: the ONPG test has a threshold for positive results of ≥75% (positive) for *V. comitans*, and *V. splendidus I*. The melibiose test has a threshold for positive results of ≥75% (positive) for *V. nigrapulchritudo*. The α-ketoglutarate test has a threshold for positive results of ≤25% (negative) for *V. pelagius II* (Noguerola and Blanch 2008).
Table 2 Biochemical and physiological characteristics of the clinical Vibrio spp.

<table>
<thead>
<tr>
<th>Test (s)</th>
<th>Group 1</th>
<th>Group 2</th>
<th>Group 3</th>
<th>Group 4</th>
<th>Group 5</th>
<th>Group 6</th>
</tr>
</thead>
<tbody>
<tr>
<td>V. cholerae</td>
<td>+</td>
<td>+</td>
<td>-</td>
<td>+</td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>V. mimicus</td>
<td>+</td>
<td>+</td>
<td>-</td>
<td>+</td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>V. metchnikovii</td>
<td>-</td>
<td>-</td>
<td>+</td>
<td>-</td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>V. cincinnatiensis</td>
<td>-</td>
<td>-</td>
<td>+</td>
<td>-</td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>V. holliase</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>-</td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>V. damselae</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>-</td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>V. fluvialis</td>
<td>-</td>
<td>-</td>
<td>+</td>
<td>+</td>
<td>-</td>
<td>+</td>
</tr>
<tr>
<td>V. alginolyticus</td>
<td>-</td>
<td>-</td>
<td>+</td>
<td>+</td>
<td>-</td>
<td>+</td>
</tr>
<tr>
<td>V. parahaemolyticus</td>
<td>-</td>
<td>-</td>
<td>+</td>
<td>+</td>
<td>-</td>
<td>+</td>
</tr>
<tr>
<td>V. vulnificus</td>
<td>-</td>
<td>-</td>
<td>+</td>
<td>+</td>
<td>-</td>
<td>+</td>
</tr>
<tr>
<td>V. harveyi</td>
<td>-</td>
<td>-</td>
<td>+</td>
<td>+</td>
<td>-</td>
<td>+</td>
</tr>
<tr>
<td>Oxidase</td>
<td>+</td>
<td>+</td>
<td>-</td>
<td>+</td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>Nitrate to nitrite</td>
<td>+</td>
<td>+</td>
<td>-</td>
<td>+</td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>Fermentation</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Gas from glucose</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>+</td>
<td>-</td>
</tr>
<tr>
<td>Lactose</td>
<td>v</td>
<td>v</td>
<td>v</td>
<td>-</td>
<td>-</td>
<td>+</td>
</tr>
<tr>
<td>Sucrose</td>
<td>+</td>
<td>-</td>
<td>+</td>
<td>-</td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>myo-inositol</td>
<td>-</td>
<td>-</td>
<td>v</td>
<td>-</td>
<td>+</td>
<td>-</td>
</tr>
<tr>
<td>Lysine</td>
<td>-</td>
<td>+</td>
<td>v</td>
<td>v</td>
<td>-</td>
<td>+</td>
</tr>
<tr>
<td>Decarboxylase&lt;sup&gt;b&lt;/sup&gt;</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Arginine</td>
<td>-</td>
<td>-</td>
<td>v</td>
<td>-</td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>Dihydrolase&lt;sup&gt;b&lt;/sup&gt;</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ornithine</td>
<td>+</td>
<td>+</td>
<td>-</td>
<td>+</td>
<td>+</td>
<td>v</td>
</tr>
<tr>
<td>Decarboxylase&lt;sup&gt;b&lt;/sup&gt;</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Growth in 0% NaCl</td>
<td>+</td>
<td>+</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Growth in 6% NaCl</td>
<td>v</td>
<td>v</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>TCBS&lt;sup&gt;d&lt;/sup&gt; growth</td>
<td>G</td>
<td>G</td>
<td>G&lt;sup&gt;e&lt;/sup&gt;</td>
<td>P</td>
<td>P</td>
<td>R</td>
</tr>
<tr>
<td>Colony on TCBS&lt;sup&gt;d&lt;/sup&gt;</td>
<td>y</td>
<td>g</td>
<td>y</td>
<td>y</td>
<td>g</td>
<td>g&lt;sup&gt;f&lt;/sup&gt;</td>
</tr>
</tbody>
</table>

<sup>v</sup>, Variable; +, >90% of strains are positive; -, <90% of strains are negative; (+), delayed; G, Good; P, very poor; R, reduced at 36°C; y, Yellow; g, Green. Key differential tests result in dot boxes.

<sup>a</sup> Relassified as G. holliase and Photobacterium damselae
<sup>1</sup> 1% NaCl added to enhance growth.
<sup>b</sup> Nutrient broth with 0% or 6% NaCl added.
<sup>c</sup> Thiosulfate citrate bile salt sucrose agar.
<sup>d</sup> May be reduced.
<sup>e</sup> 5% yellow.
<sup>f</sup> 1% yellow.
<sup>g</sup> 10% yellow.

[Source: From Forbes et al. (2007); Kelly et al. (1991) with slightly modification]
Molecular methods have been developed to identify vibrios with a higher reproducibility than phenotypic tests. These include a well-known polymerase chain reaction (PCR) technique and nucleotide sequence analysis.

The *gyrB* gene coding for the well conserved B subunit of DNA gyrase showed considerable nucleotide sequence variation useful for identification of *V. parahaemolyticus*, *V. alginolyticus*, *V. splendidus* and related species (Le Roux et al. 2004; Venkateswaran et al. 1998). The specific primers for this gene were also developed for identification of *V. hollisae* (*G. hollisae*) (Vuddhakul et al. 2000). A gene encoding an outer membrane protein (OMP), *ompW*, of *V. cholerae*, *toxR* encoding a transcriptional regulator for virulence gene expression of *V. parahaemolyticus*, and *vvh* encoding for the hemolysin of *V. vulnificus* have been developed to detect those bacteria from clinical specimens (Kim et al. 1999; Lee et al. 1998; Nandi et al. 2000). Other genes such as *gyrA* coding for the A subunit of DNA gyrase; *parC* (Okuda et al. 1999) coding for a subunit of the type II topoisomerase; *recA* (Stine et al. 2000) an essential gene for genetic recombination; *hsp60* (Kwok et al. 2002) encoding a highly conserved housekeeping protein that assists in proper protein folding; *sodA* (Shyu and Lin 1999) coding for the superoxide dismutase; *groESL* (Mizunoe et al. 1999) coding for heat shock protein (HSP); *lux* (Palmer and Colwell 1991) coding for luminescence; *fur* (Colquhoun and Sørum 2002) coding for a regulator of an iron uptake system, and *toxR* (Vuddhakul et al. 2000) encoding for a transmembrane transcriptional regulator have been reported as useful genes for identification or the phylogenetic analysis of *Vibrio* spp. The 16S rRNA sequence analysis is popular for phylogenetic studies among vibrios (Dorsch et al. 1992; Kita-Tsukamoto et al. 1993; Ruimy et al. 1994). However, the sequence variation in this gene is not large enough to be easily used as the target for differentiation of closely related *Vibrio* spp. Different loci, e.g., 23S rRNA and *gapA* have been used for the identification of *Vibrio* spp. (Le Roux et al. 2004; Macián et al. 2004; Sparagano et al. 2006). MLSA become a useful method for identification of vibrios and could also be used as an alternative to 16S rRNA gene sequences analysis (Thompson et al. 2005).

Recently, Real-Time PCR (RT-PCR) has been developed with three main fluorescence–monitoring systems. These include a TaqMan probes for the detection of *V. cholerae* and *V. vulnificus*; an FAM fluorescence probe for detecting *V. parahaemolyticus*; and a SYBR green for the detection of *V. vulnificus* (Blackstone et al. 2003; Campbell and Wright 2003; Lyon 2001; Panicker et al. 2004).
Pathogenesis in the vibrios

A wide range of vibrios is capable of causing diseases in aquatic animals and some species are recognized as serious pathogens in human. Pathogenic vibrios isolated from marine animals are listed in Table 3 (Thompson et al. 2006). Although, the virulence factors and virulence mechanisms of those vibrios are not quite understood, pathogenic vibrios isolated from human (\textit{V. cholerae}, \textit{V. parahaemolyticus}, \textit{V. vulnificus}) mostly cause diseases by ingestion of contaminated food or water. The cholera toxin produced from \textit{V. cholerae} affects the small intestine and causes fluid secretion (Herrington et al. 1988; Pierre et al. 1989) while thermostable direct hemolysin (TDH) produced from \textit{V. parahaemolyticus} affects the colon leading a cause of gastroenteritis (Takahashi et al. 2000). The important virulence factor of \textit{V. vulnificus} is hemolysin, this bacterium causes septicemia (Lee et al. 2004). Major virulence factors and pathogenesis of human pathogenic vibrios are listed in Table 4 (Igbinosa and Okoh 2008).

\textbf{Table 3} Pathogenic Vibrio spp. isolated from marine animals

<table>
<thead>
<tr>
<th>Species</th>
<th>Main host</th>
<th>Site of infection</th>
</tr>
</thead>
<tbody>
<tr>
<td>\textit{V. alginolyticus}</td>
<td>Finfish</td>
<td>Blood, skin, and cornea</td>
</tr>
<tr>
<td></td>
<td>Penaeids shrimp</td>
<td>Hemolymph and shell</td>
</tr>
<tr>
<td>\textit{V. anguillarum}</td>
<td>Trout and salmon</td>
<td>Blood, skin, fins, and gastrointestinal tract</td>
</tr>
<tr>
<td>\textit{V. fischeri}</td>
<td>Juvenile turbot</td>
<td>Skin, pancreas, and bile duct</td>
</tr>
<tr>
<td>\textit{V. harveyi}</td>
<td>Penaeid shrimp</td>
<td>Hemolymph, hepatopancreas, shell, gills, and muscle</td>
</tr>
<tr>
<td>\textit{V. ichthyoeenteri}</td>
<td>Japanese flounder</td>
<td>Intestinal tract</td>
</tr>
<tr>
<td>\textit{V. logei}</td>
<td>Atlantic salmon</td>
<td>Skin</td>
</tr>
<tr>
<td>\textit{V. pectenicida}</td>
<td>Scallop larvae</td>
<td>Hemocytes</td>
</tr>
<tr>
<td>\textit{V. pelagius}</td>
<td>Juvenile turbot</td>
<td>Fins, tail, internal organs, and intestinal tract</td>
</tr>
<tr>
<td>\textit{V. penaeicida}</td>
<td>Kuruma prawns</td>
<td>Gill, lymphoid organs, muscle, and hemolymph</td>
</tr>
<tr>
<td>\textit{V. proteolyticus}</td>
<td>Brine shrimp</td>
<td>Microvilli (gut), epithelial cells</td>
</tr>
<tr>
<td>\textit{V. salmonicida}</td>
<td>Salmon</td>
<td>Blood, kidney, bladder, and gastrointestinal tract</td>
</tr>
<tr>
<td>\textit{V. splendidus}</td>
<td>Mollusks</td>
<td>Gonads, mantle, velum, and connective tissues</td>
</tr>
<tr>
<td>\textit{V. tapetis}</td>
<td>Clams</td>
<td>Periostracal lamina (shell)</td>
</tr>
<tr>
<td>\textit{V. tubiashii}</td>
<td>Pacific oyster</td>
<td>Cilia, velum</td>
</tr>
<tr>
<td>\textit{V. vulnificus}</td>
<td>Eels</td>
<td>Body, gastrointestinal tract, heart, liver, and spleen</td>
</tr>
</tbody>
</table>

[Source: From Thompson et al. (2006) with slightly modification]
**Table 4** Virulence factors of human pathogenic *Vibrio* spp.

<table>
<thead>
<tr>
<th>Virulence factors</th>
<th>Target systems</th>
<th>Species</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flagellum</td>
<td>Gastrointestinal tract</td>
<td><em>V. cholerae</em></td>
</tr>
<tr>
<td>Adhesins</td>
<td>Gastrointestinal tract</td>
<td><em>V. cholerae, V. parahaemolyticus</em></td>
</tr>
<tr>
<td>Serum resistance</td>
<td>Blood</td>
<td><em>V. vulnificus</em></td>
</tr>
<tr>
<td>Polysaccharides, acidic</td>
<td>Blood</td>
<td><em>V. vulnificus</em></td>
</tr>
<tr>
<td>Enterotoxin cholera toxin</td>
<td>Gastrointestinal tract</td>
<td><em>V. cholerae</em> O1, <em>V. cholerae</em> non-O1, <em>V. mimicus</em></td>
</tr>
<tr>
<td>Enterotoxin labile toxin</td>
<td>Gastrointestinal tract</td>
<td><em>V. cholerae</em> O1, <em>V. cholerae</em> non-O1, <em>V. mimicus, V. fluvialis, G. hollisae</em></td>
</tr>
<tr>
<td>or heat–stable toxin</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cytolysin labile toxin</td>
<td>Wounds, GI tract</td>
<td>*V. vulnificus, V. fluvialis, V. damsela, <em>V. cholerae</em> non-O1</td>
</tr>
<tr>
<td>Cytotoxin labile toxin</td>
<td>Gastrointestinal tract</td>
<td><em>V. fluvialis</em></td>
</tr>
<tr>
<td>Cytotoxin shiga</td>
<td>Gastrointestinal tract</td>
<td><em>V. cholerae</em> O1, <em>V. cholerae</em> non-O1, <em>V. parahaemolyticus</em></td>
</tr>
<tr>
<td>Hemolysin</td>
<td>Gastrointestinal tract</td>
<td><em>V. parahaemolyticus, G. hollisae</em></td>
</tr>
<tr>
<td>Collagenase</td>
<td>Wounds</td>
<td><em>V. alginolyticus, V. vulnificus</em></td>
</tr>
<tr>
<td>Protease</td>
<td>Cutaneous lesions</td>
<td><em>V. vulnificus</em></td>
</tr>
<tr>
<td>Siderophore</td>
<td>Blood</td>
<td><em>V. vulnificus</em></td>
</tr>
<tr>
<td>Mucinase</td>
<td>Gastrointestinal tract</td>
<td><em>V. cholerae</em> O1, <em>V. cholerae</em> non-O1, <em>V. mimicus, V. fluvialis, V. parahaemolyticus</em></td>
</tr>
<tr>
<td>Neuraminidase</td>
<td>Gastrointestinal tract</td>
<td><em>V. cholerae</em> O1</td>
</tr>
</tbody>
</table>

[Source: From Igbinosa and Okoh (2008) with slightly modification]
**Vibrio harveyi**

*V. harveyi* was first discovered in 1936 (Johnson and Shunk 1936). It was first described as *Achromobacter harveyi* and was changed to the genus *Lucibacterium* and *Beneckea* (Reichelt and Baumann 1973). Finally, it has been named in genus *Vibrio*. The specie harveyi named after E.N Harvey who was a pioneer in study of bioluminescence. Recently, *V. carchariae* and *V. trachuri* are reported as the junior synonym of *V. harveyi* (Gauger and Gómez-Chiarri 2002; Pedersen et al. 1998; Thompson et al. 2002).

**Important and epidemiology**

*V. harveyi* is a bioluminescent marine bacterium that can easily be found as free-living organisms in seawater or associated with normal intestinal microflora of marine animals (Ruby and Nealson 1978). It has been isolated from many geographical locations, and from the coastal and open ocean seawater (Baumann and Baumann 1981). *V. harveyi* was found as a minor component of the microflora on the exoskeleton of female black tiger shrimp, *P. monodon*, in Thailand (Jiravanichpaisal and Miyazaki 1994). However, it seems to be dominant luminous bacterial population in nearshore seawater and sediments, for example about 5 to 7 CFU/ml of this bacterium found in nearshore water in the Philippines (Lavilla-Pitogo et al. 1990); 26 to 58 CFU/ml detected from surface seawater samples in the Arabian Gulf (Makemson et al. 1992); and $10^3$ CFU/g demonstrated in estuary sediments from southern India (Ramesh et al. 1989). *V. harveyi* started to get attention as a pathogen after it caused a massive loss of shrimp in the large scale aquaculture (Harris 1998). The extensive use of antibiotics against this bacterium in shrimp farms resulted in development of antibiotic resistant strains (Karunasagar et al. 1994). There are only 2 report cases of *V. harveyi* infection in human. One was a girl who was infected after a shark bite in the South East coast of the US and another was a child with cancer who was infected after swimming in the French Mediterranean Sea (Pavia et al. 1989; Wilkins et al. 2007).

*V. harveyi* causes vibriosis in a variety of aquatic animal hosts, including marine fish, bivalves, and crustaceans. *V. harveyi* was reported as an opportunistic pathogen of common snook, *Centropomus undecimalis* (Kraxberger-Beatty et al. 2006). This bacterium was isolated from diseased seahorse (*Hippocampus sp.*), pearl oyster (*Pinctada maxima*), rock lobster (*Jasus verreauxi*), silvery black porgy (*Acanthopagrus cuvieri*), brown spotted grouper (*Epinephelus tauvina*), sea bream (*Sparus aurata*), dentex (*Dentex dentex*), sunfish (*Mola mola*), and cage-cultured sea bass (*Lates calcarifer* Bloch) (Alcaide et al. 2007).
Over the past decade, *V. harveyi* has been recognized as a significant pathogenic organism and cause of high rates of shrimp mortality in the shrimp culture industry worldwide (Karunasagar et al. 1994; Liu et al. 1996b; Saeed 1995). It has been recognized as pathogenic for several crustacean larvae, particularly, *Penaeus* species. *V. harveyi* was the main bacterium associated with vibriosis diseased in *L. vannamei* (Vandenberghe et al. 1999). Pathogenic strains of *V. harveyi* have caused massive epidemics in shrimp in Thailand, Philippines and many Asian countries (Lavilla-Pitogo et al. 1990). Luminescent *V. harveyi* appears to release exotoxins and cause 80–100% mortality of *P. monodon* hatcheries in Australia (Harris and Owens 1999). In Latin America, including Mexico, *V. harveyi* significantly affects the production of *L. vannamei*, the most cultured penaeid shrimp in these areas (Aguirre-Guzmán et al. 2001; Vandenberghe et al. 1999). *V. harveyi* was demonstrated as a dominant bacterium in western Mediterranean seawater and marine bivalves during the warm season. Outbreaks of *V. harveyi* correlated to heavy rainfall, which caused nutrient runoff to the sea and increased the number of *V. harveyi* as much as 100-fold (Harris and Owens 1997; Ramesh et al. 1989).

**General characteristics, isolation and identification**

*V. harveyi* is gram negative, nonspore-forming, straight rod bacterium and classified as chemoorganotroph. Colonies on Luria Bertani (LB) agar containing 1% NaCl can emit light in dark after 24 h incubation at room temperature (Figure 10) (*Diseases of Penaeus monodon* 2010). It can grow in the presence of 0.5% to 8% NaCl but the optimal growth requires between 2% to 4% of NaCl. The optimal temperature is between 30–35°C and no growth is observed at 4°C (Baumann et al. 1984). The general characteristics and biochemical traits of *V. harveyi* are listed in Table 5. TCBS is an ideal medium for isolation vibrios (Kobayashi et al. 1963). However, colonies of *V. harveyi* on TCBS appear as either sucrose fermenter (yellow) or non-sucrose fermenter (green). Therefore, they cannot be distinguished from other sucrose fermenter or non-sucrose fermenter bacteria. In 1996, Harris et al. developed *Vibrio harveyi* agar (VHA) for isolation and enumeration of *V. harveyi*. This medium is able to differentiate *V. harveyi* from 15 other *Vibrio* species and has been shown to inhibit the growth of *Pseudomonas* spp. and *Flavobacterium* spp. Although *Photobacterium* spp. are allowed to grow on this medium, their colonies appear differently from *V. harveyi*. High concentrations of NaCl (30 g/l) and incubation temperature at 28°C.
seem to favor for isolation vibrios by this medium but high pH (pH 9) and the absence of magnesium ions are important selective factors to inhibit many *Vibrio* spp. except *V. harveyi*. On VHA, *V. harveyi* utilize cellobiose as a carbon source, which changes pH to be acid and decarboxylate ornithine result in a basic pH. Therefore, colonies of *V. harveyi* on VHA will be green with yellow halos (Harris et al. 1996). *V. harveyi* can be differentiated from other luminous bacteria, *V. fisheri, V. logei, P. phosphoreum* and *P. leiognathi*, by L-tyrosine (Reichelt and Baumann 1973). Serological methods such as dipstick and ELISA have been used for rapid detection of *V. harveyi* from penaeid shrimp and water (Robertson et al. 1998b).

![Figure 10 Bioluminescent of *V. harveyi* colonies.](source: From “Diseases of Penaeus monodon” (2010)]

*V. harveyi* is phylogenetically related to other *Vibrio* spp. such as *V. parahaemolyticus, V. alginolyticus, V. campbellii* and *V. carchariae* (Kita–Tsukamoto et al. 1993; Pedersen et al. 1998). Thus, identification of *V. harveyi* by conventional biochemical techniques is not accurate. A PCR technique targeted to unique nucleotide sequences of *V. harveyi* has been developed to facilitate its detection and differentiation from closely related *Vibrio* spp. Primers specific to toxR gene for amplification of *V. harveyi* were designed (Conejero and Hedreyda 2003; Pang et al. 2006). The toxR gene functions as a regulatory gene for outer membrane protein gene expression and was found to presence in both virulent and non–virulent species (Okuda et al. 2001). Primers specific to other genes such as luxN coding for the receptor of LuxM/N quorum sensing system, vhh coding for the hemolysin protein and 16S rRNA gene were developed (Bassler et al. 1993; Oakey et al. 2003; Zhang et al. 2001). However, the limitations of these primers in either species or strain detection were detected. The toxR primers did not produce amplicons with isolates from Thailand and Ecuador. The primers designed for luxN gene of *V. harveyi* could amplify two *V. campbellii* strains isolated from diseased larvae of the tropical rock lobster *Panulirus ornatus* (Cano–
Gomez et al. 2009). The vhh gene is not suitable as a marker of V. harveyi because species-specific markers should be stable in the genome, however, horizontal gene transfer of the virulence gene by bacteriophage can occur among Vibrio strains (Waldor and Mekalanos 1996). Identification of V. harveyi by PCR using 16s rRNA gene primers demonstrated that a few strains of V. alginolyticus gave positive results (Oakey et al. 2003). Primers targeted to gyrB were developed (Thaithongnum et al. 2006). gyrB is encoded for the subunit B protein of DNA gyrase (topoisomerase type II) which regulates the supercoiling of dsDNA. It is necessary for DNA replication, and the enzyme is distributed universally among bacterial species (McMacken et al. 1987). In addition, its molecular evolution rate is higher than that of 16S rRNA. This divergence in the gyrB gene could provide greater resolution for phylogenetic analysis of luminous bacteria than does the 16S rRNA method (Dunlap and Ast 2005). In addition, gyrB targeted PCR protocols have been used for identification of other bacteria such as Aeromonas, Pseudomonas, Bacillus, and G. hollisae (De Clerck et al. 2004; Vuddhakul et al. 2000; Yamamoto and Harayama 1995; Yamamoto et al. 2000; Yanez et al. 2003).

Table 5 Physical and biochemical characteristics of V. harveyi.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flagella</td>
<td>Motile with shethed single polar flagella</td>
</tr>
<tr>
<td></td>
<td>Synthesizing lateral flagella on solid medium</td>
</tr>
<tr>
<td>Arginine decarboxylase</td>
<td>-</td>
</tr>
<tr>
<td>Lysine decarboxylase</td>
<td>+</td>
</tr>
<tr>
<td>Ornithine decarboxylase</td>
<td>+</td>
</tr>
<tr>
<td>Catalase test</td>
<td>+</td>
</tr>
<tr>
<td>Oxidase test</td>
<td>+</td>
</tr>
<tr>
<td>Voges Proskauer test</td>
<td>-</td>
</tr>
<tr>
<td>Oxidation–fermentation test</td>
<td>+</td>
</tr>
<tr>
<td>Unable to utilize:</td>
<td>D–Xylose, melibiose, D–galacturonate, β–hydroxybutyrate, D–sorbitol, ethanol, L–leucine, γ–aminobutyrate, putrescine</td>
</tr>
<tr>
<td>Positive for:</td>
<td>Production of amylase, chitinase, gelatinase, lipase</td>
</tr>
<tr>
<td>Negative for:</td>
<td>Production of acetoin and/or diacetyl</td>
</tr>
</tbody>
</table>

[Source: From Baumann et al. (1984) with slightly modification]
Molecular typing methods

Some strains of *V. harveyi* are highly pathogenic to aquatic animals, while others are considered to be opportunistic pathogens (Oakey et al. 2003). In order to obtain an extensive epidemiological evidence of molecular variability of *V. harveyi* strains associated with disease, various molecular typing methods have been developed. Moreover, different molecular markers used for differentiation pathogenic and nonpathogenic strains of *V. harveyi* by PCR and hybridization techniques have been demonstrated.

Random Amplified Polymorphic DNA (RAPD)

RAPD also referred to as the Arbitrarily-Primed PCR (AP-PCR) is the PCR-based technique for typing bacterial genomic DNA (Welsh and McClelland 1990; Williams et al. 1990). This technique is used for molecular epidemiological analysis because it is a fast and easy (Williams et al. 1990). The technique is used for identification strain-specific variations in DNA or specific fingerprints of bacteria and *Vibrio* spp. such as *V. cholerae*, *V. parahaemolyticus*, *V. vulnificus* and *V. harveyi* (Bhoopong et al. 2007; Martinez and Yman 1998; Pujalte et al. 2003; Ralph et al. 1993; Rivera et al. 1995; Warner and Oliver 1999; Welsh and McClelland 1990). In *V. harveyi*, this technique could distinguish not only *V. harveyi* isolates from different host species, but also the isolates from different outbreaks or different rearing systems (Alavandi et al. 2006; Hernández and Olmos 2004; Musa et al. 2008; Pujalte et al. 2003).

RAPD is based on random amplification of genomic DNA fragments using a short single primer (usually 8–10 bp) of arbitrary nucleotide sequence. RAPD analysis primer set consisting of six primers (10 bp) of arbitrary sequence is commercially available (Amersham Biosciences, Uppsala, Sweden). These primers can be applied for investigation many genera of bacteria (Fritsch and Rieseberg 1996). PCR conditions usually include an annealing cycle at a low temperature (36 to 45°C), thus the primer will randomly hybridize at multiple locations in chromosome to initiate DNA synthesis. PCR products of different lengths are amplified and separated by gel electrophoresis. These generate “fingerprint patterns” which specific for bacterial strains or species (Figure 11) (Berg et al. 1997).

The discrimination of *V. harveyi* isolates involved in the disease outbreaks of gilthead sea bream and the European sea bass were demonstrated by RAPD technique (Pujalte et al. 2003). This technique was also used to distinguish *V. harveyi* pathogenic strains (Z2 and Z3) isolated from shrimp hatcheries in Mexico, and and a *V. harveyi* ATCC 14126
standard strain (Hernández and Olmos 2004). In addition, RAPD was applied to differentiate pathogenic from nonpathogenic strains *V. harveyi* isolated from *P. monodon* mysis (Alavandi et al. 2006).

![Figure 11](source: From Berg et al. (1997) with slightly modification)

**Figure 11** Schematic drawing of RAPD technique.

[Source: From Berg et al. (1997) with slightly modification]

**Other molecular typing techniques**

In addition to RAPD, several methods including Amplified Fragment Length Polymorphism (AFLP) (Gomez–Gil et al. 2004a; Thompson et al. 2001; Vandenbergh et al. 1999), Repetitive Extragenic Palindromic Elements PCR (REP–PCR) (Gomez–Gil et al. 2004a), ribotyping or ribotype Restriction Fragment Length Polymorphism (RFLP) (Macián et al. 2000; Montes et al. 2006; Pujalte et al. 2003) and Amplified Ribosomal DNA Restriction Analysis (ARDRA) (Urakawa et al. 1997; Hernandez and Olmos 2004; Kita–Tsukamoto et al. 2006) have been demonstrated for molecular typing of *V. harveyi*.

AFLP is based on initial digestion of genomic DNA with a particular combination of restriction endonucleases and allowing DNA fragments to be amplified with primers using PCR technique. Then DNA fingerprint of bacteria is generated by separation of amplification products by electrophoresis. AFLP was used by Vandenbergh et al. 1998 to analyzed DNA fingerprint of vibrios associated with *P. chinensis* larvae in Chinese shrimp hatcheries. In addition, it was used to characterize *V. harveyi* isolated from diseased postlarvae, juveniles and broodstock shrimp in Mexico and *V. harveyi* associated with
vibriosis outbreaks in *L. vannamei* prawn in Ecuador (Vandenbergh et al. 1999). This technique has several advantages including high reproducibility and high discriminatory power, however its disadvantages are time consuming and expensive (Thompson et al. 2001).

For REP–PCR, primers are designated to amplify highly conserved DNA sequences or repeated sequences presented in multiple copies within the bacterial genome (Rodriguez–Barradas et al. 1995). Many bacteria such as bacteria in Family *Enterobacteriaceae*, this sequence can occur single or in multiple adjacent copies (Stern et al. 1984). Amplification will produce polymorphic DNA pattern (fingerprints) that are useful to discriminate between bacterial species and strains. This technique was used for differentiate strains of *E. coli, B. subtilis* and *V. cholerae* (Dombek et al. 2000; Rivera et al. 1995; Versalovic et al. 1991). REP–PCR was first applied to investigate *V. harveyi* isolates from aquacultural environments and primer 5’–GTG GTG GTG GTG GTG–3’ was recommended (Gomez–Gil et al. 2004a).

In ribotyping or ribotype RFLP, the fragments of restriction–digested bacterial genomic DNA are separated by gel electrophoresis and transfered to nylon membrane by Southern blotting. DNA hybridization with ribosomal operon (16S, 23S, 5S) probes is performed in order to generate DNA patterns. Copy numbers of rRNA operons have been variable detected in bacteria such as 1 (*Chlamydia trachomatis*) and 15 (*P. profundum*) (Klappenbach et al. 2001). This technique has been used to analyse the *V. harveyi* associated with cultured oysters (*Ostrea edulis*) and turbot (*Scophthalmus maximus*) (Macián et al. 2000; Montes et al. 2006).

ARDRA is the extension of the RFLP technique. This technique differentiates organisms by amplification of 16S rRNA gene followed by digestion with restriction enzyme to generate DNA pattern. ARDRA was developed to characterize *Mycobacterium* spp. (Vaneechoutte et al. 1993). Though the 16S rDNA sequences of bacteria in the same species may be almost identical, ARDRA is able to emphasize a few differences nucleotides presented without the need of 16S rDNA sequence analysis (Bölske et al. 1996). This technique was applied to classify the bacterial isolates in *Vibrionaceae* and was able to clarify bioluminescent marine bacterial diversity, including *V. harveyi* in coastal samples by digestion 16S rRNA gene with five enzymes (EcoRI, Ddel, Hhis, HinfI, Rsal) (Hernández and Olmos 2004; Kita–Tsukamoto et al. 2006; Urakawa et al. 1997). However, this technique has poor resolution power but has proven useful for species differentiation rather than intraspecies discrimination.
Pathogenesis

*V. harveyi* is a causative agent of vibriosis in aquatic animals. Signs of illness exhibited in a variety hosts are illustrated in Table 6 (Owens and Busico-Salcedo 2006). Vibriosis in fish usually starts with lethargy and a loss of appetite. As the disease progress, the skin may become discolored, red and necrotic. Hemorrhagic ulcers may appear on the mouth or skin surface. Eye disease in milkfish (*Chanos chanos*) in the Philippines and opaque white corneas in the common snook (*Centropomus undecimalis*) caused by *V. harveyi* exhibited focal necrotic lesions in the muscle or eye opacity (Ishimaru and Muroga 1997; Kraxberger-Beatty et al. 2006). Without treatment, the fish became blind. The disease may spread and become systemic. Internal symptoms include intestinal necrosis, anemia, hemorrhages in the muscle wall, swollen intestine, hemorrhage in internal organs, and pale mottled liver may occur. The infected animal can also show a slow behavior and spiral or irregular movement (Thompson et al. 2004). Pathogenesis in Atlantic salmon (*Salmo salar*) required intraperitoneal injection of $10^3$ to $10^5$ cells of *V. harveyi* (Owens et al. 1996).

<table>
<thead>
<tr>
<th>Sign of illness</th>
<th>Host (s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Possible role in surface fouling</td>
<td>Gorgonian corals</td>
</tr>
<tr>
<td>Mortality, tissue lesions</td>
<td>Pearl oyster (<em>Pinctada maxima</em>)</td>
</tr>
<tr>
<td>Luminous vibriosis</td>
<td>Larvae and postlarvae of black tiger prawn (<em>P. monodon</em>), banana prawn (<em>P. merguiensis</em>), postlarvae of freshwater prawn (<em>Macrobrachium rosenbergii</em>), and rock lobster (<em>Jasus verreauxii</em>)</td>
</tr>
<tr>
<td>Mortality, septicemia</td>
<td>Adult kuruma prawn (<em>P. japonicus</em>) and brown tiger prawn spawners (<em>P. esculentus</em>)</td>
</tr>
<tr>
<td>Septicemia, lesions on exoskeleton</td>
<td>Spiny lobster (<em>Panulirus homarus</em>)</td>
</tr>
<tr>
<td>Infection of cornea causing blindness</td>
<td>Common snook (<em>Centropomus undecimalis</em>)</td>
</tr>
<tr>
<td>Skin infection, septicemia</td>
<td>Barramundi (<em>Lates calcarifer</em>)</td>
</tr>
<tr>
<td>Ulcerative lesions, hemorrhagia</td>
<td>Turbot (<em>Scophthalmus maximus</em>)</td>
</tr>
<tr>
<td>Bacterial luminescent disease</td>
<td>Seahorse (<em>Hippocampus sp.</em>)</td>
</tr>
<tr>
<td>Eye lesions</td>
<td>Milkfish (<em>Chanos chanos</em>)</td>
</tr>
</tbody>
</table>

[Source: From Owen and Busico-Salcedo (2006) with slightly modification]
In shrimp, *V. harveyi* is associated with luminous vibriosis that dead and dying shrimp exhibit luminosity in the dark (Figure 12) (Prayitno and Latchford 1995). Therefore, luminescent water at shrimp ponds or rearing tanks at night indicates incidence of vibriosis (Lavilla-Pitogo et al. 1992). High mortality usually occurs in postlarvae and young juvenile prawns. Colonization of bacteria was probable on the feeding apparatus and oral cavity as revealed by scanning electron micrographs (Lavilla-Pitogo et al. 1990). *V. harveyi* penetrates into host tissues by means of chemotactic motility, generally across the gill filament. The bacteria eventually damage gill filament by extracellular enzymes. After bacteria attack gill filament, oxygen cannot diffuse to host and cause Tea Brown Gill Syndrome (TBGS). External signs of diseased shrimp were brittle shells with brown or black spots on the shell and darkened or red body surface (Lavilla-Pitogo et al. 1990). An extensive colonization of the connective tissue of experimentally infected *P. esculentus* was also reported (Owens et al. 1992). Ganglionic neurophiles of infected *P. monodon* larvae showed extensive vacuolation and granulation compared to uninoculated controls (Muir 1991). Histopathology of moribund shrimp showed extensive hepatopancreatic tubular necrosis, melanized and marked hemocytic enteritis (Nithimathachoke et al. 1995). Erratic motility and pale pancreas were observed (Robertson et al. 1998a). In addition, *V. harveyi* can degrade proteins of shrimp hemolymph and release free ammonia and phenolate compound. These increase pH and reduce ability of hemolymph to fix oxygen. *V. harveyi* infection usually caused septicemia because the bacterium could be isolated from hemolymph and hepatopancreas (Jiravanichpaisal and Miyazaki 1994; Liu et al. 1996b).

![Figure 12 Illustrate luminescence after shrimp infected with *V. harveyi.*](Source: From “Diseases of *Penaeus monodon*” (2010))
Bioluminescence

Mechanisms of luminescence in \textit{V. harveyi} remain unclear. However, expression of luminescence has been associated with virulence of this bacterium (Karunasagar et al. 1994). Stimulation of DNA repair by photoreactivation seems to be one of explanations of \textit{V. harveyi} luminescence (Czyz et al. 2000). Genetics and biochemistry of light–emission have been investigated. It was found that \textit{V. harveyi} produced luciferase enzyme, which encoded by \textit{luxA} and \textit{luxB} genes (Cohn et al. 1985; Johnston et al. 1986). This enzyme is heterodimer (composed of $\alpha$ (40 kDa) and $\beta$ (36 kDa) polypeptides) and catalyze reduced flavin mononucleotide (FMNH$_2$) and a long chain fatty aldehyde (RCHO) in the presence of oxygen, resulting in the emission of blue–green light (Figure 13) (Baumann and Baumann 1984; Lin and Meighen 2010)

![Luminescence mechanism in bacteria.](source.png)

**Figure 13** Luminescence mechanism in bacteria.
[Source: From Lin and Meighen (2010)]

Proteins involved in luminescent system are encoded by \textit{luxCDABE} genes located in \textit{lux} operon. \textit{luxA} and \textit{luxB} genes encode for bacterial luciferase. \textit{luxC}, \textit{luxD}, and \textit{luxE} genes encode for fatty acid reductase enzyme complex that required for conversion of fatty acid to long chain aldehyde (Meighen 1993).

Luminescence of \textit{V. harveyi} is inhibited by growth in the presence of glucose but induction of luminescence is stimulated by adding arginine (Nealson et al. 1970). The important factors regulated the expression of luminescence are the small molecules called
autoinducers (Manefield et al. 2000). High amounts of autoinducers produced in the late stages of bacterial growth increased several thousand-fold of luminescence (Meighen 1991). This reason could explain why luminous bacteria living free in the ocean are very dim compared with bacteria living in light organ.

Other lux gene loci (luxR) that involved in the expression of luxCDABE have been discovered in V. harveyi (Martin et al. 1989). Genes involved in luminescence and regulation of various cellular functions has been reported (Table 7) (NCBI 2010). Moreover, these genes found to be regulated bacterial cell–cell communication or quorum sensing.

**Table 7** lux genes and coding proteins involved for transcription of luxCDABE in V. harveyi.

<table>
<thead>
<tr>
<th>lux gene</th>
<th>Product</th>
<th>lux gene</th>
<th>Product</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Luciferase α chain</td>
<td>N</td>
<td>HAI–1 sensor kinase/phosphatase</td>
</tr>
<tr>
<td>B</td>
<td>Luciferase β chain</td>
<td>O</td>
<td>Repressor protein</td>
</tr>
<tr>
<td>C</td>
<td>Acyl–CoA reductase</td>
<td>P</td>
<td>Periplasmic AI–2 binding protein</td>
</tr>
<tr>
<td>D</td>
<td>Acyl transferase</td>
<td>Q</td>
<td>AI–2 sensor kinase/phosphatase</td>
</tr>
<tr>
<td>E</td>
<td>Long–chain–fatty–acid ligase</td>
<td>R</td>
<td>Transcriptional activator protein</td>
</tr>
<tr>
<td>L</td>
<td>AI–1 synthase</td>
<td>S</td>
<td>AI–2 production protein</td>
</tr>
<tr>
<td>M</td>
<td>AI–1 synthase</td>
<td>U</td>
<td>AI phosphorelay protein</td>
</tr>
</tbody>
</table>

[Source: From NCBI (2010)]

**Cell–cell communication (Quorum sensing)**

Quorum sensing (QS) is a process of cell–cell communication in bacteria that acquires secreted signaling molecules called autoinducers (AIs) (Miller and Bassler 2001). QS enables bacterial populations to control gene expression and thus coordinates group behaviours (Waters and Bassler 2005). It is very important for bacteria to co–ordinate their behaviour for rapid adaptation in the environment in order to survive and also very important to co–ordinate their virulence to establish infection in host. Many bacteria utilize this process by producing, releasing and response to AIs in order to monitor cell population density and to regulate gene expression (Nealson and Hastings 1979). In the early 1970s, the word “QS” was first used to described the process of autoinduction of luminescence in V. fisheri (bacteria lives in the light–producing organ of the Hawaiian bobtail squid) and V. harveyi (free living marine bacteria) (Eberhard 1972; Nealson et al. 1970). At the time of writing, vibrios that
communicate via QS systems are *V. fischeri*, *V. harveyi*, *V. cholerae*, *V. anguillarum* and *V. vulnificus* (Thompson et al. 2004).

In *V. harveyi*, QS positively regulates bioluminescence, metalloprotease, siderophore, and exopolysaccharide production, but negatively regulates type III secretion (Bassler et al. 1993; Bassler et al. 1994; Henke and Bassler 2004a; Henke and Bassler 2004c; Lilley and Bassler 2000; Mok et al. 2003). Moreover, QS are required for virulence of *V. harveyi* in a gnotobiotic brine shrimp model (*Artemia franciscana*) (Defoirdt et al. 2005).

*V. harveyi* uses three different AIs to control gene expression; CAI–1 (*cholerae* AI–1), HAI–1 (*harveyi* AI–1) and AI–2 (Figure 14) (Tu and Bassler 2007). CAI–1 is produced by CqsA (Henke and Bassler 2004b). HAI–1 (N–(3–hydroxybutanoyl) homoserine lactone) is produced by LuxM (Bassler et al. 1993). AI–2 (3A–methyl–5,6–dihydro–furo(2,3-D)(1,3,2)dioxaborole–2,2,6,6A–tetraol) is produced by LuxS (Surette et al. 1999). Each AIs has its own membrane receptor protein; CqsS is receptor for CAI–1, LuxN is receptor for HAI–1 and LuxQ and LuxP are receptors for AI–2 (Figure 14) (Bassler et al. 1993; Bassler et al. 1994; Freeman et al. 2000; Henke and Bassler 2004b).

These three receptor proteins phosphorylise LuxU protein, which transfer the phosphoryl group to LuxO (Freeman and Bassler 1999a; Freeman and Bassler 1999b). LuxO is the σ^{54} (encoded by *rpoN* gene)–dependent response regulator protein. Thus activation of LuxO requires σ^{54}. Phosphorylated LuxO (LuxO–P) then activates genes encoding the small regulatory RNAs (sRNAs), named Quorum Regulatory RNA (Qrr). Five Qrr sRNAs have been identified and characterized in *V. harveyi* (Figure 14) (Tu and Bassler 2007). Four out of these five Qrrs are required to destabilize the luxR mRNA, and the presence of each sRNA causes *V. harveyi* to express a distinct level of bioluminescence. sRNAs are known to interact with RNA chaperone (Hfq) to be able to target their mRNAs and involve expression of *luxR* gene which directly activates the *lux* operon (Massé and Gottesman 2002; Møller et al. 2002; Showalter et al. 1990). In the low cell density of *V. harveyi*, production of AIs is low; the three receptor proteins (CqsS, LuxN, LuxQ) act as kinases and phosphorylise LuxU which transfer phosphate to LuxO. Phosphorylated LuxO is then associated with σ^{54} and suppress expression of *luxR*. Therefore, no luminescence is produced at low cell density (LCD) conditions. At high cell density (HCD) condition or high AIs concentration, the three receptor proteins (CqsS, LuxN, LuxQ) act as phosphatases and dephosphorylate LuxO. This inactivates LuxO and causes expression of *lux* operon and bioluminescence (Figure 14) (Freeman and Bassler 1999a; Lilley and Bassler 2000).
Figure 14 Model of quorum-sensing systems of V. harveyi.

[Source: From Tu and Bassler (2007)]
Virulence factors and virulence mechanisms

Type III secretion systems (TTSSs)

TTSSs have been demonstrated in many pathogenic bacteria (Hueck 1998). TTSSs enable Gram–negative bacteria to secrete and inject bacterial effector proteins into cytoplasm of eukaryotic host cell. The secretion apparatus consists of rings spanning the bacterial membranes, linked by a ~60-nm–long needle protruding outside the bacterial body (Blocker et al. 2001; Kimbrough and Miller 2000; Kubori et al. 1998). The injection process requires the presence of translocator proteins, which form a pore into the target cell. Therefore, the effector proteins are able to translocate into the cytosol of the target cell (Figure 15) (Troisfontaines and Cornelis 2005).

Figure 15 A resting TTSS where effectors and translocators are stored inside a bacterium, (A). The translocator forms a pore into the target cell membrane (B). Electron micrograph of the surface of Yersinia enterocolitica with protruding needles. 
[Source: From Troisfontaines and Cornelis (2005)]

TTSSs were first described in Yersinia spp. and are presented in a number of pathogenic bacteria such as Shigella, Salmonella, Escherichia coli, Erwinia and P. aeruginosa

TTSSs in Vibrio spp. were first reported in V. parahaemolyticus (Park et al. 2004). Two sets of genes, TTSS1 and TTSS2, have been identified in V. parahaemolyticus. An effector protein VopD was secreted in a TTSS1-dependent manner, and was involved in the cytotoxicity of the HeLa cells. In contrast, VopP effector protein was secreted via the TTSS2 pathway and played an important role in enterotoxigenicity in rabbit model. Interestingly, TTSS1 was found in all of the V. parahaemolyticus strains and also was detected in other vibrios, such as V. alginolyticus, V. harveyi and V. tubiashii (Park et al. 2004). However, TTSS2 was present only in V. parahaemolyticus isolates that possess tdh gene.

TTSS gene of V. harveyi has been identified and three gene clusters have been demonstrated (Figure 16) (Henke and Bassler 2004a). They are similar in sequence, organization, and regulation to TTSS gene locus recently reported in V. parahaemolyticus (Makino et al. 2003). The putative TTSS proteins of V. harveyi are Vop (Vibrio outer protein), Vsc (Vibrio secretion), Vcr (Vibrio calcium response).

**Figure 16** TTSS operon of V. harveyi.
[Source: From Henke and Bassler (2004) with slightly modification]

The most conserved parts of secretion apparatus of TTSS belong to the “lcrD superfamily” which encode for inner–membrane channel proteins of TTSS (Plano et al. 1991). One important protein is low calcium response protein LcrD (encoded by the gene lcrD), which detected in Y. pestis. LcrD is homologous to VcrD (encoded by vcrD) in V. harveyi (Figure 16).

Regulation of TTSS in V. harveyi by quorum sensing was first described by (Henke and Bassler 2004a). At high cell density, quorum sensing of V. harveyi suppressed TTSS whereas it was activated at low cell density. This is different from TTSS detected in enterohemorrhagic and enteropathogenic E. coli in which their quorum sensing activated TTSS at high cell density, and suppressed TTSS at low cell density.
Hemolysins

Hemolysin has been reported as a virulence factor of Vibrio spp. Many bacteria in the genus Vibrio for example, V. cholerae, V. parahaemolyticus, V. vulnificus, V. anguillarum, and V. mimicus possess hemolysins (Zhang and Austin 2005). Some hemolysin genes have been detected only in pathogenic strains (Honda et al. 1988; Miyamoto et al. 1969).

Currently, four representative hemolysin families were demonstrated in Vibrio spp., including TDH (thermostable direct hemolysin) family of V. parahaemolyticus, H1yA (El Tor hemolysin) family of V. cholerae, TLH or LDH (thermolabile hemolysin or lecithin-dependent hemolysin) family of V. parahaemolyticus, δ–VPH (thermostable hemolysin) family of V. parahaemolyticus (Table 8) (Baida and Kuzmin 1995; Chang et al. 1997; Fallarino et al. 2002; Hamada et al. 2007; Shinoda 1999). There are no identity found among the different families (Zhang and Austin 2005).

Hemolysin gene of V. harveyi (vhh) has been demonstrated (Zhang et al. 2001). The amino acid sequence of V. harveyi VHH protein shows high homology to the hemolysin in TLH family such as lecithinase LEC of V. cholerae (64.3%) (Fiore et al. 1997), Lecithinase PHL of V. mimicus (65.3%) (Kang et al. 1998), TLH or LDH of V. parahaemolyticus (85.6%) (Shinoda et al. 1991), and VPL (Genbank AF291424) of V. vulnificus (75.6%).

The most pathogenic V. harveyi (VIB645) which produced extracellular products (ECPs) that caused highest hemolytic activity to fish erythrocytes possesses two copies of hemolysin genes (vhhA/vhhB) (Zhang et al. 2001). Both genes had an open reading frame of 1,254 nucleotides, which is the same size as the tlh gene of V. parahaemolyticus (Nishibuchi and Kaper 1985). Purified VHH protein was cytotoxic to flounder gill cells in tissue culture, had strong pathogenicity to flounder when injected intraperitoneally, and had phospholipase activity on egg yolk agar (Zhong et al. 2006).

Hemolytic activity of V. harveyi was first described by Liu et al. (1996a). V. harveyi isolated from diseased penaeids were more virulent to tiger prawns and exhibited higher hemolytic activities against sheep and fish erythrocytes than those of non-virulent isolates from sea water or diseased Talorchestia sp. (Liu et al. 1996a). Investigation V. harveyi on fishes, Atlantic salmon and rainbow trout, demonstrated that both pathogenic and non–pathogenic V. harveyi isolates produced ECPs containing caseinase, gelatinase, phospholipase, lipase and hemolysins, however, one of the pathogenic strains seem to produce high level of hemolysin (Zhang and Austin 2000).
V. harveyi hemolysin was demonstrated to be a lysophospholipase or a phospholipase B by gas chromatography and the phospholipase and hemolytic activity of the VHH is inhibited by disruption of Ser153 active site (Sun et al. 2007). Phospholipases are the major virulence factors of many pathogenic bacteria that act on eukaryotic cells by hydrolyzing the cell wall phospholipids, leading to the loss of cell integrity and cytolysis (Schmiel and Miller 1999). Phospholipase toxicity to blood cells could lead to systemic infection and phospholipase that affect membrane phospholipids could lead to host tissue damage (Istivan and Coloe 2006). The role of VHH in shrimp pathogenicity and its mode of action on invertebrate cells have not yet been clearly understood.

In India PCR primers targeted to vhh gene were developed to identify V. harveyi strains isolated from P. monodon hatcheries. It was demonstrated that vhh gene is not only detected in V. harveyi isolated from luminescent vibriosis shrimp, but also detected in V. harveyi isolated from healthy shrimp (Parvathi et al. 2009). Therefore, vhh gene may not be specific for identification pathogenic strains of V. harveyi. Zhang et al. (2001) showed that one of the V. harveyi isolate, VIB 645, harbored the duplicate hemolysin gene and this did not increased levels of the VHH detected by Northern blot analysis. This indicates that some factors might involve in expression of vhh. Further investigation should be conducted to clarify this.

**Protease**

Three extracellular proteases were demonstrated in V. harveyi isolated from seawater (Fukasawa et al. 1988a; Fukasawa et al. 1988b). These proteases are alkaline metal–chelator–sensitive. An extracellular cysteine protease was reported from V. harveyi isolates from diseased tiger prawn (Liu et al. 1997). The cysteine protease was considered as the major exotoxin of pathogenic V. harveyi (Lee et al. 1999; Liu and Lee 1999). It played an important role in diseased P. monodon by causing unclottable plasma in shrimps leading to the dissemination and propagation of V. harveyi in shrimp. The purified protease (38 kDa) was heat labile and could be inactivated at temperatures above 60°C.
### Table 8 Hemolysins produced by vibrios.

<table>
<thead>
<tr>
<th>Hemolysin family and <em>Vibrio</em> Species</th>
<th>Name or abbreviation</th>
<th>Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. HlyA and related hemolysins</td>
<td></td>
<td></td>
</tr>
<tr>
<td><em>V. cholerae</em> O1 biotype El Tor</td>
<td>El Tor hemolysin</td>
<td>65 kDa (64,864 Da)(^\text{a}), two-step processing for mature protein, colloid osmotic hemolysis, RIL(^\text{b}) positive</td>
</tr>
<tr>
<td></td>
<td>(HlyA)</td>
<td></td>
</tr>
<tr>
<td><em>V. cholerae</em> non-O1</td>
<td>NAG hemolysin</td>
<td>Indistinguishable from El Tor hemolysin (biologically, physiochemically, immunologically)</td>
</tr>
<tr>
<td><em>V. mimicus</em></td>
<td>VMH</td>
<td>63 kDa (65,972 Da), two step processing for mature protein, colloid osmotic hemolysis, RIL positive, 81.6% homology with <em>V. cholerae</em> HlyA hemolysin</td>
</tr>
<tr>
<td><em>V. fluvialis</em></td>
<td>VFH</td>
<td>84,260 Da (Calculated from amino acid sequence deduced from open reading frame including signal peptide), 57% homology with <em>V. cholerae</em> HlyA hemolysin</td>
</tr>
<tr>
<td><em>V. anguillarum</em></td>
<td>VAH1</td>
<td>57.3% homology with <em>V. cholerae</em> HlyA hemolysin</td>
</tr>
<tr>
<td><em>V. vulnificus</em></td>
<td>VVH</td>
<td>51 kDa (50,851 Da), colloid osmotic cell lysis, temperature-independent binding to cholesterol (suspecting binding site)</td>
</tr>
<tr>
<td><em>V. tubiashii</em></td>
<td>Cyolysin</td>
<td>59 kDa, sensitive to heat and protease, inhibited by cholesterol</td>
</tr>
<tr>
<td>2. TDH and related hemolysins</td>
<td></td>
<td></td>
</tr>
<tr>
<td><em>V. parahaemolyticus</em></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Kanakawa–positive</td>
<td>Vp–TDH</td>
<td>Tetramer of 75 kDa (18,600 Da each subunit), thermostable (heating at 100°C), colloid osmotic cell lysis, RIL positive, cardiotoxicity</td>
</tr>
<tr>
<td>Kanakawa–negative</td>
<td>Vp–TRH</td>
<td>Closely related to Vp–TDH but thermolabile, virulence factor in KP–negative strains</td>
</tr>
<tr>
<td><em>G. hollisae</em></td>
<td>Vh–TDH</td>
<td>Thermolabile</td>
</tr>
<tr>
<td><em>V. cholerae</em> non-O1</td>
<td>NAG–TDH</td>
<td>Thermolabile</td>
</tr>
<tr>
<td><em>V. mimicus</em></td>
<td>Vm–TDH</td>
<td>Thermolabile</td>
</tr>
</tbody>
</table>
Table 8 (continued).

<table>
<thead>
<tr>
<th>Hemolysin family and Vibrio Species</th>
<th>Name or abbreviation</th>
<th>Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>3. TLH and related hemolysin</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><em>V. cholerae</em> O1</td>
<td>Lecithinase LEC</td>
<td>Thermolabile</td>
</tr>
<tr>
<td><em>V. harveyi</em></td>
<td>VHH</td>
<td>45 kDa, Thermolabile, 64.3% homology with <em>V. cholerae</em> LEC hemolysin, phospholipase B</td>
</tr>
<tr>
<td><em>V. mimicus</em></td>
<td>Lecithinase PHL</td>
<td>Thermolabile</td>
</tr>
<tr>
<td><em>V. parahaemolyticus</em></td>
<td>TLH</td>
<td>43 kDa (41,453 Da) and 45 kDa (42,794 Da), lecithin–dependent indirect hemolysis (phospholipase A₂/lisophospholipase)</td>
</tr>
<tr>
<td><em>V. vulnificus</em></td>
<td>VPL</td>
<td>Thermolabile</td>
</tr>
<tr>
<td><strong>4. δ-VPH and related hemolysins</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><em>V. parahaemolyticus</em></td>
<td>δ-VPH</td>
<td>Thermostable</td>
</tr>
<tr>
<td><em>V. cholerae</em></td>
<td>Vc-δ TH</td>
<td>22.8 kDa, 71.5% homology with <em>V. parahaemolyticus</em> δ-VPH hemolysin, a product of dth gene</td>
</tr>
<tr>
<td><strong>5. Other hemolysins</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><em>V. cholerae</em> O1</td>
<td>HLX</td>
<td>10,451 Da, a product of hlx gene</td>
</tr>
<tr>
<td><em>V. mimicus</em></td>
<td>HLX</td>
<td>-</td>
</tr>
<tr>
<td><em>V. vulnificus</em></td>
<td>HLYIII</td>
<td>48% identity to <em>Bacillus cereus</em> haemolysin III</td>
</tr>
<tr>
<td></td>
<td>VLLY</td>
<td>Amino acid sequence show high similarity to the sequence of legiolysin of <em>Legionella pneumophila</em></td>
</tr>
</tbody>
</table>

* Molecular weight deduced from SDS–PAGE and amino acid sequence in parentheses.

* Rabbit ileal loop test (a test for enterotoxic activity)

[Source: From Baida and Kumin (1995); Chang et al. (1997); Fallarino et al. (2002); Hamada et al. (2007); Shinoda (1999); Zhang and Austin (2005) with slightly modification]
Toxin

Exotoxins have been demonstrated to involve in luminous disease in shrimp larvae and adult *P. monodon* (Liu et al. 1996a; Muir 1991). Two marine exotoxins, tetrodotoxin and anhydrotetrodotoxin, have been shown to be produced by *V. harveyi* isolated from seawater (Simidu et al. 1987).

Virulence of *V. harveyi* (strain 47666–1) was associated with a proteinaceous exotoxin (toxin T1) with a molecular mass of approximately 100 kDa (Harris and Owens 1999; Pizzutto and Hirst 1995). T1 was produced during the midexponential phase and T1 protein sequence was similar to virulence-associated proteins detected in gut pathogens such as *S. Typhimunum*, *S. flexneri*, and *B. thuringiensis* (Harris and Owens 1999). This toxin transferred bacteria from the gut to other tissues in mouse models (Gulig and Curtiss III 1987; Sansonetti et al. 1986) and to the mid-gut microvilli of lepidopteran larvae (Hofte and Whiteley 1989). Thus, it is possible that T1 enables luminous bacteria to pass *P. monodon* gut cells to larval tissue.

Bacteriophage

Bacteriophage could mediate *V. harveyi* virulence through shrimp model. Shrimp infected with nonpathogenic *V. harveyi* (VH1039) and diluted gill filtrate containing bacteriophage showed 100% mortality within 48 h. This result suggested that bacteriophage might mediate toxicity of *V. harveyi* in tiger prawn by transfer a toxin gene (s) or gene (s) controlling toxin production (Ruangpan et al. 1999).

A new bacteriophage from pathogenic *V. harveyi*, called VHML (*V. harveyi* myovirus–like) was discovered (Oakey et al. 2000). This VHML infected *V. harveyi* through the process of lysogenic conversion, and might be responsible for exotoxin production including increased hemolytic activity in salmon, *Artemia* nauplii and *Artemia* cysts (Austin et al. 2003; Manefield et al. 2000; Oakey and Owens 2000). The nucleotide sequence of VHML revealed a putative Open Reading Frame 17 (ORF17) that regulates the production of N6-Dam (DNA adenine methyltransferase) protein. The translated sequence of ORF17 contained a site similar to the active site for ADP–ribosylating toxin (APDRT) with possesses neurotoxic activity (Oakey et al. 2002).

A novel *V. harveyi* siphoviridae–like phage 1 (VHS1) was isolated from a tiger shrimp–rearing pond in Thailand but it was unclear whether it involved in virulence of *V. harveyi* (Khemayan et al. 2006; Pasharawipas et al. 2005).
Siderophore

Siderophore is bacterial secreted molecules that scavenge iron from the environment for cell growth, particularly for replication of the cytochrome systems. Siderophore production is associated with production of iron repressible outer membrane proteins (IROMP) which act as receptors for the iron–siderophore complex (Crosa 1989). These systems have been found to be major determinates of virulence in V. cholerae non–O1, V. anguillarum and Aeromonas salmonicida (Amaro et al. 1990; Hirst and Ellis 1994; Pybus et al. 1994).

Siderophore of V. harveyi was demonstrated on a modified chrome azurol sulphate agar (Owens et al. 1996) and was considered as a virulence factor of V. harveyi isolated from fish. However, it was not detected in the isolates from infected invertebrates (Owens et al. 1996). Because invertebrates do not possess iron–binding compounds such as lactoferrin, transferritin and haemoglobin as in vertebrates, therefore, expression of siderophore in bacteria is limited. High siderophore activity was detected in environmental V. harveyi. Owens et al. (1996) suggested that iron is quickly oxidized to ferric salts and precipitates in seawater, thus it become biologically unavailable particularly in neutral or alkaline pH.

Biofilm

V. harveyi that form biofilm caused large–scale mortalities in prawn hatcheries (Karunasagar et al. 1994). Biofilm is an evidence that population of microorganisms that is growing and attaching to a surface (Costerton et al. 1999). In shrimp hatcheries, bacteria settle on the surface of various materials such as pipes and tanks and form biofilms (Karunasagar et al. 1996). These adherent cells are embedded within a self–produced extracellular polysaccharide (Costerton et al. 1999). Biofilm formation is an important phenomenon in aquatic systems. Bacteria may adopt this as one of the survival strategies to avoid stress conditions because in shrimp hatcheries, they are exposed to disinfectants and antibiotics regularly.
Bacteriocin-like substance

Bacteriocins are proteins produced by bacteria to inhibit the growth of similar or closely related bacterial strain(s) (Klaenhammer 1988; Reeves 1965; Tagg et al. 1976). Bacteriocin-like substance (BLIS) in \textit{V. harveyi} was reported (McCall and Sizemore 1979). This bacteriocin, ‘harveyicin SY’, was lethal to two strains of \textit{V. harveyi}, KN96 and BBP8. A novel BLIS was detected from strain of \textit{V. harveyi} (VIB571) that has been demonstrated to be pathogenic to rainbow trout (\textit{Oncorhynchus mykiss}) and Atlantic salmon (\textit{Salmo salar}) (Prasad et al. 2005). This BLIS inhibited four isolates of \textit{V. harveyi}, and each one isolate of \textit{V. fisheri}, \textit{V. gazogenes} and \textit{V. parahaemolyticus}.

Other possible virulence factors

Other factors reported as virulence factors of \textit{V. harveyi} are chitinase, lipopolysaccharide and swarming capability. Chitinase facilitates \textit{V. harveyi} to attach to chitin of marine animals to colonize on the surface (Montgomery and Kirchman 1993; Montgomery and Kirchman 1994). In addition, it can digest chitin and enable bacteria to penetrate into host (Shahabuddin and Kaslow 1993). However, the chitinase activity of pathogenic and nonpathogenic \textit{V. harveyi} was similar (Liu et al. 1996b). In contrast, chitinase-negative \textit{V. harveyi} isolate was demonstrated to be more virulent than the chitinase-positive \textit{V. harveyi} isolate (Jiravanichpaisal and Miyazaki 1994). Therefore, it is possible that chitinase is not a crucial virulence factor for infection.

Lipopolysaccharide (LPS) is a surface antigen on outer membrane of Gram-negative bacteria which act as endotoxins and induces host immune systems (Raetz and Whitfield 2002). LPS of \textit{V. harveyi} is lethal toxin that possesses cytotoxic, proteolytic and haemolytic activity (Montero and Austin 1999).

Swarming capability of \textit{V. harveyi} has been demonstrated to cause mortalities in experimental inoculated North sea fish (\textit{Solea solea}). It was concluded that genes involved in swarming might link to some of virulence genes (Zorrilla et al. 2003).
Molecular pathogenesis investigation of bacteria

Criteria for identifying bacterial virulence factors using molecular technique followed Koch’s postulates was originally proposed by Falkow and modified by Gulig (Falkow 1988; Gulig 1993). These rules stated that there must be an association between virulence factor and disease. A mutation that disrupts gene expression of that factor must reduce the virulence and this virulence could be restored by complementation with that gene in the wild type. In addition, identification of factor involved in virulence gene expression can be use to confirm correlation between virulence factor and its pathogenesis.

Many techniques have been reported for disruption gene. Transposable genetic elements (transposon or Tn) have been uses as a molecular tool to introduce insertions into genomic DNA (target genes). When the target gene is inserted, mutation or dysfunction of gene occurs (Figure 17) (Dale and Park 2004). Transposons will be randomly inserted into the host DNA to generate large number of mutants that can be determined by screening for impairment of gene function. Transposon mutagenesis has been used in a variety of bacteria including Leishmania sp., Haemophilus sp., Streptococcus sp., Esherichia sp. and Mycobacterium sp. (Akerley et al. 1998; Gueiros-Filho and Beverley 1997; Rubin et al. 1999). In addition it has been used to define the genes encoding Dictyostelium virulence in V. cholerae strain V52 (Pukatzki et al. 2006), identify essential genes required for bioluminescence (luxCDABE genes) (Martin et al. 1989), cgtA gene involved in the regulation of signal transduction (Czyz et al. 2001) and vopN, vscP and vopB genes encoding putative TTS proteins in TTSS of V. harveyi (Henke and Bassler 2004).

![Figure 17](image_url) Insertion of transposon (Tn) into target gene results in gene mutation. [Source: From Dale and Park (2004) with slightly modification]
Another gene disruption technique is based on homologous recombination (DNA crossover). Plasmid containing a fragment of gene required for disruption will be crossed over with specific gene in a bacterium host. A specific gene replaced by a fragment of gene results in disruption or dysfunction of that gene, for example, disruption of \( \text{cyn}D_{C1} \) gene in \( B. \ pumilus \) (Figure 18). \( \text{cyn}D_{C1} \) encoded for C1 cyanide dihydratase was disrupted by the integration of plasmid containing 539–bp PCR product of cyanide dihydratase (\( \text{cyn}D_{C1529} \)) causing no expression of \( \text{cyn}D_{C1} \) (Jandhyala et al. 2003). In \( Vibrio \) spp., \( \text{toxR} \) gene of \( V. \ cholerae \) was disrupted by integration of plasmid containing a portion of the \( \text{toxR} \) coding sequence. Mutation in \( \text{toxR} \) gene resulted in changing the expression of outer membrane proteins OmpT and OmpU of \( V. \ cholerae \) (Miller and Mekalanos 1988).

**Figure 18** Homologous recombination–based gene disruption. Plasmid integration into the \( \text{cyn}D \) gene of bacteria by homologous recombination.

[Source: From Jandhyala et al. (2003) with slightly modification]
Proteomics technologies

Two-dimensional gel electrophoresis (2-DE)

2-DE is a powerful technique for investigation the entire set of proteins (proteomes) expressed by a genome of bacteria. This technique, proteins are separated by molecular charge and molecular weights (Figure 19). Proteins are first solubilized in a denaturing buffer containing a neutral chaotrope, a zwitterionic or neutral detergent, and a reducing agent. In the first-dimension, proteins will be separated according to their isoelectric point (pI) using high voltage and pH gradient. Proteins will be migrated followed their charges (either cation or anion net charges) and stopped when the net charge is zero by pH gradient. Then equilibration is performed with dithiothreitol (DTT) and iodoacetamide to make protein unfolding completely. In the second dimension, proteins are separated by molecular weights using sodium dodecyl sulfate polyacrylamide gel electrophoresis (SDS-PAGE). Therefore, each protein is differentiated by a unique isoelectric point and molecular weight (Rosenberg 2004). After staining, proteomic pattern will be analyzed by gel image analysis, and each interested protein spot will be identified by mass spectrometry sequence analysis combining with database analysis (Figure 20).

Figure 19 Diagram represents 2-D gel electrophoresis.
[Source: From Rosenberg (2004) with slightly modification]
Mass spectrometry (MS)

MS is a technique used to measures the molecular weight of molecules based on the motion of a charged particle in an electric or magnetic field. With this technique, each protein sample (spot) is digested with proteolytic enzyme such as trypsin and protein fragments are separated by High Performance Liquid Chromatography (HPLC). Then, in the gas phase, the protein molecules are converted into ions by electrospray ionization (ESI) and separated according to their mass-to-charge ratio (m/z) using mass analyzer. The m/z values are plotted against their intensities to reveal the different (ionizable) components in the sample and their molecular mass. Recently, nano LC–ESI–MS/MS system with the 0.05–0.1 mm inner diameter of HPLC column was used to increase the sensitivity and reproducibility of the separation (Chervet et al. 1996).

Protein identification by MASCOT search

MASCOT (http://www.matrixscience.com/search_form_select.html) is a popular tool used to analyze the raw MS data from peptide fragments by submission it to the National Center for Biotechnology Information non-redundant (NCBI-nr) database (Rastogi and Mendiratta 2006). Identification of the predicted peptide from raw MS data is done by the MASCOT MS/MS Ion Search program (Figure 20) (“Today’s Proteomics” 2010).

Figure 20 Protein identification by 2-D electrophoresis, mass spectrometry and database analysis.
[Source: From “Today’s Proteomics” (2010)]
Shrimp model for studying *V. harveyi* pathogenesis

Several animal models have been used to identify virulence factors of *V. harveyi* for example fish and shrimp (Amparyup et al. 2009; Jiravanichpaisal and Miyazaki 1994; Lee et al. 1999; Ruangpan et al. 1999; Saeed 1995; Sun et al. 2007). However, penaeid shrimp seems to be the most commonly used for investigation of *V. harveyi* (Figure 21) (Primavera 1990). In Thailand, *P. monodon* (black tiger shrimp) and *L. vannamei* (Pacific white shrimp) are susceptible to *V. harveyi*-associated disease in shrimp culture. Thus in this study, they are selected to be an animal model of determining virulence of *V. harveyi*.

**Figure 21** Diagram of penaeid shrimp.
[Source: From Primavera (1990) with slightly modification]

Most of virulence investigations in shrimp model evaluate median lethal dose (LD$_{50}$) after injection bacteria into shrimp (Reed and Muench 1938). In this study we have established competition assay to evaluate ability of *V. harveyi* wild type and mutant strains in colonizing in shrimp. Virulence attenuation of the strains is determined by competitive index (CI).
Control of *V. harveyi*

*V. harveyi* is an important pathogen causing luminous disease in cultured shrimp. Therefore, control of this bacterium is necessary to reduce a massive damage in shrimp industry. Some marine bacteria and fungi have been reported to produce antibacterial, antifungal, antiviral including anti-tumor substances (Bernan et al. 1997; Rosenfeld and ZoBell 1947). Several studies have suggested that marine bacteria can be used to combat epizootics in aquaculture systems (Abraham et al. 2001; Douillet and Langdon 1994; Maeda and Liao 1992; Maeda et al. 1997).

The first publication on biological control in aquaculture was reported in 1980, and since then it has been continuously increased (Yasuda and Taga 1980). Isolated bacterium from soil, strain PM-4, increased *P. monodon* and *P. trituberculatus* larvae survival and decreased vibrio densities (Maeda and Liao 1992). *V. alginolyticus* isolated from Pacific Ocean seawater increased survival and weight of *L. vannamei* postlarvae and decreased number of *V. parahaemolyticus* detected in the shrimps (Garriques and Arevalo 1995). In addition, bacteria strain BY-9 isolated from coastal seawater also showed the same results (Verschuere et al. 2000). Moreover, a probiotic, *Pseudomonas* I–2, was able to inhibit growth of shrimp pathogenic vibrios, including *V. harveyi*, *V. fluvialis*, *V. parahaemolyticus*, *P. damselae*, and *V. vulnificus* (Chythanya and Karunasagar 2002). Marine bacterium *Alteromonas* sp. could protects *P. monodon* larvae from *V. harveyi* infection by reducing the mortality to 59% (Abraham and Palaniappan 2004). A significant reduction in the mortality of 25% in rainbow trout (*Oncorhynchus mykiss*) against *V. anguillarum* after pretreatment with *P. fluorescens* AH2 was observed (Gram et al. 1999). Therefore, it is interesting to isolate some bacteria from marine environment to use as a biological control of *V. harveyi* in shrimp pond.
OBJECTIVES

1. To characterize *V. harveyi* isolated from marine animals by determination of extracellular products and genes involved in hemolytic activity.

2. To distinguish virulence and non-virulence *V. harveyi* isolates by DNA fingerprinting using RAPD technique.

3. To determine factor involved in virulence gene expression of *V. harveyi* using transposon mutagenesis and homologous recombination-based gene disruption techniques.

4. To establish competition assay for evaluation virulence of *V. harveyi* in shrimp model.

5. To identify proteins involved in virulence gene expression of *V. harveyi* using two dimensional gel electrophoresis.

6. To investigate inhibitory activity of bacteria isolated from marine sediments on *V. harveyi*.
CHAPTER 2

RESEARCH METHODOLOGY

MATERIALS AND EQUIPMENTS

1. Bacterial strains

All isolates of *V. harveyi* from marine samples were obtained from shrimp, fish, mollusks, mantis shrimp and crab in Hat Yai city, Thailand. Other *V. harveyi* isolates, *V. harveyi* NICA was obtained from the National Institute of Coastal Aquaculture (NICA), Thailand. *V. harveyi* HY01 was isolated from a black tiger shrimp that died from luminous vibriosis in Hat Yai city, Thailand. *V. harveyi* BAA–1116 (BB210) (Bassler et al. 1997) was provided by Prof. John Mekalanos, Department of Microbiology and Molecular Genetics, Harvard University, USA. *V. carchariae, V. cholerae* O1, *V. cholerae* non–O1, *V. parahaemolyticus, V. vulnificus, V. alginolyticus, V. campbellii, V. furnissii, V. fluvialis, V. hollisae (G. hollisae)* and *E. coli* were obtained from stock culture of Department of Microbiology, Prince of Songkla University. *E. coli* DH5α/λpir and *E. coli* BW20767/λpir were obtained from Asst. Prof. Janelle Thompson, Department of Civil and Environmental Engineering, Massachusetts Institute of Technology, USA. All isolates were kept in 15% glycerol at -70°C until used.

2. Plasmids

The vector pSC189 (Km<sup>R</sup>), a plasmid carrying the *mariner*-based transposon containing both the hyperactive transposase C9 (Lampe et al. 1999) and transposon terminal inverted repeats flanking a kanamycin resistance gene was modified by insert the selectable chloramphenicol marker into the *PstI* restriction site to obtained pJT064 (Figure 22). pJT064 vector was used in transposon mutagenesis for delivery transposon from *E. coli* to *V. harveyi*. pSC189 (Chiang and Rubin 2002) was obtained from Asst. Prof. Janelle Thompson, Department of Civil and Environmental Engineering, Massachusetts Institute of Technology, USA.
Plasmid pCVD422 is one of the most commonly used for gene mutation. In this study pJT084 (Figure 23), a pCVD422 derivative plasmid was constructed in this study and was used in homologous recombination–based gene disruption.

**Figure 22** Structure of pJT064 transposon–base delivery system. IR, inverted repeat; ApR, CmR and KmR, ampicillin, chloramphenicol and kanamycin resistance gene, respectively.

**Figure 23** Structure and restriction sites of pJT084 plasmid for constructs homologous recombination–based gene disruption mutant. CmR, chloramphenicol resistance gene.
3. **Microbiological media**

All microbiological media used in this study were purchased from Difco (USA); Merck (Germany).

4. **Chemicals**

All chemicals used in this study are of analytical grade that were purchased from Merck (Germany); Sigma–Aldrich (USA); Lab–Scan Asia Co., Ltd. (Thailand).

5. **Antibiotic drugs**

The antibiotic drugs used in this study, including streptomycin and chloramphenicol were purchased from General Drug House (Thailand).

6. **PCR reagents and primers**

PCR reagents including 10× buffer (Magnesium Free; containing 100 mM Tris–HCl [pH 9.0]), 25 mM MgCl₂, 2.5 mM deoxynucleotide triphosphates (dNTPs) and Taq DNA polymerase in storage buffer A (5 U/µl) were purchased from Promega Corp. (Madison, WI, USA). The oligonucleotide primers were synthesized by Operon Tech. (Alameda, CA, USA) (Table 9).

The RAPD reagents including dNTPs, 10× Ex Taq buffer and Ex Taq DNA polymerase were obtained from TaKaRa Biochemicals, Tokyo. A random 10-mer primer, primer 2 (5’-GTTTCGCTCC-3’), was synthesized by Operon Tech. (Alameda, CA, USA).

The PCR reagents used in two-round semiarbitrary PCR (Ewen et al. 2008) to identify the insertion size of transposon mutants including 100× BSA, 10× ThermoPol buffer, and Vent DNA Polymerase were purchased from NEB (Beverly, MA, USA). Betaine was purchased from Sigma (St Louis, MO, USA), and dNTPs were purchase from QIAGEN (Valencia, CA, USA). The primers were synthesized by IDT Tech. (Coralville, IA, USA) (Table 10).

The primers and reagents for gene disruption including 10× ThermoPol buffer, and Vent DNA Polymerase were purchased from NEB (Beverly, MA, USA). dNTPs were purchase from QIAGEN (Valencia, CA, USA). The primers were synthesized by IDT Tech. (Coralville, IA, USA) (Table 11).
### Table 9

Primers used for identification of *V. harveyi* and detecting *vhh*, *vcrD* and *hhl* genes in *V. harveyi*. W = A or T; R = A or G

<table>
<thead>
<tr>
<th>Primers</th>
<th>Primer sequence 5’ → 3’</th>
<th>Product size (bp)</th>
<th>References</th>
</tr>
</thead>
<tbody>
<tr>
<td>A2</td>
<td>TCTA ACTATCCACCCGG</td>
<td>393</td>
<td>Thaithongnum et al. 2006</td>
</tr>
<tr>
<td>B3</td>
<td>AGCAATGC CATCTCAGTTC</td>
<td>332</td>
<td>This study</td>
</tr>
<tr>
<td>vcrD1</td>
<td>TGWRACACGGGTAACGATGA</td>
<td>332</td>
<td>This study</td>
</tr>
<tr>
<td>vcrD2</td>
<td>GTAAGCAGATGAGRATGACCG</td>
<td>914</td>
<td>This study</td>
</tr>
<tr>
<td><em>vhh−F</em></td>
<td>AAGTAATCAGCAGCAGACGAGCG</td>
<td>1019</td>
<td>This study</td>
</tr>
<tr>
<td><em>vhh−R</em></td>
<td>GAGTGGGCAAGAAAAATCCAGATGG</td>
<td></td>
<td></td>
</tr>
<tr>
<td><em>hhl−F</em></td>
<td>TTCAGAAAGACTTATGGGCTGG</td>
<td></td>
<td></td>
</tr>
<tr>
<td><em>hhl−R</em></td>
<td>TAAACCCGTGATAGATTGGGCG</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Table 10

Primers used in Nested PCR for identification of transposon insertion sites in *V. harveyi* chromosome. [Source: From references Cameron et al. (2008)]

<table>
<thead>
<tr>
<th>Primers</th>
<th>Primers Targets</th>
<th>Primer sequence 5’ → 3’</th>
</tr>
</thead>
<tbody>
<tr>
<td>MarEC6</td>
<td>Transposon</td>
<td>GCTTGTCATCGATCCTTGGTTGATCG</td>
</tr>
<tr>
<td>Mar2018</td>
<td>Transposon</td>
<td>CAAACTGGAACAAAACCTCAACC</td>
</tr>
<tr>
<td>ARB6</td>
<td>Chromosome</td>
<td>GGCCACCGCTGACTAGTACNNNNNNNNACGCC</td>
</tr>
<tr>
<td>ARB7</td>
<td>Chromosome</td>
<td>GGCCACCGCTGACTAGTACNNNNNNNNNCGAA</td>
</tr>
<tr>
<td>ARB2</td>
<td>Chromosome</td>
<td>GGCCACCGCTGACTAGTAC</td>
</tr>
</tbody>
</table>

### Table 11

Primers designed in this study used for gene disruption mutagenesis.

<table>
<thead>
<tr>
<th>Primers</th>
<th>Primer sequence 5’ → 3’</th>
<th>Product size (bp)</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>rpoE−F</em>1197</td>
<td>CATGTCTCTAGAGGGCGGAACTGCGTCTTAC</td>
<td>697</td>
</tr>
<tr>
<td><em>rpoE−R</em>1893</td>
<td>CATGTCTCTAGATTTTGTTGGCTCGTCTGCGAC</td>
<td>1228</td>
</tr>
<tr>
<td><em>rseA−F</em>1676</td>
<td>CATGTCTCTAGATAGAAAGCACAAGCAGACAGCCCTG</td>
<td>516</td>
</tr>
<tr>
<td><em>rseA−R</em>2903</td>
<td>CATGTCTCTAGACCCAACCTTACATTCCAGTTACTCG</td>
<td>914</td>
</tr>
<tr>
<td><em>rseB−F</em>2410</td>
<td>CATGTCTCTAGATGCGACTACAGACAAAGACCCAG</td>
<td>332</td>
</tr>
<tr>
<td><em>rseB−R</em>2925</td>
<td>CATGTCTCTAGATGGGAAACCTTCCAGCGC</td>
<td>1019</td>
</tr>
</tbody>
</table>
7. DNA probes for Southern blot hybridization

To detect the *vhh* and *hhl* gene of *V. harveyi*, the DNA probes used for Southern blot hybridization were 914–bp and 1019–bp nucleotide sequences, respectively. The DNA probes were derived from PCR amplification using the *vhh* and *hhl* primers listed in Table 9. The thermal cycling conditions were described in Methods.

All probes were isolated by agarose gel electrophoresis and purified by QIAquick Gel Extraction Kit (QIAGEN), and then labeled with digoxigenin (Roche Diagnostics) according to the manufacturer’s specifications.

8. Reagents

<table>
<thead>
<tr>
<th>Reagents</th>
<th>Company</th>
</tr>
</thead>
<tbody>
<tr>
<td>DIG–High Prime DNA Labeling and Detection Starter Kit I</td>
<td>Roche Diagnostics (Germany)</td>
</tr>
<tr>
<td>DryStrip Cover Fluid</td>
<td>GE Healthcare Bio–Sciences (NJ, USA)</td>
</tr>
<tr>
<td>Plus One 2–D Quant Kit</td>
<td>GE Healthcare Bio–Sciences (NJ, USA)</td>
</tr>
<tr>
<td>PUREGENE Core Kit A</td>
<td>QIAGEN (CA, USA)</td>
</tr>
<tr>
<td>QIAprep Spin Miniprep Kit</td>
<td>QIAGEN (CA, USA)</td>
</tr>
<tr>
<td>QIAquick Gel Extraction Kit</td>
<td>QIAGEN (CA, USA)</td>
</tr>
<tr>
<td>2–D Clean–Up Kit</td>
<td>GE Healthcare Bio–Sciences (NJ, USA)</td>
</tr>
</tbody>
</table>

9. Enzymes

<table>
<thead>
<tr>
<th>Enzymes</th>
<th>Company</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alkaline Phosphatase</td>
<td>New England Biolabs, Inc. (MA, USA)</td>
</tr>
<tr>
<td><em>EcoRI</em> restriction enzyme</td>
<td>New England Biolabs, Inc. (MA, USA)</td>
</tr>
<tr>
<td>Proteinase K</td>
<td>Sigma–Aldrich, Inc. (MO, USA)</td>
</tr>
<tr>
<td><em>PstI</em> restriction enzyme</td>
<td>New England Biolabs, Inc. (MA, USA)</td>
</tr>
<tr>
<td>RNase</td>
<td>Merck &amp; Co., Inc. (NJ, USA)</td>
</tr>
<tr>
<td>T4 DNA ligase</td>
<td>New England Biolabs, Inc. (MA, USA)</td>
</tr>
<tr>
<td><em>XbaI</em> restriction enzyme</td>
<td>New England Biolabs, Inc. (MA, USA)</td>
</tr>
</tbody>
</table>
10. Miscellaneous

<table>
<thead>
<tr>
<th>Product Description</th>
<th>Company</th>
</tr>
</thead>
<tbody>
<tr>
<td>30% Acrylamide/Bis Solution</td>
<td>Bio-Rad Laboratories (MA, USA)</td>
</tr>
<tr>
<td>Agarose</td>
<td>Gibco (NY, USA)</td>
</tr>
<tr>
<td>Immobiline Drystrip (7 cm, pH range 4–7)</td>
<td>GE Healthcare Bio-Sciences (NJ, USA)</td>
</tr>
<tr>
<td>Lambda DNA/HindIII marker</td>
<td>Bio-Rad Laboratories (MA, USA)</td>
</tr>
<tr>
<td>SDS–PAGE molecular weight standards (low range)</td>
<td>Bio-Rad Laboratories (MA, USA)</td>
</tr>
<tr>
<td>1 kb DNA Ladder</td>
<td>New England Biolabs, Inc. (MA, USA)</td>
</tr>
<tr>
<td>100 bp DNA Ladder</td>
<td>New England Biolabs, Inc., (MA, USA)</td>
</tr>
</tbody>
</table>

11. Equipments and instruments

<table>
<thead>
<tr>
<th>Equipments/Instruments</th>
<th>Company</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aquarium liquid filter (SP-7800)</td>
<td>KW Aquatic supplies SDN. BHD. (Malaysia)</td>
</tr>
<tr>
<td>Autoclave</td>
<td>Tomy (Japan)</td>
</tr>
<tr>
<td>Autopipette</td>
<td>Gilson (France)</td>
</tr>
<tr>
<td>Balances</td>
<td>Denver Instrument Company (NY, USA)</td>
</tr>
<tr>
<td>Bioprofile image analysis system</td>
<td>Viber Lourmat (France)</td>
</tr>
<tr>
<td>Centrifugation (H-103N)</td>
<td>Kokusan (Japan)</td>
</tr>
<tr>
<td>Densimat</td>
<td>bioMerièux (Italy)</td>
</tr>
<tr>
<td>Desiccator</td>
<td>Kartell (Italy)</td>
</tr>
<tr>
<td>Digital Dry Bath (Accublock)</td>
<td>Labnet International Inc. (NJ, USA)</td>
</tr>
<tr>
<td>DNASIS software for Windows ver. 2.1</td>
<td>Hitachi Software Engineering Co., Ltd. (Japan)</td>
</tr>
<tr>
<td>Electrophoresis apparatus</td>
<td>Bio-Rad Laboratories (MA, USA)</td>
</tr>
<tr>
<td>Ettan IPIPhore III</td>
<td>GE Healthcare Bio-Sciences (NJ, USA)</td>
</tr>
<tr>
<td>Freezer (4°C, −20°C and −70°C)</td>
<td>Sanyo (Japan)</td>
</tr>
<tr>
<td>Gel Documentation</td>
<td>Syngene (MD, USA)</td>
</tr>
<tr>
<td>Hot air sterilizer</td>
<td>BINDER (Germany)</td>
</tr>
<tr>
<td>Hot plate–Stirrers</td>
<td>Fisher Scientific (PA, USA)</td>
</tr>
<tr>
<td>Incubator (MIR-262)</td>
<td>Sanyo (Japan)</td>
</tr>
<tr>
<td>ImageMaster 2-D Platinum software</td>
<td>GE Healthcare Bio-Sciences (NJ, USA)</td>
</tr>
</tbody>
</table>
## 11. Equipments and instruments (continued)

<table>
<thead>
<tr>
<th>Equipments/Instruments</th>
<th>Company</th>
</tr>
</thead>
<tbody>
<tr>
<td>ImageScanner</td>
<td>GE Healthcare Bio-Sciences (NJ, USA)</td>
</tr>
<tr>
<td>Laminar airflow cabinet (ABS 1200A)</td>
<td>ASTEC microflow (UK)</td>
</tr>
<tr>
<td>Microcentrifuge (Eppendorf 5415C)</td>
<td>Brinkman Instrument Inc. (Germany)</td>
</tr>
<tr>
<td>Micro hybridization incubator (2000)</td>
<td>Robbins Scientific Corp. (CA, USA)</td>
</tr>
<tr>
<td>Microplate replicators</td>
<td>Boekel Scientific (PA, USA)</td>
</tr>
<tr>
<td>Microplate spectrophotometer (SpectraMax Plus®)</td>
<td>Molecular Device, Inc. (CA, USA)</td>
</tr>
<tr>
<td>MiniVE electrophoresis system</td>
<td>GE Healthcare Bio-Sciences (NJ, USA)</td>
</tr>
<tr>
<td>Olympus CH40 light microscope</td>
<td>Olympus (Japan)</td>
</tr>
<tr>
<td>Orbital shaker (TPM–2)</td>
<td>SARSTEDT (Germany)</td>
</tr>
<tr>
<td>PCR Gene Amp (PCR system 2400)</td>
<td>Perkin Elmer (CT, USA)</td>
</tr>
<tr>
<td>pH meter</td>
<td>Metrohm (Switzerland)</td>
</tr>
<tr>
<td>Square polystyrene assay dish with lid (245 mm square × 28 mm deep)</td>
<td>Corning (NY, USA)</td>
</tr>
<tr>
<td>Power supply (PowerPac Basic) (PC–818)</td>
<td>Bio–Rad Laboratories (MA, USA)</td>
</tr>
<tr>
<td>Program Temp Control system</td>
<td>Astec, Inc. (Japan)</td>
</tr>
<tr>
<td>Refractometer</td>
<td>Nippon Optical Works (Japan)</td>
</tr>
<tr>
<td>Refrigerated Microcentrifuge</td>
<td>Hettich (Germany)</td>
</tr>
<tr>
<td>Shaking incubator</td>
<td>Labline Instrument Co. (IL, USA)</td>
</tr>
<tr>
<td>Spectrophotometer (Lambda 25 UV/VIS)</td>
<td>Perkin Elmer (UK)</td>
</tr>
<tr>
<td>Thermo Cycler (PTC–200)</td>
<td>MJ Research (USA)</td>
</tr>
<tr>
<td>Tuberculin disposable syringe</td>
<td>NIPRO Corp., Ltd. (Thailand)</td>
</tr>
<tr>
<td>Ultrasonic cleaner (3200)</td>
<td>Branson (Germany)</td>
</tr>
<tr>
<td>Vortex–Genie 2</td>
<td>Scientific Industries, Inc. (NY, USA)</td>
</tr>
<tr>
<td>Waterbath (1235)</td>
<td>Sheldon Manufacturing, Inc. (OR, USA)</td>
</tr>
<tr>
<td>0.45–µm Millipore filter</td>
<td>Millipore Filter Corp. (MA, USA)</td>
</tr>
<tr>
<td>27 G × 1” hypodermic needle</td>
<td>NIPRO Corp., Ltd. (Thailand)</td>
</tr>
<tr>
<td>96–well deep well plates</td>
<td>VWR International (PA, USA)</td>
</tr>
<tr>
<td>96–well microtiter plates (Nunclon)</td>
<td>Sigma–Aldrich, Inc. (MO, USA)</td>
</tr>
</tbody>
</table>
METHODS

This work was divided into three parts. Part I, characterization of *V. harveyi* isolated from marine samples. Part II, investigation of factor involved in virulence mechanism of *V. harveyi*. Part III, isolation of marine bacteria that possess inhibitory activity against *V. harveyi*.

**Part I. Characterization of *V. harveyi* isolated from marine samples**

In order to characterize *V. harveyi* isolated from marine samples, investigation of phenotypic and genotypic of *V. harveyi* isolates, determination virulent strains of *V. harveyi* in shrimp model and evaluation virulent and non-virulent strains of *V. harveyi* by molecular typing were performed (Figure 24).

**Isolation of *Vibrio* spp. from marine samples**

**Identification of *V. harveyi***

- Biochemical tests
- PCR targeted to *gyrB*

**Virulence investigation**

<table>
<thead>
<tr>
<th>Shrimp model</th>
<th>Production of ECPs</th>
<th>Detection of virulence genes by PCR and Southern blot hybridization</th>
</tr>
</thead>
</table>
| Injection to *P. monodon* | - Phospholipase  
- Lipase  
- Chitinase  
- Hemolysin | - *vhh*  
- *vcrD*  
- *hhl* |

**RAPD fingerprinting**

**Figure 24** Diagram represents the methods for characterization of *V. harveyi* isolated from marine samples in part I.
1. *V. harveyi* isolation and identification

One hundred and twenty samples of seafood including shrimp, fish, mollusks, mantis shrimp and crab were investigated. *V. harveyi* was isolated from shrimp. Briefly, small shrimp were crushed in a sterile mortar. *V. harveyi* was isolated from the hemolymph and hepatopancreas of adult shrimp, whereas skin, gills and intestine are the source of this bacterium in fish. In shellfish, it was isolated from the hemolymph. In all cases, sucrose non-fermenting colonies on thiosulfate–citrate–bile salts–sucrose agar (TCBS) were selected after incubation at room temperature for 24 h and identified as *V. harveyi* by biochemical tests following the schemes of Alsina and Blanch (1994) and confirmed by the PCR targeted to *gyrB* gene (see section 3 below).

2. DNA extraction

For any PCR assay, the tested isolates were grown in LB broth (Difco) containing 1% NaCl with shaking (150 rpm) at 30°C overnight. One ml of the broth culture was centrifuged (7,000 × g) and the bacterial cells were washed and re-suspended in sterile saline solution (0.85% NaCl). The cell suspension was boiled for 10 min, and the supernatant was obtained by centrifugation (14,500 × g) and diluted 10-fold in distilled water. The diluted supernatant was used as the template for amplification of *gyrB*, *vcrD*, *vhh* and *hhl* genes. For RAPD and Southern blot hybridization assay, genomic DNA was extracted by phenol–chloroform method explained in Appendix B1 (Sambrook et al. 1989). Briefly, the bacterial suspension was centrifuged and re-suspended in 1 ml of phosphate–buffered saline (PBS) (Appendix A13). After re-centrifugation, cells were treated with PBS–EDTA and 10% sodium dodecyl sulfate (SDS) (Sigma) (Appendix A17) at room temperature for 10 min. Then DNA was extracted by phenol–chloroform solution (1:1) (Appendix A12) and precipitated with 3 M sodium acetate (NaOAc) (Merck) (Appendix A16) and cold absolute ethanol (Merck). After centrifugation, the precipitated DNA was washed twice with 70% cold ethanol and air-dried at room temperature for at least 15 min. DNA pellet was dissolved with sterile water and treated with RNase (Merck) at 37°C for 30 min. DNA extraction by phenol–chloroform was repeated and DNA pellet was finally dissolved in Tris–EDTA (TE) buffer (Appendix A20) and stored at −20°C.
3. Molecular confirmation of *V. harveyi*

*V. harveyi* isolates from marine animals were confirmed by PCR targeted to *gyrB* gene. A pair of primers A2 and B3 was used to detect 393-bp amplicon (Thaithongnum et al. 2006). PCR mixture consisted of 2 µl of DNA template, 1.6 µl of 2.5 mM dNTPs (Promega Corp.), 5 µl of each primers (2 µM) (Table 9), 0.5 U of *Taq* polymerase (Promega Corp.), 2 µl of 10× reaction buffer (Promega Corp.), 2 µl of 25 mM MgCl$_2$ (Promega Corp.), and 2.3 µl of distilled water. The amplification conditions were 30 cycles of denaturation at 94°C for 1 min, annealing at 63°C for 1 min, and extension at 72°C for 2 min, followed by 1 cycle of 72°C for 7 min. Amplification was performed in a Perkin–Elmer Thermal Cycler (Gene Amp PCR System 2400). Ten µl of PCR product was resolved by electrophoresis on a 1.5% agarose gel. After gel was stained with ethidium bromide (Appendix A8), the amplicons were detected by a UV transluminator.

4. Virulence investigation in shrimp model

The median lethal dose (LD$_{50}$) of *V. harveyi* HY01 pathogenic strain and an ocean isolate of *V. harveyi* BAA–1116 was evaluated on the black tiger shrimp *P. monodon*. The test strains were grown overnight in tryptic soy broth (TSB) containing 1% NaCl at 30°C with shaking at 150 rpm. Cultured cells were harvested by centrifugation at 7,000 × g for 10 min, and washed twice with sterile artificial seawater (ASW) (Marinum). Bacterial cell suspensions in ASW were adjusted to 2.5 × 10$^8$ CFU/ml with a densitometer (Densimat, bioMerièux) and 2-fold dilutions were performed to obtain concentrations of bacteria between 4.0 × 10$^6$ and 6.4 × 10$^7$ CFU/ml.

The *P. monodon* juvenile shrimps (Figure 25) were 10 to 13 g in weight and 4 to 5 inches (10.2 to 12.7 cm) in length (base of rostrum to base of telson) (Figure 26A). Each shrimp received an intramuscular injection of 0.1 ml diluted *V. harveyi* (with batches of 7 shrimps/dose) at the sixth abdominal segments (Figure 26). Control shrimp were injected with ASW. The experiments were performed in duplicate. Shrimps were maintained in a 70 l ASW glass tank at a temperature of 29 ± 1°C and salinity of 17 ppt. Shrimps mortalities were observed within 48 h of injection and were confirmed by detecting luminescence in the organs of the dead shrimp. The LD$_{50}$ of *V. harveyi* was calculated using the method of Reed and Muench (Reed and Muench 1938).

For evaluation of virulence of all *V. harveyi* isolates obtained from fish and shellfish, each isolate was injected into shrimp at a concentration of 4× LD$_{50}$ (Kashef et al.
using the same procedure as described above. Mortality rates were measured after 48 h injection.

5. Investigation of extracellular products (ECPs)

In order to determine pathogenic strains of *V. harveyi*, ECPs from *V. harveyi* isolates were investigated. Media used in each test were explained in Appendix A. Phospholipase and lipase were examined as described previously (Liu et al. 1996a). Briefly, overnight culture of bacteria were stabbed into tryptic soy agar (TSA) with 1% NaCl supplemented with either 1% (v/v) egg yolk emulsion (Appendix A7) or 1% (v/v) tween 80 (Gibco) for determination of phospholipase and lipase activity, respectively. Plates were incubated at 30°C for 2 days. The developments of opalescence around the bacterial growth were recorded as positive.

Chitinase activity was investigated by spotting the bacteria on chitin agar plate [modified from (Suginta et al. 2000)]. Sample from overnight bacterial cultures were stabbed into agar plates prepared from TSA with 1% NaCl and 1% (w/v) swollen chitin (Sigma Practical Grade from crab shells). The clear zone around the stab site was observed after 24 h incubation.

Hemolytic activity was detected using prawn blood agar (Chang et al. 2000). Briefly, 1 ml of citrate-EDTA prawn hemolymph was mixed with Rose Bengal (at a final concentration of 0.3% w/v) and was added to 15 ml basal medium (consisting of 10 g Bacto peptone, 10 g NaCl, and 15 g Bacto agar in 1 l). Hemolysis was evaluated by detection of a clear zone around *V. harveyi* colonies on prawn blood agar within 7 d of incubation at 30°C.

6. Statistical analysis

Pearson’s correlation coefficient was used to investigate correlations between hemolytic activity and shrimp mortality (Neter et al. 1996).
Figure 25 Juvenile *P. monodon* used for investigation virulence of *V. harveyi* isolates.

Figure 26 Anatomical diagram of *P. monodon*, the arrow indicated site of injection (A). Intramuscular injection of *V. harveyi* into shrimp (B).
7. Testing for hemolysin and TTSS genes

In this study, vhh–F and vhh–R primers specific to the vhh hemolysin gene of V. harveyi, were designed using vhh sequences of V. harveyi VIB 645 (accession nos. AF 293430 and AF 293431) and V. harveyi BAA–1116 (accession no. NC_009784) reported in GenBank. vcrD1 and vcrD2 primers targeted to the vcrD gene, a gene of TTSS of V. harveyi, were designed based on the vcrD nucleotide sequences of V. parahaemolyticus (accession no. NP_798041), V. alginolyticus (accession no. ZP_01259742) and V. campbellii (accession no. ZP_02195895) deposited in GenBank. All primers were designed using MacVector 9.5.2 and BLAST software (www.ncbi.nlm.nih.gov/BLAST/), and are shown in Table 9.

To evaluated the specificity of these primers, V. harveyi NICA, V. harveyi HY01, V. carchariae, V. cholerae O1, V. cholerae non–O1, V. parahaemolyticus, V. vulnificus, V. alginolyticus, V. campbellii, V. furnissii, V. fluvialis, G. hollisae, and E. coli were grown overnight in LB broth containing 1% NaCl, and DNA templates were extracted by boiling (Thaithongnum et al. 2006). PCR analysis was performed in 20 µl of reaction mixture containing 2 µl of 10× PCR buffer (Promega Corp.), 1.5 µl of template DNA, 1.6 µl of 25 mM MgCl₂, 5 µl of vhh–F and vhh–R or the vcrD1 and vcrD2 primers (2 µM), 0.1 µl of Tag polymerase (Promega Corp.), and 1.6 µl of 2.5 mM dNTPs. PCR analysis was performed using a Gene Amp PCR thermocycler, and the reaction involved 96°C for 5 min, 35 cycles of 94°C for 1 min, 56°C for 1 min and 72°C for 1 min, followed by 72°C for 7 min. The amplification products were subjected to electrophoresis in 1% agarose gel. A total of 38 isolates of V. harveyi were examined for the presence of vhh and vcrD. Southern–blot hybridization assays were used to confirm isolates that were PCR–negative for vhh.

8. hlyA–like hemolysin gene

Using BLAST software, a sequence alignment of the hemolysin gene from V. harveyi strain HY01 (GenBank accession no. NZ_AAWP01000001) showed 86% homology to the hlyA hemolysin gene of V. cholerae N16961 (GeneBank accession no. AE003853). Therefore, specific primers for this gene, designated as hhl, were designed (Table 9). Amplification conditions for this gene were similar to those used for vcrD, except that 1 µl of each primer (2 µM concentration) was used and the PCR reaction comprised 94°C for 5 min, 30 cycles of 94°C for 45 s, 50°C for 1 min, and 72°C for 1 min. The presence of this hhl gene was examined in V. harveyi HY01 and V. harveyi BAA–1116, and
36 isolates of *V. harveyi* from fish and shellfish. Some *hhl*-negative isolates were confirmed by Southern-blot hybridization using the *hhl* probe.

9. **Southern blot hybridization**

Genomic DNA from *V. harveyi* was digested with *EcoRI* restriction enzyme and was subjected to electrophoresis in 1% agarose gel. The digested genomic DNA was transferred to a nylon membrane (Boreheinger Manheim) and was hybridized with *vhh* or *hhl* probes. The probes were prepared by PCR using the *vhh* primers and *hhl* primers designed as previously described and was labeled with digoxigenin (Roche Diagnostics) according to the manufacturer’s specifications as described in Materials and equipments. Hybridization was performed under high-stringency conditions at 42°C. The hybridized probes were detected using a DNA detection kit (Roche Diagnostics) according to the manufacturer’s instructions (explained in Appendix B2).

10. **DNA fingerprints investigation**

10.1 **Random Amplified Polymorphic DNA (RAPD) fingerprinting**

To characterize DNA profiles of virulent and non-virulent strains of *V. harveyi*, genomic DNA of *V. harveyi* was extracted by a phenol–chloroform method and RAPD was performed using the RAPD universal primer 2 (5’-GTTTCGCTCC-3’) (Matsumoto et al. 2000). Amplification was performed in a 30 µl mixture containing 0.33 mM dNTPs (TaKaRa Biochemicals), 25 ng of template DNA, 2.5 U *Ex Taq* (TaKaRa) 0.83 pmol of primer and 1× *Ex Taq* buffer. The PCR analysis was performed in an Astec PC-818A thermal cycler and the reaction comprised 95°C for 4 min, 45 cycles of denaturation at 95°C for 1 min, annealing at 36°C for 1 min, and extension at 72°C for 2 min, followed by 72°C for 7 min. The amplification products were analyzed by electrophoresis using a 1.5% agarose gel at 100V for 5 min and continued running at 15 mA for 12 h.

10.2 **Analysis of RAPD fingerprint patterns**

Using a Bioprofile image analysis system (Viber Lourmat), a dendrogram was constructed using the data matrix generated by DNA profiles of all 38 tested strains of *V. harveyi*.
Part II. Investigation of factor involved in virulence mechanism of *V. harveyi*

In order to investigate factor involved in virulence mechanism of *V. harveyi*, transposon mutagenesis, homologous recombination–based gene disruption technique and proteomics analysis were performed (Figure 27).

**Figure 27** Diagram represents the methods for investigation of factor involved in virulence mechanism of *V. harveyi* in part II.
1. Transposon mutagenesis

All bacterial strains and plasmids used in this study are listed in Table 12.

1.1 Competent cell preparation

*E. coli* DH5α/λpir were used as competent cells. They were grown overnight at 37°C in 5 ml LB (Luria Bertani) medium. Cells were diluted (1:100) in 300 ml LB medium and allowed to grow up to an OD$_{650}$ of 0.2–0.4. The cultures were kept on ice for 10 min, and then they were centrifuged at 3,600 × g at 4°C for 10 min. The supernatant was discarded and the bacterial pellet was re-suspended in a 75 ml of chilled 100 mM MgCl$_2$. The cells were kept on ice for 5 min and centrifuged at 2,300 × g at 4°C for 10 min. The supernatant was discarded and the pellet was re-suspended in 25 ml of chilled 100 mM CaCl$_2$. Cells were kept on ice for 20 min and centrifuged at 2,300 × g at 4°C for 10 min. The supernatant was discarded and the pellet was re-suspended in 10 ml of solution. These cells were aliquot (100 µl) and stored immediately at −80°C for further use.

1.2 Transformation

Plasmids pJT064 containing transposon (Figure 23) were transformed into *E. coli* DH5α/λpir competent cells (Cohen et al. 1972). Briefly, 100 µl competent cells were thawed on ice. 1–5 µl (10–100 ng) pJT064 plasmids was added to the cells, these cells were allowed to stand on ice for 30 min and they were heated shock at 42°C for 1 min. The cells were immediately kept on ice for 2 min and were cultured in LB broth at 37°C for 1 h. Finally they were plated on LB agar containing chloramphenicol (20 µg/ml) and incubated at 37°C overnight. The transformants (*E. coli* DH5α/λpir harboring pJT064) were selected and were cultured in LB broth at 37°C for 16–18h to obtain high copy number of the pJT064 plasmids. Then the pJT064 plasmids were extracted using QIAprep Spin Miniprep Kit (QIAGEN) and were cloned into *E. coli* BW20767/λpir. After growing at 37°C in LB agar supplemented with chloramphenicol (20 µg/ml), the bacteria (*E. coli* BW20767/λpir harboring pJT064) were used for conjugation with *V. harveyi* PSU3316.
1.3 Conjugation

*V. harveyi* PSU3316 was isolated from a diseased shrimp (*P. monodon*) and was used as a recipient strain for transposon mutagenesis using *E. coli* BW20767/λ*pir* harboring pJT064. Conjugation was performed by mixing *V. harveyi* PSU3316 and *E. coli* BW20767/λ*pir* at ratio of 1:1 and they were incubated at 30°C for 6 h. *V. harveyi* mutants (transposants) were selected on TCBS agar containing chloramphenicol (2 µg/ml) to create a transposon library.

2. Screening transposon library for hemolytic activity

*V. harveyi* mutants were screened for hemolytic activity by spotting the test strains on sheep blood agar (Appendix A15) and incubation at 30°C for 48 h. Any *V. harveyi* transposant strains that caused incomplete hemolytic activity (α-hemolytic) compared to wild type (β-hemolytic) were further screened for virulence in shrimp.

3. Virulence investigation in shrimp

To prepare inocula, *V. harveyi* mutants were grown overnight in TSB containing chloramphenicol (2 µg/ml) at 30°C. The cells were washed and resuspended in a sterile saline solution. *L. vannamei* shrimp (Figure 28) (n=3 per treatment) were challenged with 100 µl of saline solution by intramuscular injection. Challenge doses contained $2.4 \times 10^6$ CFU/shrimp for each transposon mutant and the wild-type strain (corresponding to four times the wild-type LD$_{50}$), and sterile saline as a control for viability. Mortality was observed after 18 h where mortality was 100% for the wild type and attenuated virulence of mutants was indicated in the case of partial mortality.

![Image](image-url)

**Figure 28** Juvenile *L. vannamei* used for virulence investigation of *V. harveyi* mutants.
Table 12 Bacterial strains and plasmids used in this study.

<table>
<thead>
<tr>
<th>Strains or plasmids</th>
<th>Description</th>
<th>Reference(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Strains</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><em>E. coli</em></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DH5α/λpir</td>
<td>φ80dlacZAΔM15 Δ(lacZYAargF) U169 recA1 hsdR17 deoR thi−1 supE44 gyrA96 relA1/λpir</td>
<td>(Miller and Mekalanos 1988)</td>
</tr>
<tr>
<td>RP4−2−Tc::Mu−1 kan::Tn7 integrant leu−</td>
<td></td>
<td></td>
</tr>
<tr>
<td>BW20767/λpir</td>
<td>63:IS10 recA1 zbi−5 creB510 hsdR17 endA1 thi uidA (ΔMluI)::pir+</td>
<td>(Metcalf et al. 1996)</td>
</tr>
<tr>
<td><strong>V. harveyi</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PSU3316</td>
<td>Wild type; <em>rpoE</em>, <em>rseA</em>, <em>rseB</em></td>
<td>This study</td>
</tr>
<tr>
<td>PSU4512</td>
<td>PSU3316 derivative <em>rseB</em>::TnJT064</td>
<td>This study</td>
</tr>
<tr>
<td>PSU3545</td>
<td>PSU3316 Sm−; spontaneous mutant</td>
<td>This study</td>
</tr>
<tr>
<td>PSU4029</td>
<td>PSU3545 derivative <em>rpoE</em>::pJT084</td>
<td>This study</td>
</tr>
<tr>
<td>PSU4030</td>
<td>PSU3545 derivative <em>rseA</em>::pJT084</td>
<td>This study</td>
</tr>
<tr>
<td>PSU4031</td>
<td>PSU3545 derivative <em>rseB</em>::pJT084</td>
<td>This study</td>
</tr>
<tr>
<td>PSU4559</td>
<td>PSU4512 derivative <em>rpoE</em>::pJT084</td>
<td>This study</td>
</tr>
<tr>
<td><strong>Plasmids</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>pSC189</td>
<td>Transposon delivery plasmid; NCBI accession no. AY115560</td>
<td>(Chiang and Rubin 2002)</td>
</tr>
<tr>
<td>pDTR801</td>
<td>pCVD422 derivative; Sm−; Ap−</td>
<td>This study</td>
</tr>
<tr>
<td>pJT064</td>
<td>pSC189 derivative; ApR; KmR; CmR</td>
<td>This study</td>
</tr>
<tr>
<td>pJT084</td>
<td>pDTR801 derivative; CmR</td>
<td>This study</td>
</tr>
<tr>
<td>pPR141</td>
<td>pJT084 with 697 bp fragment harbouring <em>rpoE</em> from PSU3545 cloned into the XbaI site</td>
<td>This study</td>
</tr>
<tr>
<td>pPR142</td>
<td>pJT084 with 1228 bp fragment harbouring <em>rseA</em> from PSU3545 cloned into the XbaI site</td>
<td>This study</td>
</tr>
<tr>
<td>pPR143</td>
<td>pJT084 with 516 bp fragment harbouring <em>rseB</em> from PSU3545 cloned into the XbaI site</td>
<td>This study</td>
</tr>
</tbody>
</table>
4. Characterization of genes involved in hemolytic activity and virulence in shrimp

To identify genes disrupted in hemolysis--and virulence--attenuated mutants, the transposon insertion junctions were sequenced using an outward facing primer targeting a priming site in the transposon (Mar2018 and MarEC6) and arbitrary primers targeted to *V. harveyi* genome ARB6/7 and ARB2 (Cameron et al. 2008).

Briefly, chromosomal DNA of *V. harveyi* mutants was purified by PUREGENE Core Kit A (QIAGEN, USA). The primers sequences for PCR amplification are listed in Table 9. First-round PCR analysis was performed in 15 µl reactions containing 1.5 µl of template DNA, 0.12 µl of 25 mM dNTP, 0.3 µl of Mar2018 and ARB6/7 primers (20 µM), 1.5 µl 10× ThermoPol buffer, 0.75 µl 100× BSA, 4.69 µl 4M Bataine and 0.2 µl of Vent DNA Polymerase. The thermal conditions involved 94°C for 3 min; 6 cycles at 94°C for 30 s, 30°C for 30 s, 72°C for 1.30 min; 30 cycles at 94°C for 30 s 45°C for 30 s, 72°C for 1.30 min; followed by 72°C for 5 min.

The components of reaction mix in the second-round PCR was the same, except the 1.5 µl products from first-round PCR is used as a template, and using TnJT064 specific primer (MarEC6) closer to the flanking region (Figure 29) and ARB2 as the primers. The thermal conditions involved 94°C for 3 min; 35 cycles at 94°C for 30 s, 45°C for 30 s, 72°C for 1.30 min; followed by 72°C for 5 min. All reaction procedures were performed in a Peltier thermal cycler model PTC–200 (MJ Research). The second-round PCR products were electrophoreses in 1% agarose gel and were purified using a QIAquick Gel Extraction kit (QIAGEN). Purified products were sequenced and were analyzed by BLAST using the National Center for Biotechnology Information database (http://www.ncbi.nlm.nih.gov/blast).

![Figure 29 Specific primers, MarEC6 and Mar2018, binding site of TnJT064. IR, inverted repeats.](http://www.ncbi.nlm.nih.gov/blast)
5. Homologous recombination-based gene disruption

5.1 Cloning of rpoE, rseA and rseB fragments into pJT084 plasmid

A spontaneous streptomycin resistant *V. harveyi* PSU3316 (designated as PSU3545) was constructed for developing rpoE, rseA and rseB mutants by homologous gene disruption technique (Miller and Mekalanos 1988). PCR amplification of inserts for gene disruption (rpoE, rseA and rseB) was performed using specific primers (5’ XbaI restriction sites) designed in this study (Table 11). The 50 µl PCR reaction contained 5 µl of template DNA, 0.67 µl of 25 mM dNTP, 1.25 µl of each gene specific primer (20 µM), 5 µl 10× ThermoPol buffer and 0.5 µl of Vent DNA Polymerase (NEB). The thermal conditions involved 94°C for 5 min; 30 cycles at 94°C for 45 s, 55°C for 30 s, 72°C for 1.30 min; followed by 72°C for 5 min. The PCR product of each gene was purified and was cloned into pJT084 plasmid. Briefly, both PCR product and pJT084 vector were subjected to XbaI restriction enzyme. In 40 µl of each digestion reaction contained 20 U of XbaI (NEB), bovine serum albumin (BSA), and 10× enzyme buffers. The restriction enzyme digestion was carried out at 37°C for 45 min followed by inactivated at 65°C for 20 min. After digestion, pJT084 was treated with 10 U of Alkaline Phosphatase (NEB) at 37°C for 1 h and was electrophoresed in 1% agarose gel. Then the plasmid was purified using QIAquick Gel Extraction kit (QIAGEN). Ligation of PCR product and pJT084 plasmid was performed in 25 µl of reaction volumes containing PCR product and plasmid at the molar ratio of 6:1, 1.25 µl (6 U/µl) T4 DNA Ligase (NEB), and 10× buffer. The ligation was carried out at 16°C overnight followed by inactivated at 65°C for 10 min. In this study, plasmids harboring either rpoE, rseA or rseB designated as pPR141 (697 bp), pPR142 (1,228 bp) and pPR143 (516 bp) were constructed respectively.

*E. coli* DH5α/λpir were used as competent cells as described above (section 1.1). Plasmids pJT084 containing rpoE (pPR141), rseA (pPR142) or rseB (pPR143) were transformed into *E. coli* DH5α/λpir competent cells by the method as previously described (section 1.2). The transformants (*E. coli* DH5α/λpir harboring pJT084 which contained a specific gene) were selected and were cultured in LB broth at 37°C for 16–18 h. Then the pJT084 plasmids were extracted using QIAprep Spin Miniprep Kit (QIAGEN) and were cloned into *E. coli* BW20767/λpir. After growing at 37°C in LB agar supplemented with chloramphenicol (20 µg/ml), the bacteria (*E. coli* BW20767/λpir harboring either pPR141, pPR142 or pPR143) were used for conjugation with *V. harveyi* PSU3545.
5.2 *rpoE*, *rseA* and *rseB* disruption

The *E. coli* BW20767/λpir harboring either pPR141, pPR142 or pPR143 were then conjugated with *V. harveyi* PSU3545 as described previously (section 1.3) and *V. harveyi* mutants were selected on TCBS containing chloramphenicol (2 µg/ml) and streptomycin (200 µg/ml). *V. harveyi rpoE* (PSU4029), *rseA* (PSU4030) and *rseB* (PSU4031) mutant strains were generated (Table 12). In addition, *E. coli* BW20767/λpir harboring pPR141 was used to construct *V. harveyi rseB rpoE* (PSU4559) mutant. Each specific gene disruption in *V. harveyi* was confirmed by PCR and gene sequencing analysis. Phenotype and growth characteristics of these mutant strains were evaluated compare to *V. harveyi* PSU3545.

6. Characteristics of *rpoE*, *rseA* and *rseB* mutants

6.1 Hemolytic activity

To assay for hemolytic activity, *V. harveyi rpoE*, *rseA* and *rseB* mutants were inoculated on defibrinated sheep blood agar (PML Microbiologicals, OR, USA). Hemolytic activity was determined by the appearance of lytic zone after incubation at 30°C for 48 h.

6.2 Growth and competition assays

To compare growth of mutants and wild-type strains, the strains were grown in LB broth containing 1.5% NaCl for 16 h at 30°C. Growth was determined by optical density (OD$_{600}$) every 60 min.

The competitive index (CI) of mutant strains was determined *in vivo* using juvenile penaeid shrimp (*L. vannamei*). Briefly, cell suspensions of wild-type PSU3545 (Cm$^S$ Sm$^R$) and a mutant strain (Cm$^R$ Sm$^R$) were combined at a ratio of 1:1 in sterile saline and were injected intramuscularly into shrimp. After 18 h post injection, the hepatopancreas of the shrimp was removed and the proportion of *V. harveyi* wild type and mutant strains were evaluated on TCBS supplemented with streptomycin (200 µg/ml) and TCBS supplemented with streptomycin (200 µg/ml) and chloramphenicol (2 µg/ml), respectively. The CI was calculated as follow:
CI = \frac{\text{number of mutant/number of wild type isolated from hepatopancrease}}{\text{number of mutant/number of wild type in injected cell suspension}}

A CI of less than 1 indicates the ability of the mutant strain to infect shrimp is lower than wild type.

7. Proteomics

7.1 Preparation of whole-cell protein extract

Protein extracts of mutant and wild-type *V. harveyi* were investigated by 2-D gel electrophoresis (2-DE) to identify differentially expressed proteins that may mediate hemolytic activity. Briefly, *V. harveyi* PSU3545 and its rseA mutant (PSU4030) were grown on sheep blood agar at 30°C for 24 h. *V. harveyi* colonies were scraped from the surface of the agar plates using a sterile micropipette tip and the whole-cell protein extracts were prepared by suspending bacterial cells in 1 ml PBS followed by centrifugation at 6,000 \times g for 5 min at 4°C. Cells were washed three times with PBS and the cell pellets were then resuspended in lysis buffer (7 M Urea, 2 M Thiourea, 4% CHAPS, 2% Pharmalyte 4–7, 40 mM DTT) and incubated at 4°C for 6 h. The remaining bacterial particles and non-lysed cells were removed by centrifugation at 14,000 \times g for 5 min at 4°C. The supernatants were collected by centrifugation and were kept at −70°C until required.

7.2 Two dimensional gel electrophoresis (2-DE)

Tested protein samples were cleaned by 2-D Clean-Up Kits (GE Healthcare) and the concentration of protein was determined using PlusOne 2-D Quant Kit (GE Healthcare). In the first dimension, Immobiline Drystrip gels (IPG gel strips) were used and the 2-DE was performed according to manufactory’s protocol (GE Healthcare). Briefly, IPG gel strips were rehydrated using 125 µl of rehydration buffer (7 M Urea, 2 M Thiourea, 2% CHAPS, 0.5% Pharmalyte, 0.002% bromophenol blue) and covered with Dry Strip Cover Fluid (GE Healthcare). After rehydration, the IPG gel strips were transferred to the Ettan IPGphor III Manifold assembled according to the manufacturer’s instructions. After that 200 µg of the protein samples were loaded to each IPG gel strip. Isoelectric focusing (IEF) was conducted at 300 V for 0.30 h, 1000 V for 0.30 h, 5000 V for 1.20 h, and then 5000 V for 0.25 h. (total 6.5 kVh) at 20°C. After IEF, the strips were equilibrated in SDS
equilibration buffer (6 M Urea, 75 mM Tris–HCl (pH 8.8), 29.3% glycerol, 2% SDS, 0.002% bromophenol blue) containing 1% DTT for 15 min followed by a further 15–min incubation in the same buffer containing 2.5% iodoacetamide.

In the second step, the IPG gel strips were transferred onto 12.5% Tris–glycine SDS polyacrylamide gel. Electrophoresis was performed with miniVE electrophoresis system (GE Healthcare) with an initial constant current of 10 mA/gel for 15 min followed by 20 mA/gel. Proteins were visualized by staining with Coomassie Brilliant Blue R250.

Gels were scanned by ImageScanner (GE Healthcare) and the protein spots were analyzed using an ImageMaster 2–D Platinum (GE Healthcare) (Appendix C). The experiment was performed in duplicate. Protein spots were picked from 2–D gels using a 1 mm diameter micropipette tip and were digested and subjected to mass spectrometry analysis.

### 7.3 Mass spectrometry analysis

Differentially expressed proteins from mutant and wild type were analyzed by nano liquid chromatography–electrospray ionization tandem mass spectrometry (nano LC–ESI–MS/MS). Proteins were identified using MS/MS ion search of the Mascot search engine (Matrix Science, London, UK) and nonredundant protein databases (NCBI nr; National Center for Biotechnology Information, Bethesda, MD, USA) with the following parameters: taxonomy: other proteobacteria; fixed modifications: cysteine carbamidomethylation; variable modifications: methionine oxidation, three missed cleavage allowed, peptide tolerance of 1.2 Da, and MS/MS tolerance of 0.6 Da. The identification of proteins was based on the Probability–Based MOWSE (molecular weight search) scores, whereby individual ions score of greater than 53 indicates significant identities ($p < 0.05$).
Part III. Isolation and characterization of bacteria that possess inhibitory activity against *V. harveyi*

In order to develop the bacteria to control *V. harveyi* infection in shrimp aquaculture, the marine bacteria were isolated from marine sediments and their inhibitory activities against *V. harveyi* was performed (Figure 30).

![Diagram](image)

**Figure 30** Diagram represents the methods for isolation and characterization of bacteria that possess inhibitory activity against *V. harveyi* in part III.
1. Isolation of bacteria from marine sediments

To isolate marine bacteria, sediment samples were collected at Koh Yor, Songkhla, Thailand. The samples were suspended in peptone water containing 2% NaCl, after homogenization, samples were diluted and were spread on TSA containing 2% NaCl. Bacteria were collected kept in 15% glycerol at −70°C until used.

2. Screening of antagonistic activity by cross streak method

All bacterial isolates were investigated for inhibitory activity against *V. harveyi* using cross streak technique (Lemos et al. 1985). Briefly, *V. harveyi* were streaked on tryptic soy agar (TSA) containing 2% NaCl and a single cross streak of the test bacterial isolate was performed. Plates were incubated at 30°C for 24 h. The marine bacteria that inhibited the growth of *V. harveyi* in the confluence area were defined as antagonistic bacteria. The inhibition of *V. harveyi* by antagonistic bacteria was confirmed by co-culture method (Vaseeharan and Ramasamy 2003).

3. Co-culture of antagonistic bacteria with *V. harveyi*

Antagonistic bacteria and *V. harveyi* were cultured separately in TSB containing 2% NaCl at 30°C for 24 h. Then they were mixed at the ratio of 1:1 (10^3 CFU/ml *V. harveyi*: 10^3 CFU/ml of antagonistic bacteria). Monoculture of *V. harveyi* was used as control. The tubes were incubated at 30°C under continuous agitation. Samples were collected after 0, 48 and 72 h for enumeration of the number of bacteria on TSA containing 2% NaCl. The percentage of inhibition in co-culture was calculated compared with control according to the formula given below:

\[
\% \text{ inhibition} = \frac{(\text{CFU/ml of } V. \text{ harveyi in control}) - (\text{CFU/ml of } V. \text{ harveyi in mixed culture})}{(\text{CFU/ml of } V. \text{ harveyi in control})} \times 100
\]

4. Identification of antagonistic bacteria

The antagonistic bacteria against *V. harveyi* were identified by the standard protocols described in Bergey’s Manual of Determinative Bacteriology (Holt et al. 1994) and were confirmed by 16S rRNA gene sequence analysis as described in Appendix D.
CHAPTER 3

RESULTS

Part I. Characterization of *V. harveyi* isolated from marine samples

*V. harveyi* isolation and identification

A total of 120 marine samples was investigated, 81 isolates of bacteria were obtained from TCBS. Forty isolates were suspected to be *V. harveyi* by biochemical tests following the schemes of Alsina and Blanch (1994) but only 36 strains were confirmed to be *V. harveyi* by PCR (Table 13) (5).

Table 13 Identification of *V. harveyi* isolates using PCR targeted to the *gyrB*.

<table>
<thead>
<tr>
<th>Seafood</th>
<th>Total no. of samples</th>
<th>No. of bacteria isolated from TCBS plates</th>
<th><em>V. harveyi</em> (biochemical test)</th>
<th><em>V. harveyi</em> (PCR)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shrimp</td>
<td>74</td>
<td>54</td>
<td>28</td>
<td>27</td>
</tr>
<tr>
<td>Fish</td>
<td>22</td>
<td>17</td>
<td>8</td>
<td>6</td>
</tr>
<tr>
<td>Mollusks</td>
<td>20</td>
<td>9</td>
<td>4</td>
<td>3</td>
</tr>
<tr>
<td>Mantis-shrimp</td>
<td>2</td>
<td>1</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Crab</td>
<td>2</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td><strong>120</strong></td>
<td><strong>81</strong></td>
<td><strong>40</strong></td>
<td><strong>36</strong></td>
</tr>
</tbody>
</table>

Virulence investigation in shrimp model

The pathogenicity of 36 *V. harveyi* isolates was investigated in shrimp model. In this study, the LD$_{50}$ of virulent strain of *V. harveyi* was evaluated using *V. harveyi* HY01 and *V. harveyi* BAA–1116 standard strains. Mortalities rates of 85.7 and 58.3% were observed in shrimp after injection of *V. harveyi* HY01 at concentrations of $6.4 \times 10^6$ and $3.2 \times 10^6$ CFU/shrimp, respectively (Table 14). No shrimp deaths were detected after injection with *V. harveyi* BAA–1116. Therefore, the LD$_{50}$ dose for *V. harveyi* HY01 was calculated to be $1.9 \times 10^6$ CFU/shrimp using the method of Reed and Muench (1938). Thus, inoculum concentrations equivalent to $4 \times$ LD$_{50}$ of *V. harveyi* HY01 were used to
analyze the pathogenicity of 36 *V. harveyi* isolates from marine samples.

All 36 *V. harveyi* isolates, *V. harveyi* HY01 and *V. harveyi* BAA-1116 were classified into 5 groups (A to E) according to their abilities to cause shrimp death within a certain time period post-injection, with Group A being the most pathogenic and Group E the least. Thirteen isolates of *V. harveyi* were classified in group A, including *V. harveyi* HY01 (Figure 31 and Table 16) because they were the most pathogenic strains, inducing 100% mortality within 12 h of injection. No live shrimp were detected at 24 h after injection with isolates of Group B (11 isolates). *V. harveyi* isolates of Group C (9 isolates) induced 58% mortality among test shrimp by 24 h after injection, with no subsequent deaths. The isolates designated as belonging to Group D (4 isolates) caused 29% mortality within 24 h of injection with no subsequent mortality thereafter. None of the shrimp died after injection with *V. harveyi* BAA-1116, which was designated as Group E. All dead shrimp exhibited luminescence, which confirmed that their deaths caused by luminescent bacteria, *V. harveyi* (Figure 32).

**Determination of extracellular products (ECPs)**

The ability to produce extracellular products (ECPs) of 36 *V. harveyi* isolates was evaluated. All *V. harveyi* isolates produced phospholipase and chitinase. Lipase activity was detected in 35 isolates of *V. harveyi* (Table 15). However, only 28 isolates exhibited hemolysis on prawn blood agar (Table 16).

**Correlations between hemolytic activity and shrimp mortality**

It is of interest that 12 out of 13 *V. harveyi* isolates (92.3%) in Group A, including *V. harveyi* HY01, caused hemolysis, whereas the hemolytic activity of isolates of Group B, C, and D was 81.8%, 66.7% and 50.0%, respectively (Figure 31 and Table 16). No hemolysis was observed on prawn blood agar inoculated with *V. harveyi* BAA-1116.

Evaluation of the correlation between the hemolytic activity of *V. harveyi* and the deaths of infected shrimps by Pearson’s correlation coefficient analysis (*r*) demonstrated a significant correlation at 24 h after injection (*r* = 0.972, *p* < 0.05). Therefore, the presence of *V. harveyi* hemolysin genes was evaluated.
**Table 14** Investigation of the median lethal dose (LD$_{50}$) of *V. harveyi* strains HY01 and BAA–1116 in *P. monodon*. Experiments were performed in duplicate and % mortality of shrimps in both experiments was not different. Therefore, the results of one experiment are shown here.

<table>
<thead>
<tr>
<th>V. harveyi strains Dose (CFU/shrimp)</th>
<th>No. of shrimp dead/total</th>
<th>Cumulative no. of shrimp Dead</th>
<th>Cumulative no. of shrimp Alive</th>
<th>Mortality (%)</th>
</tr>
</thead>
<tbody>
<tr>
<td>HY01</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$6.4 \times 10^6$</td>
<td>5/7</td>
<td>12</td>
<td>2</td>
<td>85.7</td>
</tr>
<tr>
<td>$3.2 \times 10^6$</td>
<td>4/7</td>
<td>7</td>
<td>5</td>
<td>58.3</td>
</tr>
<tr>
<td>$1.6 \times 10^6$</td>
<td>3/7</td>
<td>3</td>
<td>9</td>
<td>25.0</td>
</tr>
<tr>
<td>$8.0 \times 10^5$</td>
<td>0/7</td>
<td>0</td>
<td>16</td>
<td>0</td>
</tr>
<tr>
<td>$4.0 \times 10^5$</td>
<td>0/7</td>
<td>0</td>
<td>23</td>
<td>0</td>
</tr>
<tr>
<td>BAA–1116</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$6.4 \times 10^6$</td>
<td>0/7</td>
<td>0</td>
<td>7</td>
<td>0</td>
</tr>
<tr>
<td>$3.2 \times 10^6$</td>
<td>0/7</td>
<td>0</td>
<td>7</td>
<td>0</td>
</tr>
<tr>
<td>$1.6 \times 10^6$</td>
<td>0/7</td>
<td>0</td>
<td>7</td>
<td>0</td>
</tr>
<tr>
<td>$8.0 \times 10^5$</td>
<td>0/7</td>
<td>0</td>
<td>7</td>
<td>0</td>
</tr>
<tr>
<td>$4.0 \times 10^5$</td>
<td>0/7</td>
<td>0</td>
<td>7</td>
<td>0</td>
</tr>
</tbody>
</table>

**Table 15** Detection of extracellular products in *V. harveyi* isolates.

<table>
<thead>
<tr>
<th>Total no. of isolates</th>
<th>No. of <em>V. harveyi</em> isolates positive for extracellular products</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Phospholipase</td>
</tr>
<tr>
<td>36</td>
<td>36</td>
</tr>
</tbody>
</table>
Figure 31 Survival of *P. monodon* after injection with *V. harveyi* isolates. See Table 16 for Groups A to E. In the control group, none of the shrimp died after injection with artificial seawater (ASW) (data not shown).

Figure 32 Luminescence of dead shrimp injected with *V. harveyi*. 
Hemolysin and TTSS genes investigation

To determine genes encoding hemolysin (vhh) and TTSS (vcrD), the specificities of vhh and vcrD primers (Table 9) were evaluated using 2 strains of V. harveyi, 9 species of Vibrio, and E. coli. Only V. harveyi produced an amplicon with the vhh primers (Figure 33). For the vcrD primers, only V. harveyi, V. carchariae and V. parahaemolyticus gave a positive result with a single 332 bp DNA product. This result was not surprising because previous analysis of 16S ribosomal DNA sequences has indicated that V. carchariae is the junior synonym of V. harveyi (2), and the sequence, organization, and regulation of the TTSS gene clusters in V. harveyi and V. parahaemolyticus have been reported to be similar (3). An alignment between partial vcrD gene sequences of V. parahaemolyticus RIMD 2210633 (GeneBank accession no. BA000031) and that of V. harveyi BAA-1116 (GeneBank accession no. AY524044) was demonstrated in Figure 34.

Figure 33 Specificity of vcrD, vhh and hlyA primers. Lane M, 100 bp molecular weight marker (NEB); Lane 1 to 13, in order V. harveyi NICA, V. harveyi HY01, V. carchariae, V. cholerae O1, V. cholerae non–O1, V. parahaemolyticus, V. vulnificus, V. alginolyticus, V. campbellii, V. furnissii, V. fluvialis, G. hollisae, and E. coli.
Figure 34 Alignment between partial vcrD gene sequences of *V. parahaemolyticus* RIMD 2210633 (GeneBank accession no. BA000031) and *V. harveyi* BAA−1116 (GeneBank accession no. AY524044).
All 38 isolates of *V. harveyi*, including *V. harveyi* HY01 and *V. harveyi* BAA-1116 were analyzed for the presence of the *vhh* and *vcrD* genes using PCR. In this study, *vcrD* was detected in 35 *V. harveyi* isolates (91.7%) but not among isolate numbers 1, 2, and 18 (Table 16). *vhh* was detected in 34 isolates (89.5%) and negative in the remaining 4 isolates (isolates numbers 1, 18, 8 and 24).

**hlyA–like hemolysin gene**

Using BLAST software, alignment of hemolysin gene sequences of *V. harveyi* HY01 and *hlyA* hemolysin gene sequences of *V. cholerae* N16961 indicated that *V. harveyi* HY01 contained *hhl*, which its sequence was similar to the *hlyA* gene of *V. cholerae* (Figure 35). Therefore, specific primers were designed to detect this gene in other *V. harveyi* isolates. The *hhl* gene was detected in 3 isolates of *V. harveyi* (isolates numbers 15, 5, and 11) obtained from fish and shellfish (Table 16). These 3 isolates and *V. harveyi* HY01 contained both *vhh* and *hhl* hemolysin genes. Interestingly, 3 isolates that were negative for both *vhh* and *hhl* (isolates numbers 1, 18, and 8) showed hemolytic activity against prawn erythrocytes (Table 16). Therefore, Southern–blot hybridization was performed using the *vhh* and *hhl* probes (Figure 36). These isolates (plus isolate number 24) were shown to be *vhh*-positive (Figure 36A) but *hhl*-negative (Figure 36B).

**RAPD fingerprinting**

To characterize DNA profiles of virulence and non-virulence strains of *V. harveyi*, DNA fingerprinting of all *V. harveyi* isolates was performed using the RAPD technique. Analysis of DNA profiles revealed one to twenty-seven amplicons ranging from 300 to 12,000 bp. Although all of the isolates shared one 1,600 bp amplicon, 16 distinctive DNA profiles at 70% similarity were observed. *V. harveyi* HY01 and all 3 *V. harveyi* isolates that possessed *hhl* showed different DNA profiles(Figure 37 and Figure 38).
Table 16 Detection of hemolysis and vcrD, vhh and hhl genes in *V. harveyi* isolates.

<table>
<thead>
<tr>
<th>Isolates no.</th>
<th>Hemolysis on prawn blood agar</th>
<th>PCR detection of vcrD</th>
<th>vhh</th>
<th>hhl</th>
<th>Group</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>−</td>
<td>A</td>
</tr>
<tr>
<td>7</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>−</td>
<td>A</td>
</tr>
<tr>
<td>23</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>−</td>
<td>A</td>
</tr>
<tr>
<td>25</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>−</td>
<td>A</td>
</tr>
<tr>
<td>26</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>−</td>
<td>A</td>
</tr>
<tr>
<td>30</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>−</td>
<td>A</td>
</tr>
<tr>
<td>33</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>−</td>
<td>A</td>
</tr>
<tr>
<td>34</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>−</td>
<td>A</td>
</tr>
<tr>
<td>9</td>
<td>−&lt;sup&gt;a&lt;/sup&gt;</td>
<td>+</td>
<td>+</td>
<td>−</td>
<td>A</td>
</tr>
<tr>
<td>1</td>
<td>+</td>
<td>−</td>
<td>−</td>
<td>−</td>
<td>A</td>
</tr>
<tr>
<td>2</td>
<td>+</td>
<td>−</td>
<td>+</td>
<td>−</td>
<td>A</td>
</tr>
<tr>
<td>18</td>
<td>+</td>
<td>−</td>
<td>−</td>
<td>−</td>
<td>A</td>
</tr>
<tr>
<td>8</td>
<td>+</td>
<td>+</td>
<td>−</td>
<td>−</td>
<td>B</td>
</tr>
<tr>
<td>19</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>−</td>
<td>B</td>
</tr>
<tr>
<td>20</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>−</td>
<td>B</td>
</tr>
<tr>
<td>21</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>−</td>
<td>B</td>
</tr>
<tr>
<td>27</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>−</td>
<td>B</td>
</tr>
<tr>
<td>31</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>−</td>
<td>B</td>
</tr>
<tr>
<td>32</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>−</td>
<td>B</td>
</tr>
<tr>
<td>36</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>−</td>
<td>B</td>
</tr>
<tr>
<td>15</td>
<td>−</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>B</td>
</tr>
<tr>
<td>17</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>−</td>
<td>B</td>
</tr>
<tr>
<td>14</td>
<td>−</td>
<td>+</td>
<td>+</td>
<td>−</td>
<td>B</td>
</tr>
<tr>
<td>16</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>−</td>
<td>C</td>
</tr>
<tr>
<td>22</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>−</td>
<td>C</td>
</tr>
<tr>
<td>29</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>−</td>
<td>C</td>
</tr>
<tr>
<td>12</td>
<td>−</td>
<td>+</td>
<td>+</td>
<td>−</td>
<td>C</td>
</tr>
<tr>
<td>13</td>
<td>−</td>
<td>+</td>
<td>+</td>
<td>−</td>
<td>C</td>
</tr>
<tr>
<td>24</td>
<td>−</td>
<td>+</td>
<td>−</td>
<td>−</td>
<td>C</td>
</tr>
<tr>
<td>6</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>−</td>
<td>C</td>
</tr>
<tr>
<td>28</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>−</td>
<td>C</td>
</tr>
<tr>
<td>35</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>−</td>
<td>C</td>
</tr>
<tr>
<td>5</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>D</td>
</tr>
<tr>
<td>3</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>−</td>
<td>D</td>
</tr>
<tr>
<td>10</td>
<td>−</td>
<td>+</td>
<td>+</td>
<td>−</td>
<td>D</td>
</tr>
<tr>
<td>11</td>
<td>−</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>D</td>
</tr>
<tr>
<td>HY01</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>A</td>
</tr>
<tr>
<td>BAA-1116</td>
<td>−&lt;sup&gt;b&lt;/sup&gt;</td>
<td>+</td>
<td>+</td>
<td>−</td>
<td>E</td>
</tr>
</tbody>
</table>

<sup>a</sup>Not detected

<sup>b</sup>Not detected due to poor growth compared with other strains tested on the same prawn blood agar plates after 7 d of incubation.
Figure 35 Alignment of partial hlyA gene sequences of *V. cholerae* N16961 (GeneBank accession no. AE003853) and *hhl* gene sequences of *V. harveyi* HY01 (GenBank accession no. NZ_AAWP01000001).
Figure 36 Southern-blot hybridization analysis to detect vhh (A) and hhl (B) genes in V. harveyi. Genomic DNA was digested with EcoRI and hybridized with (a) a 914 bp vhh-specific probe and (b) a 1019 bp hhl-specific probe under high stringency conditions. Lane 1: V. harveyi HY01; Lanes 2 to 5, in order: V. harveyi isolates 1, 8, 18 and 24 (molecular weight markers: 1 kb DNA ladder, NEB).
Figure 37 Random amplified polymorphic DNA (RAPD) profiles of 38 *V. harveyi* isolates. Lane 1 to 36: each lane number is correlated to the isolate number of *V. harveyi* listed in Table 16; Lane 37 and 38: *V. harveyi* HY01 and *V. harveyi* BAA-1116, respectively. Molecular weight markers: 1 kb DNA ladder, NEB).
Figure 38 A dendrogram constructed from random amplified polymorphic DNA (RAPD) profiles of 38 *V. harveyi* isolates. Number 1 to 36: each number is correlated to the *V. harveyi* isolate number given in Table 16 and Figure 37. Number 37 and 38: *V. harveyi* HY01 and *V. harveyi* BAA–1116, respectively. A, B, C, D, and E indicate the groups of *V. harveyi* listed in Table 16.
Part II. Investigation of factor involved in virulence mechanism of *V. harveyi*

Transposon mutagenesis of *V. harveyi* PSU3316 was performed by conjugation between *E. coli* BW20767/λpir harboring mariner-based transposon-pJT064 and *V. harveyi* PSU3316. A transposon library containing 1,764 mutants (transposants) of *V. harveyi* was obtained.

This transposon library was screened for hemolytic activity, an important virulence factor of *V. harveyi*. Of the 1,764 mutants, 5 of them displayed low hemolytic activity. Within these 5 mutants, 4 isolates caused partial mortality (33%) when injected into shrimp at a dose of 4× LD$_{50}$ of the *V. harveyi* PSU3316 wild type (2.4 × 10$^6$ CFU/shrimp). In contrast, wild-type *V. harveyi* PSU3316 consistently induced 100% shrimp mortality at this concentration (data not shown).

In this study, transposon insertion sites of *V. harveyi* were analyzed by gene sequencing and it was demonstrated that 2 out of 5 mutant strains (both with attenuated virulence – designated as FH3 and GG7) possessed disrupted *rseB* gene encoding for σ$^E$ factor regulatory protein (RseB) (Figure 39 and Table 17). This gene is homologous to VP2576 (GenBank accession no. NC_004603) described in *V. parahaemolyticus* (4). In *E. coli*, four genes (*rpoE–rseA–rseB–rseC*) are clustered in the σ$^E$ operon (Figure 39). *rpoE* encodes for the transcription factor σ$^E$ which is repressed by transmembrane and periplasmic response regulators RseA and RseB encoded by *rseA* and *rseB*, respectively (Figure 47A) (1). However, the role of *rseB* gene has not been reported in any *Vibrio* spp.

**Figure 39** σ$^E$ operon in *E. coli* (A). Insertion site of pJT064 in *V. harveyi* strain FH3 (B) and GG7 (C).
Table 17 Transposon mutants exhibit low hemolytic activity obtained in this study.

<table>
<thead>
<tr>
<th>Mutants</th>
<th>Homologous ORF&lt;sup&gt;a&lt;/sup&gt; (GeneBank accession no.)</th>
<th>Products</th>
<th>$E$ value&lt;sup&gt;a&lt;/sup&gt;</th>
<th>Organisms&lt;sup&gt;b&lt;/sup&gt;</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. EG6</td>
<td>VP0252 (BA000031)</td>
<td>Transcriptional repressor, LacI family</td>
<td>8.0E-85</td>
<td>V. parahaemolyticus</td>
</tr>
<tr>
<td>2. EH12</td>
<td>VP2784 (BA000031)</td>
<td>Hypothetical protein</td>
<td>0.0</td>
<td>V. parahaemolyticus</td>
</tr>
<tr>
<td>3. FH3</td>
<td>VP2576 (BA000031)</td>
<td>$\sigma^E$ factor regulatory protein RseB</td>
<td>7.0E-80</td>
<td>V. parahaemolyticus</td>
</tr>
<tr>
<td>4. GG7</td>
<td>VP2576 (BA000031)</td>
<td>$\sigma^E$ factor regulatory protein RseB</td>
<td>7.0E-113</td>
<td>V. parahaemolyticus</td>
</tr>
<tr>
<td>5. FD6</td>
<td>VP0496 (BA000031)</td>
<td>Threonine synthase</td>
<td>1.0E-119</td>
<td>V. parahaemolyticus</td>
</tr>
</tbody>
</table>

<sup>a</sup> $E$ values and identities were determined using the GenBank database BLAST program.

<sup>b</sup> Organism in which the homologous ORF detected.
To investigate the correlation between hemolytic activity and disruption of genes encoding for $\sigma^E$ factor and its regulatory proteins, mutants in \( rpoE \), \( rseA \) and \( rseB \) were constructed in \( V.\ harveyi \) using a homologous recombination-based gene disruption technique. Both \( rseA \) (PSU4030) and \( rseB \) (PSU4031) mutants showed low hemolytic activity on sheep blood agar (Figure 40).

If \( rpoE \) is negatively regulated by \( rseA \) and \( rseB \) as in \( E.\ coli \) (1), the hemolytic activity of the \( rseB \) mutant should be rescued by knocking out \( rpoE \). To test this, a \( rseB\ rpoE \) double mutant strain (designated PSU4559) was constructed using \( rseB \) transposon mutant strain FH3 (designated as PSU4512). This \( rseB\ rpoE \) double mutant displayed hemolytic activity higher than \( rseB \) transposon mutant strain FH3. The activity \( rseB\ rpoE \) mutant was not restored to the same level of hemolytic activity detected in wild type (PSU3545) because growth of this mutant was slower than that observed in wild type.

\[
\begin{array}{ccc}
\text{Strains (PSU)} & 3545 & 4512 & 4559 \\
\hline
\text{Characteristics} & \text{Wild type} & \text{RseB}^- & \text{RseB}\cdot\text{RpoE}^- \\
\end{array}
\]

\[
\begin{array}{ccc}
\text{Strains (PSU)} & 4029 & 4030 & 4031 \\
\hline
\text{Characteristics} & \text{RpoE}^- & \text{RseA}^- & \text{RseB}^- \\
\end{array}
\]

**Figure 40** Hemolytic activity of wild type and mutants on sheep blood agar.
Growth analysis of rseA and rseB mutant strains on LB broth revealed no significant difference from wild-type strain. However, the rpoE mutant reached stationary phase suggesting mutation in rpoE but not rseA or rseB confers an attenuated growth phenotype (Figure 41). This was also detected in cultivation of rseB rpoE double mutant (data not shown).

Figure 41 Growth curve of V. harveyi in LB broth with 1.5% NaCl, pH7.5 at 30°C. 

Pathogenicity of the mutant strains was determined by quantification of shrimp hepatopancreas colonization by mutant and wild-type V. harveyi 18 h after injection. The competitive indexes of rpoE, rseA and rseB mutants were 2.0, 0.15 and 0.31, respectively (Figure 42). This indicated that virulence of rseA and rseB mutants was three to seven-fold lower than the wild-type strain. In contrast, the rpoE mutant (PSU4029) was able to colonize two-fold higher than the wild-type strain.
Figure 42 In vivo virulence evaluation of *V. harveyi* wild type and mutant strains using competitive index assay. Shrimp was injected with $2.4 \times 10^6$ CFU of wild-type *V. harveyi* PSU3545 (Cm$^+$) and $2.4 \times 10^6$ CFU of mutant strain (either rpoE mutant, PSU4029 or rseA mutant, PSU4030 or rseB mutant, PSU4031). Number of *V. harveyi* in hepatopancreas was evaluated after 18 h injection.

To demonstrate factor involved in hemolytic activity and virulence of *V. harveyi*, proteomic study was performed to compare the cellular proteins of wild type and the mutant. Two-dimensional protein gel electrophoresis revealed 6 proteins that were differentially expressed in wild type and rseA mutant. In the non-hemolytic *V. harveyi rseA* mutant (PSU4030), decrease in protein concentration was detected in 3 different protein spots (spots 1, 2, 3) while three additional proteins were increased (spots 4, 5, 6) when compared to the wild type (Figure 43 and Figure 44). These differentially expressed proteins were analyzed by nano LC–ESI–MS/MS. Five proteins (spots 2, 3, 4, 5, 6) except one (spot 1) were identified with significant ($p < 0.05$) identity to the proteins in NCBInr database. They were conserved hypothetical protein, outer membrane protein (OmpN), phosphomannomutase (PMM), alcohol dehydrogenase (ADH), and protease (DegP) (Table 18).
Figure 4.3 Comparative between 2-D proteomic map of *V. harveyi* wild type (PSU3545) (A) and *rseA* mutant (PSU4030) (B). Circled spots were selected for mass spectrometry analysis.
<table>
<thead>
<tr>
<th>Spot no.</th>
<th>Wild type (PSU 3545)</th>
<th>rseA mutant (PSU 4030)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td><img src="image1.png" alt="Image" /></td>
<td><img src="image2.png" alt="Image" /></td>
</tr>
<tr>
<td>2,3</td>
<td><img src="image3.png" alt="Image" /></td>
<td><img src="image4.png" alt="Image" /></td>
</tr>
<tr>
<td>4</td>
<td><img src="image5.png" alt="Image" /></td>
<td><img src="image6.png" alt="Image" /></td>
</tr>
<tr>
<td>5</td>
<td><img src="image7.png" alt="Image" /></td>
<td><img src="image8.png" alt="Image" /></td>
</tr>
</tbody>
</table>

**Figure 44** 3D-view illustrated protein spots expressed in *V. harveyi* wild type (PSU3545) and *rseA* mutant (PSU4030).
Table 18 Summary of MS/MS data for protein spots showing altered expression levels on 2-D gels for cell extracts of wild type and rseA mutant.

<table>
<thead>
<tr>
<th>Spot no.</th>
<th>Protein</th>
<th>NCBI ID</th>
<th>Identified peptides</th>
<th>Ion score</th>
<th>Theoretical pI/MW (kDa)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Unidentified</td>
<td>NA</td>
<td>NA</td>
<td>NA</td>
<td>NA</td>
</tr>
<tr>
<td>2</td>
<td>Conserved hypothetical protein</td>
<td>gi</td>
<td>269959935</td>
<td>IGYTYNGGDITQQANFVGK</td>
<td>109</td>
</tr>
<tr>
<td>3</td>
<td>Outer membrane protein N (OmpN)</td>
<td>gi</td>
<td>153834896</td>
<td>LGYIGATHDQYGR</td>
<td>83</td>
</tr>
<tr>
<td>4</td>
<td>Phosphomannomutase (PMM)</td>
<td>gi</td>
<td>156977486</td>
<td>GVVIGYDGRPSDK VAATPIVAFGVR</td>
<td>134</td>
</tr>
<tr>
<td>5</td>
<td>Alcohol dehydrogenase (ADH)</td>
<td>gi</td>
<td>28899926</td>
<td>SELPEIVNR</td>
<td>55</td>
</tr>
<tr>
<td>6</td>
<td>Protease (DegP)</td>
<td>gi</td>
<td>156973198</td>
<td>VTPAVVIAVEGK GLGSGVIIDAK GAFVSQVPDSAADK AIDTFSERL ITLGVIR GAELSNTTPSDKIQGVK GVLAINVQR TVYLVIR</td>
<td>538</td>
</tr>
</tbody>
</table>

\(^a\) Ion score greater than 53 is significant in this study (p < 0.05)  
\(^b\) Spot no. corresponds to spot picked from stained gel in Figure 43 and Figure 44.  
\(^c\) NCBI = National Center for Biotechnology Information.  
\(^d\) Not available.
Part III. Isolation of marine bacteria that possess inhibitory activity against *V. harveyi*.

A total of 25 marine sediment samples was investigated, 175 bacterial isolates were obtained and their inhibitory activities against *V. harveyi* PSU3316 were evaluated by cross streak technique. Three isolates (designated as PB15, PB17 and PB42) showed inhibitory activity against *V. harveyi* (Figure 45). Therefore, their inhibitory activities were confirmed by co-culture technique.

![Figure 45](image_url)  
**Figure 45** Inhibition activities of PB15, PB17 and PB42 on *V. harveyi* PSU3316 by cross streak technique.
The co-culture assay indicated a real ability of the test organism against \textit{V. harveyi}. After 72 h incubation, growth inhibition of \textit{V. harveyi} by PB15, PB17 and PB42 bacteria was 100 ± 0, 60.2 ± 2.3 and 100 ± 0, respectively (Table 19).

**Table 19** Inhibitory activity of bacteria on \textit{V. harveyi} using co-culture technique.

<table>
<thead>
<tr>
<th>Strains</th>
<th>% Inhibition against \textit{V. harveyi}(^a)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>48 h</td>
</tr>
<tr>
<td>PB15</td>
<td>74.9 ± 0.1</td>
</tr>
<tr>
<td>PB17</td>
<td>0</td>
</tr>
<tr>
<td>PB42</td>
<td>97.5 ± 0.2</td>
</tr>
</tbody>
</table>

\(^a\) \(10^3\) CFU ml\(^{-1}\) \textit{V. harveyi} were cultured with \(10^3\) CFU ml\(^{-1}\) of the test bacteria for 72 h, and % inhibition was obtained. The values represent mean ± SD of two experiments.

Bacterial isolates PB15 and PB42 could completely inhibit the growth of \textit{V. harveyi} at 72 h, so these isolates were selected for further characterized. They are Gram-positive rods (Figure 46). Identification by biochemical test following the scheme of Bergey’s Manual of Determinative Bacteriology indicates that PB15 and PB42 are \textit{Bacillus} spp. Based on 16S rRNA gene sequence analysis, PB15 and PB42 were identified as \textit{B. subtilis} and \textit{B. amyloliquefaciens}, respectively.

**Figure 46** Gram’s stain of the isolate PB15 (A) and PB42 (B).
CHAPTER 4

DISCUSSIONS

Part I. Characterization of *V. harveyi* isolated from marine samples

*V. harveyi* is the cause of luminous vibriosis which leads to a massive loss in shrimp industry. In this study, technique used for detection this bacterium as well as characterization virulence and non-virulence strains were evaluated.

A2B3 primers targeted to the *gyrB* gene of *V. harveyi* were designed to investigate *V. harveyi* in marine samples by PCR technique. The molecular evolution rate of *gyrB* gene (encodes for the subunit B protein of DNA gyrase) is higher than that of 16S rRNA. This divergence in the *gyrB* gene could provide greater resolution for phylogenetic analysis of luminous bacteria than does the 16S rRNA method (Dunlap and Ast 2005). The A2B3 primers confirmed 36 out of 40 isolates from marine samples that had been presumptively identified *V. harveyi* by biochemical tests (Table 13). The 4 isolates were misidentified. Phenotypic characteristics could not clearly distinguish *V. harveyi* from other *Vibrio* spp. (Gauger and Gómez-Chiarri 2002; Gomez-Gil et al. 2004a; Thompson et al. 2003). Thus, these primers can be used for identification of *V. harveyi* in aquaculture.

The differences in pathogenicity between *V. harveyi* isolates have been reported. In addition, virulence factors of pathogenic *V. harveyi* have not been clearly understood. In the present study, we evaluated the pathogenicity of all 36 *V. harveyi* isolates and 2 standard strains of *V. harveyi* using shrimp model. Moreover, we investigated their ability to produce phospholipase, lipase, chitinase and ability to cause hemolysis on prawn blood agar, including the presence of hemolysin genes and a gene involved in TTSS. All *V. harveyi* isolates produced phospholipase and chitinase but lipase was not detected in one isolate. The ability to cause hemolysis on prawn blood agar was detected in 28 isolates of *V. harveyi*. This result was correlated with the study of *V. harveyi* by Liu et al. 1996 that chitinase activity was detected by all tested isolates but not all isolates exhibited lipase activity. Therefore, hemolytic activity but not phospholipase, lipase and chitinase might involve in the pathogenesis of *V. harveyi*.

The virulence of 38 *V. harveyi* isolates was then investigated in shrimp. We classified the *V. harveyi* isolates into 5 groups (A to E) with Group A (inducing 100% mortality of shrimp within 12 h of injection) being the most pathogenic and Group E (none of
shrimp died after 24 h of injection) the least. The correlations between hemolytic activity and shrimp mortality were evaluated. In the present study, 12 of 13 V. harveyi isolates (92.3%) in Group A (Table 16) produced hemolysis on prawn blood agar. V. harveyi HY01 isolated from a shrimp that had died from luminous vibriosis was also classified in this group. However, 81.8, 66.7, and 50.0% of V. harveyi isolates in Groups B, C, and D, respectively, displayed hemolytic activity on prawn blood agar, and these isolates were less virulent in the shrimp model (Figure 31). No hemolysis was detected in V. harveyi BAA-1116 (Group E) and this strain exhibited poor growth on prawn blood agar after 7 d of incubation. It is possible that this strain was sensitive to the Rose Bengal used in the plate medium. A significant correlation between the hemolytic activity of V. harveyi and the deaths of infected shrimps was demonstrated (r = 0.972, p < 0.05). Therefore, the presence of V. harveyi hemolysin genes was evaluated.

Thirty-four isolates of V. harveyi, including V. harveyi HY01 and BAA-1116, were positive for vhh by PCR, and the remaining 4 isolates (numbers 1, 18, 8, and 24) were vhh-positive by Southern-blot hybridization (Figure 36A). Different nucleotide sequences in this gene that did not correspond to the target sequences of the vhh PCR primers may be the reason why these 4 isolates produced a negative result in the PCR assay. The Southern-blot hybridization results indicated that there were 1 or 2 copies of vhh in these 4 isolates, which correlates with the report of Zhang et al. (2001), who demonstrated duplicate vhh genes, designated as vhhA and vhhB, in V. harveyi isolates. However, most isolates examined contained only a single gene, and vhhA and vhhB were shown to have 98.8% homology (Zhang et al. 2001).

It is of interest that vhh was detected in all V. harveyi isolates but some isolates (isolate numbers 9, 15, 14, 12, 13, 24, 10, and 11) did not show hemolysis on prawn blood agar. These results suggested that some isolates might produce unknown factors that repress gene expression and hemolysin production. Different strains of V. harveyi produce different amounts of hemolysin against erythrocytes of salmon, trout, sheep, rabbit, donkey, and horse (Zhang and Austin 2000). Although hemolysin production against salmon erythrocytes from some isolates had a titer of 1:8 to 1:16 and caused 20 to 40% mortality in rainbow trout, one isolate of V. harveyi with the highest titer (1:256) caused 60% mortality in rainbow trout. Future work should be established to investigate factors that can affect vhh gene expression in order to clarify the correlation between the amount of hemolysin produced and the pathogenicity of V. harveyi.

We also found that V. harveyi HY01 contains hhl, which has a sequence similar to the hlyA gene of V. cholerae. Therefore, specific primers were designed to detect
this gene in other *V. harveyi* isolates. *hhl* was detected in only a few strains of *V. harveyi* and the positive isolates were not classified into Group A, the most pathogenic group (Table 16). Southern–blot hybridization results confirmed that the isolates shown to be *hhl* negative by PCR did not possess this gene (Figure 36B). These results indicate that *hhl* is not conserved in *V. harveyi* and might not be a *V. harveyi* virulent determinant. Several hemolysin genes similar to *hlyA* have been reported in *Vibrio* spp.; for example, most clinical and environmental isolates of *V. mimicus* possess *vmh* (Shinoda et al. 2004), and *vvh* and *vah1* have been detected in most isolates of *V. vulnificus* and *V. anguillarum*, respectively (Aono et al. 1997; Hirono et al. 1996). Nucleotide sequence analysis of HY01 *hhl* and *hlyA* genes of *V. cholerae* N16961 (GenBank accession no. AE003853) and *V. cholerae* N86 (GenBank accession no. X51746), *vmh* genes of *V. mimicus* ATCC33653 (GenBank accession no. U68271), *vah1* genes of *V. anguillarum* PT84057 (GenBank accession no. S83534), and *vvh* genes of *V. vulnificus* EDL174 (GenBank accession no. M34670) revealed 86, 86.8, 73, 68.9, and 41% identity, respectively. Therefore, it is possible that the *hhl* detected in a few isolates of *V. harveyi* in the present study might be derived from *V. cholerae* as a discrete genetic unit by horizontal gene transfer. Further analysis of any mobile genetic elements closely associated with *hhl* may clarify how this gene has appeared in some *V. harveyi* isolates.

Secretion of extracellular products (ECPs) may be controlled through a TTSS that has been detected in many pathogenic bacteria such as *Yersinia* spp., *Shigella* spp., *Salmonella* spp., *Pseudomonas* spp., and some species of *Vibrio* (Dziejman et al. 2005; Galan and Collmer 1999; Makino et al. 2003). The TTSSs detected in *V. parahaemolyticus* are involved in cytotoxicity and enterotoxicity (Park et al. 2004). In the present study, *vcrD*, a gene involved in the TTSS of *V. harveyi*, was examined. As it was detected in all isolates of *V. harveyi* except 3 isolates of Group A (Table 16), we concluded that *vcrD* might not be correlated with the pathogenicity of *V. harveyi* in shrimp. The presence of this gene may relate to its persistence in the environment. By hybridization analysis using probes of the *V. cholerae* secretion genes (*vcsV2*, *vcsN2*, and *vcsC2*) and the *V. cholerae* secreted protein gene (*vspD*), TTSS was not detected in most clinical isolates of *V. cholerae* O1 and O139, but was present in 11.9% of environmental isolates of *V. cholerae* non–O1 and non–O139 (Rahman et al. 2008). This indicates that, in some bacteria, TTSSs might have functions in the environment.

To differentiate the virulence and non–virulence among *V. harveyi* isolates, DNA fingerprint was performed. The RAPD–PCR has been reported to be a useful technique for distinguishing *V. harveyi* isolates (Hernández and Olmos 2004). In the present study,
RAPD analysis of the 38 *V. harveyi* isolates in Groups A to E showed a high degree of genetic diversity and no correlation was detected between DNA profiles of pathogenic and non-pathogenic isolates. This may be because this organism is present in many marine environments and therefore has become associated with a range of animals and environmental factors. As a result, to ensure survival in these diverse habitats, isolates have acquired a range of genes, resulting in the diverse RAPD profiles. Four isolates of *V. harveyi* that possess *hhl* produced different RAPD profiles, which indicates that they are of unrelated origins.

In conclusion, we evaluated the mortality of shrimps infected with *V. harveyi* isolates obtained from fish and shellfish, including one isolate (HY01) obtained from a dead shrimp and another (BAA-1116) obtained from sea water, and demonstrated correlations between the isolates that showed hemolytic activity on prawn blood agar and the ability to cause shrimp death. Although *vhh* was detected in all isolates of *V. harveyi*, some isolates showed no hemolytic activity. It is possible that some as-yet-unknown factors might be involved in regulating gene expression. A *V. cholerae hlyA*-like gene, not previously reported in *V. harveyi*, was detected in 4 *V. harveyi* isolates including *V. harveyi* HY01. However, the presence of this gene, including a TTSS gene, *vcrD*, was not related to the death of infected shrimps.

**Part II. Investigation of factor involved in virulence mechanism of *V. harveyi***

Hemolytic activity of *V. harveyi* seems to be correlated with pathogenesis of this bacterium. In the present study, transposon mutagenesis and homologous recombination gene disruption techniques were used to identify genes involved in hemolytic activity and pathogenicity of *V. harveyi*.

Two strains of *E. coli* (DH5α/λpir and BW20767/λpir) were used in mutagenesis experiments. The *E. coli* DH5α/λpir has *endA* mutation so endonuclease is inactivated and cannot degrade plasmid DNA. Thus, this strain is used as a host to produce high numbers of plasmids (Taylor et al. 1993). *E. coli* BW20767/λpir carries the RP4 transfer origin (*oriT_{RP4})*, so it can be used to transfer plasmids to other bacteria by conjugation (Metcalf et al. 1996). Both *E. coli* strains contain *pir* gene (encodes π protein), which is required for plasmid origin of replication (*oriR_{R6K})* (Kolter et al. 1978). Plasmids containing *oriR_{R6K}* were unable to replicate in *V. harveyi* because *V. harveyi* does not possesses the π protein. After conjugation between *E. coli* BW20767/λpir and *V. harveyi*, the *V. harveyi* mutants harboring plasmid were selected on vibrio-selective medium (TCBS) containing appropriated antibiotic.
Transposon mutagenesis was performed to screen genes involved in hemolytic activity and pathogenicity of *V. harveyi* PSU3316. In this study, decrease in hemolytic activity of *V. harveyi* was detected in *rseB*-disrupted strains. It has been demonstrated that *rseB* in *E. coli* is located in the *rpoE*-rseABC operon (Erickson and Gross 1989). RseA and RseB are negative regulatory proteins of $\sigma^E$ (encoded by *rpoE* gene) whereas RseC is positive regulatory protein (Missiakas and Raina 1997). Therefore, to confirm the role of RseB in *V. harveyi*, *rpoE*, *rseA* and *rseB* mutants were constructed using homologous recombination-based gene disruption. Low hemolytic activity on sheep blood agar was observed in both *rseA* and *rseB* mutants (Figure 40). This indicates that reduction of RseA and RseB might affect hemolytic activity. Previous studies have demonstrated that in the absence of RseA and RseB, the transcription factor encoded by *rpoE* ($\sigma^E$) will be free to activate RNA polymerase resulting in transcription of $\sigma^E$ dependent genes (Figure 47B) (Rouviere et al. 1995).

In *V. harveyi*, these genes may involve in reduction of hemolytic activity. Loss of hemolytic activity in *rseA/B* mutants but not in mutants of *rpoE* suggests that $\sigma^E$ may direct the transcription of genes that repress hemolytic activity in *V. harveyi*. This is the first time that correlation between $\sigma^E$ operon and hemolytic activity is demonstrated. To confirm that the $\sigma^E$ factor involved in hemolytic activity of *V. harveyi*, a *rseB rpoE* double mutant was constructed. This double mutant restored hemolytic activity as would expected if *rpoE* directed the repression of hemolytic activity, however the activity was lower than hemolytic activity detected in the wild type (Figure 40). The reduced hemolytic activity in the double mutant compared to the wild type may be due to the growth impairment conferred by mutation in *rpoE*. It was found that $\sigma^E$ factor was also involved in growth of bacterium. *E. coli* that possessed defect in $\sigma^E$ factor (*rpoE* mutant) showed deleterious effect on growth (Hiratsu 1995). This correlates to our study that *rpoE* mutant exhibited slow growth rate resulting in smaller colony than that of wild–type strain (data not shown).

In this study, the competition assay was used to evaluate the pathogenicity of *V. harveyi* mutant strains compared to the wild type. This technique has been previously used in mice to evaluate the virulence of mutant strains of *V. cholerae* (Freter et al. 1981; Taylor et al. 1987), *S. Typhimurium* (Beuzón et al. 2000; Shea et al. 1999), *Listeria monocytogenes* (Auerbuch et al. 2001) and *P. aeruginosa* (Lau et al. 2004). We are the first to apply this technique to determine virulence attenuation of *V. harveyi* mutants using shrimp model. In this model, shrimp was injected with a mixed culture of *V. harveyi* wild type and mutant strains and the ability of any strain that cause hepatopancrease colonization was evaluated. Reduction in hemolytic activity and virulence attenuation were demonstrated in *rseA* and *rseB* mutants using shrimp model, which indicated that the mutants were less
virulent than the wild type. However, the ability to colonize in shrimp was restored in \textit{rpoE} mutant (Figure 42). Thus, our results suggested that $\sigma^E$ factor is involved in the reduction of hemolytic activity and virulence in \textit{V. harveyi} in the absence of RseA and RseB. However, we could not demonstrate the correlation of virulence and hemolytic activity of \textit{V. harveyi} wild type and \textit{V. harveyi rpoE} mutant because the growth rate of the \textit{rpoE} mutant was slower than that of the wild type (PSU 3545) (Figure 41). This model is supported by recent work in mouse model showing that \textit{rseB} mutants of \textit{V. vulnificus} are attenuated for virulence while \textit{rpoE} mutants are not (Brown and Gulig 2009). The same result was demonstrated in \textit{P. aeruginosa}, which \textit{algU (rpoE)} mutant caused increased systemic virulence in mice challenged with this bacterium (Yu et al. 1996).

This is the first report to demonstrate that regulation of \textit{rpoE} operon may control hemolytic activity of \textit{V. harveyi}. However, the mechanisms by which the $\sigma^E$ factor directs the repression of hemolytic activity in \textit{V. harveyi} remain unclear. To shed light on how the \textit{rpoE} operon controls hemolysis, we used proteome analysis to determine whether any protein level changes could be distinguished between non–hemolytic (\textit{rseA}) and wild– type \textit{V. harveyi} grown on sheep blood agar. In diverse type of bacteria, the $\sigma^E$ factor has been shown to regulate adaptive response necessary for survival in natural habitats (De Las Penas et al. 1997), protection against photolysis (Gorham et al. 1996), resistance to dehydration (Moreno and Landgraf 1998), and for adaptation to cold temperatures and high pressures (Chi and Bartlett 1995). In bacteria, stress condition causes accumulation of unfolded– or misfolded– proteins in the periplasm, this induces $\sigma^E$ factor to activate transcription of genes involved in stress reduction (Figure 47B) (Mecsas et al. 1993).

Microarray studies have demonstrated that expression of \textit{rpoE} encoding $\sigma^E$ factor significantly down–regulated many genes in \textit{E. coli} such as genes encoding porins (Kabir et al. 2005). Porins are bacterial outer membrane proteins (Omps) that involve in transportation of molecules in and out of the cell (Nikaido 1994). Therefore, reduction of these proteins may influence the secretion of virulence factors of bacteria.

In the present study, we found that an outer membrane proteins (OmpN) in the \textit{rseA} mutant was decreased (Table 18), thus lower expression of the OmpN porin might reduce secretion of factors mediating hemolytic activity and virulence in shrimp model. Reduction of two additional proteins was observed in the \textit{rseA}– mutant relative to the wild type. These proteins were both of unknown function (unidentified and conserved hypothetical protein) (Table 18). Characterization of these proteins and their potential involvement in the hemolytic activity of \textit{V. harveyi} should be clarified in the future. Phosphomannomutase (PMM) was an enzyme required for LPS synthesis of \textit{P. aeruginosa} (Zielinski et al. 1991).
Alcohol dehydrogenase (ADH) is up regulated in *Zymomonas mobilis* in response to stress (An et al. 1991). Protease is a protein involved in stress response of *E. coli* (Ruiz and Silhavy 2005). In this study, increasing of these 3 proteins; PMM, ADH, and DegP, correlates with the presence of \( \sigma^E \) factor in some reports. Ramsey and Wozniak (2005) demonstrated that \( \sigma^E \) factor regulated gene encoding for PMM resulting in biosynthesis of alginate in *P. aeruginosa* (Ramsey and Wozniak 2005). In *S. Typhimurium*, transcription of gene encoding ADH was higher in wild-type strain than the *rpoE* mutant strain (Bang et al. 2005). In *E. coli* and other bacteria, \( \sigma^E \) factor regulates expression of protease (DegP) gene in stress condition (Ruiz and Silhavy 2005).

**Figure 4.7** Role of \( \sigma^E \) factor in periplasmic stress response of bacteria. In normal condition, \( \sigma^E \) factor (RpoE) binds to its negative regulator protein (RseA) resulting in no transcription of stress gene (A). Stress condition causes accumulation of misfolded proteins in the periplasm. RseA is degraded, free \( \sigma^E \) factor binds to RNA polymerase and activate transcription of genes involved in stress reduction (B).
Expression of RpoE, RseA and RseB were not detected in this study because molecular weight of RpoE and RseA proteins were less than 30 kDa (21.7 and 23.5 kDa, respectively) and the theoretical pI of RseB was more than 7 (pI=8.6), which were out of molecular weight and pI range investigated in this study.

In conclusion, we have demonstrated that mutations of \textit{rseA} and \textit{rseB} in \textit{V. harveyi} leads to a reduction in hemolytic activity on sheep blood agar plates and shrimp mortality that is concurrent with differential expression of 6 proteins including decreased expression of a porin (OmpN). In this study, a conceptual model to demonstrate RseA/B inhibits RpoE, which in turn inhibits OmpN, resulting in release of hemolytic enzymes is proposed (Figure 48). The role of \(\sigma^E\) factor to regulate the hemolytic activity has not been demonstrated in any bacteria. Thus, the role of \(\sigma^E\) factor in hemolytic activity and pathogenicity of \textit{V. harveyi} could be used to clarify the ability to lyses erythrocytes and virulence mechanism of other human pathogenic Vibrio spp. such as \textit{V. cholerae}, \textit{V. parahaemolyticus} and \textit{V. vulnificus} that possess hemolysin (LEC, TLH and VPL, respectively) similar to VHH hemolysin of \textit{V. harveyi}.

\textbf{Figure 48} A rough idea of a conceptual model to show RseA/B inhibiting RpoE (solid line), which in turn indirectly (dashed line) inhibits the porin OmpN (arrow down sign and up sign demonstrated down- and up regulated, respectively). \textit{rpoE} mutant would cause an overexpression of porin and possibly more hemolytic enzyme release (plus sign). \textit{rseA} mutant exhibited less porin, so less hemolytic enzyme release (minus sign).
Part III, isolation of marine bacteria that possess inhibitory activity against *V. harveyi*

*V. harveyi* is one of the important bacterial pathogens in cultured shrimp. Use of antibiotics to control this bacterium may lead to problems of drug resistance (Karunasagar et al. 1994). Antagonistic bacteria are being recognized as a useful strategy to control this pathogen (Moriarty 1998). In this study, we demonstrated that *B. subtilis* and *B. amyloliquefaciens* isolated from sediment could inhibit growth of *V. harveyi*.

*Bacillus* spp. is one of the most bacteria used against bacterial or viral disease in shrimp aquaculture because most of them possess antibacterial substances (Balcázar and Rojas–Luna 2007; Cladera–Olivera et al. 2004) and cause less effect on shrimp or environments (Leonel and Olmos–Soto 2006; Liu et al. 2009). *Bacillus* spp. has found to increase penaeid shrimp survival and decrease luminous vibrio densities (Moriarty 1998). Challenge of *V. harveyi* to shrimp that fed with *Bacillus* sp. as a probiotic revealed 74% relative survival (Phianphak et al. 1997). Inoculation of *B. subtilis* isolated from a common snook (*Centropomus undecimalis*) into rearing water resulted in elimination of *Vibrio* spp. from the snook larvae (Kennedy et al. 1998). Inoculation of *Bacillus* S11, resulted in greater survival of the post–larval *P. monodon* after challenged with pathogenic luminescent bacteria (Rengpipat et al. 1998). In India, 90% mortality reduction of *P. monodon* has been recorded after challenged with probiont *B. subtilis* against *V. harveyi* (Vaseeharan and Ramasamy 2003). *B. subtilis* UTM 126 produced antimicrobial activity against pathogenic *Vibrio* spp. and that shrimp mortality was reduced by treatment with this bacterium (Balcázar and Rojas–Luna 2007). *B. amyloliquefaciens* secreted a variety of enzymes and showed potential against *V. harveyi* under *in vitro* condition (Priest 1977). There is no report on the application of this bacterium to control *V. harveyi in vivo*. However, this bacterium was used as an antifungal agent against plant pathogen, *Collectotrichum lagenarium*, that caused watermelon anthracnose (Kim and Chung 2004).

*B. subtilis* and *B. amyloliquefaciens* isolated in this study are non–pathogenic organisms and exhibited effective inhibitory activity against *V. harveyi*. Although the mechanism of inhibition has not been demonstrated yet, it is possible to use these isolates to control *V. harveyi* in shrimp industry. Further study will be conducted to clarify their antimicrobial properties.
CHAPTER 5

CONCLUSION

Thailand is one of the world’s leading shrimp industries (Tanticharoen et al. 2008), however shrimp diseases cause economic losses. *V. harveyi* is an important pathogen of luminous vibriosis and causes mortality in shrimp ranges from 5–80% within a few days of infection (Kasomchandra et al. 1995). Understanding virulence mechanism of *V. harveyi* may lead to solve this problem. In this study, analysis of *V. harveyi* isolates from marine samples revealed no correlation between shrimp mortality and the ability of *V. harveyi* to produce phospholipase, lipase and chitinase. Interestingly, the significant correlation ($r = 0.972$, $p < 0.05$) between hemolytic activity and shrimp mortality was demonstrated. All *V. harveyi* isolates possess *vhh* hemolysin gene however some isolates did not exhibited the hemolytic activity. The present study demonstrated that hemolytic activity of *V. harveyi* was controlled by *rseA* and *rseB* genes (encoding $\sigma^E$ factor regulatory proteins) and mutation of these genes caused reduction of virulence in shrimp, which demonstrated by competition assay. This study is the first to address the relationship between $\sigma^E$ factor regulatory genes and hemolytic activity of bacteria. Influencing of $\sigma^E$ factor regulatory genes might affect the transcription of *ompN* gene resulting in reduction of OmpN (porin) involved in transportation of some factors essential for hemolytic activity. These observations provide a better understanding of the *V. harveyi* pathogenesis and may be useful for development some methods to prevent *V. harveyi* disease in shrimp aquaculture. Moreover, these finding may explain correlation of hemolytic activity of human pathogenic *Vibrio* spp. such as *V. cholerae*, *V. parahaemolyticus* and *V. vulnificus* and human diseases.

To minimize using antibiotics for management of luminous vibriosis, antagonistic bacteria were isolated from marine sediments. Two isolates, *B. subtilis* and *B. amyloliquefaciens* exhibited inhibitory activity against *V. harveyi* completely by co-culture assay. These *Bacillus* spp. are non-pathogenic and may be use to control *V. harveyi* in shrimp aquaculture.
REFERENCES


1. **Antibody solution**

   Centrifuge Anti-Digoxigenin-AP (vial 4) for 5 min at 10,000 × g prior to use. Add 4 µl of Anti-Digoxigenin-AP in 20 ml of working blocking solution.

2. **Blocking solution** (Always prepare fresh)

   Prepare 1× working solution by diluting 10× Blocking solution (vial 6) 1:10 with Maleic acid buffer.

3. **Color-substrate solution** (Always prepare fresh)

   Add 200 µl of NBT/BCIP stock solution (vial 5) to 10 ml of Detection buffer. Store in dark.

4. **Denaturation solution** (1.5 M NaCl and 0.5 M NaOH)

   a. NaCl | 87.75 g
   b. NaOH | 20 g
   c. Distilled water (dH$_2$O) to 1,000 ml

   Sterile by autoclaving. Store at room temperature.

5. **Detection buffer** (0.1 M Tris-HCl, 0.1 M NaCl; pH 9.5)

   a. Tris | 1.21 g
   b. NaCl | 0.58 g
   c. dH$_2$O | 80 ml

   Adjust pH to 9.5. Bring to volume to 100 ml with dH$_2$O. Sterile by autoclaving. Store at room temperature.

6. **EDTA, 0.5 M pH 8.0**

   Dissolve 186.12 g of Na$_2$EDTA in 800–900 ml of dH$_2$O. Adjust pH to 8.0 with 10 N NaOH. Add dH$_2$O to make 1 Liter. Autoclave 15 min at 121°C.

7. **Egg yolk emulsion, 50%**

   Wash fresh eggs with a stiff brush and drain. Soak eggs 1 h in 70% ethanol. Drain ethanol. Crack eggs aseptically and discard whites. Remove egg yolks with sterile syringe or wide-mouth pipette. Place yolks in sterile container and mix aseptically with equal volume of sterile 0.85% saline. Store at 4°C until use. When required, dilute 1:50 to a final concentration of 1% egg yolk emulsion before used.
8. **Ethidium bromide, 10 mg/ml**

Mix 1 g of ethidium bromide with 100 ml of dH$_2$O. Stir overnight. Store in the dark at room temperature.

9. **Gel loading buffer (0.25% bromophenol blue and 4.0% (w/v) sucrose), 6×**

Weigh out 25 mg bromophenol blue and 4 g sucrose. Make up volume to 10 ml with dH$_2$O. Store at 4°C.

10. **Maleic acid buffer (0.1 M Maleic acid, 0.15 M NaCl; pH 7.5)**

a. Maleic acid  
5.8 g
b. NaCl  
4.38 g
c. dH$_2$O  
400 ml

Adjust pH to 7.5 with NaOH (solid). Bring the volume to 500 ml with dH$_2$O. Sterile by autoclaving. Store at room temperature.

11. **Neutralization solution (1.5 M NaCl and 0.5 M Tris; pH 7.2)**

a. NaCl  
87.66 g
b. 0.5 M Tris, pH 7.2  
60.57 g
c. dH$_2$O to  
1,000 ml

Sterile by autoclaving. Store at room temperature.

12. **Phenol:Chloroform**

Mix an equal volume of phenol and chloroform (1:1). Extract 3~4 times with 0.1 M Tris–HCl pH 7.6. Store under 0.01 M Tris–HCl pH 7.6 at 4°C in the dark.

13. **Phosphate–Buffered Saline (PBS), pH 7.4**

a. NaCl (Lab–Scan)  
7.650 g
b. Na$_2$HPO$_4$, anhydrous (Merck)  
0.724 g
c. KH$_2$PO$_4$ (Merck)  
0.210 g
d. dH$_2$O  
1,000 ml

Dissolve ingredients in distilled water. Adjust pH to 7.4 (with 1 N NaOH). Autoclave 15 min at 121°C.
14. RNase (DNase free), 10 mg/ml

Mix 100 mg of RNase A with 10 ml of 10 mM Tris pH 7.5, 15 mM NaCl. Heat to 100°C for 15 min. Allow to cool to room temperature (overnight). Store at -20°C.

15. Sheep blood agar

Mix 4 g of Tryptic Soy Agar and 0.5 g of NaCl with 100 ml of dH2O. Autoclave 15 min at 121°C and cool to 50°C. Add 5 ml defibrinated sheep blood to 100 ml agar. Mix and dispense 10 ml portions to 15 x 100 mm petri dishes.

16. Sodium acetate, 3 M pH 5.2/7.0

Mix 4.08 g of sodium acetate-3H2O with 8 ml of dH2O. Adjust pH to 5.2/7.0 with glacial acetic acid. Add dH2O to 10 ml. Autoclave 15 min at 121°C.

17. Sodium dodecyl sulfate (SDS) (also called sodium lauryl sulfate), 10%

Mix 1 g of SDS with 9 ml of dH2O. Heat to 68°C. Adjust pH to 7.2 with HCl. Add dH2O to 10 ml.

18. Standard saline citrate (SSC), 20× (3.0 M NaCl and 0.3 M Sodium citrate)

a. NaCl 175.3 g
b. Sodium citrate 88.2 g
c. dH2O 800 ml

Adjust the pH to 7.0 with a few drops of a 14 N HCl solution. Adjust the volume to 1 liter. Sterile by autoclaving. Store at room temperature.

19. Tris–borate–EDTA (TBE) buffer, 10×

a. Tris base 108 g
b. Boric acid 55 g
c. Sterile distilled water 800 ml
d. 0.5 M EDTA, pH 8.0 40 ml

Adjust the volume to 1 liter.

20. Tris EDTA (TE) buffer pH 8.0

Mix 1 ml of 1 M Tris–HCl pH 8.0 (10 mM), 200 µl of 0.5 mM EDTA pH 8.0 (1 mM), and 98.8 ml of dH2O.
21. **Washing buffer** (0.1 M Maleic acid, 0.15 M NaCl, 0.3% (v/v) Tween 20)
   
a. Maleic acid  
   b. NaCl  
   c. dH₂O  
   
   Adjust pH to 7.5 with NaOH (solid). Bring the volume to 500 ml with dH₂O. Sterile by autoclaving. Allow to cool to room temperature and add 1.5 ml of Tween20. Store at room temperature.
1. **Mini-scale extraction of total genomic DNA from *Vibrio* spp.**

   1.1 Grow the organism in 5 ml of LB broth at 37°C for 6~8 h with shaking (150 rpm).
   
   1.2 Inoculate 10 µl of bacterial culture into fresh 5 ml of LB broth and incubate with shaking at 37°C overnight.
   
   1.3 Harvest the cells by centrifugation at 10,000 × g for 3 min.
   
   1.4 Suspend the cell pellet in 1 ml of PBS, pH 7.4 and transfer to a 1.5-ml microcentrifuge tube (chloroform-resistant) (Eppendorf).
   
   1.5 Harvest the cells by centrifugation for 3 min.
   
   1.6 Suspend the cell pellet in 300 µl of PBS–EDTA (240 µl PBS and 60 µl of 0.5 M EDTA)
   
   1.7 Add 150 µl of 10% SDS, mix and then incubate at room temperature for 10 min. Confirm that all cells are lysed.
   
   1.8 Add 450 µl of phenol–chloroform solution (1:1) and mix vigorously, then centrifuge for 2 min at room temperature.
   
   1.9 The upper aqueous phase was carefully collected to a 1.5-ml microtube.
   
   1.10 Add 40 µl of 3 M NaOAc and 1 ml of cold absolute ethanol and mix carefully. DNA will aggregate as white flocculation.
   
   1.11 The precipitated DNA was obtained by centrifugation for 5 min, wash twice with 70% cold EtOH and allow to air-dried for 15 min.
   
   1.12 Dissolve DNA in a 0.3 ml of distilled water.
   
   1.13 Add 60 µl of 50 µg/ml RNase and incubate at 37°C for 30 min.
   
   1.14 Repeat step 8 to 11 (phenol–chloroform extraction) and dissolve dried DNA in TE buffer.
   
   1.15 Measure the concentration of DNA at OD 260 nm (1 OD_{260nm} = 50 µg/ml of DNA).
   
   1.16 Store the stock DNA solution at −20°C until used.
2. Southern blotting and hybridization
(Modified from Current Protocols in Molecular Biology, 1993)

Prepare the gel

2.1 Digest 2 µg of genomic DNA of *V. harveyi* with EcoRI to a final volume of 30 µl, incubate at 37ºC for 24 h in water bath

2.2 Prepare a 1% agarose gel and load samples and a DNA molecular weight marker (1kb ladder) onto gel and electrophoreses samples in 1× TBE buffer for 12 to 24 h.

2.3 After electrophoresis, remove gel from box. Place gel in ethidium bromide staining solution (25 µl of 10 mg/ml ethidium bromide in 500 ml water) for 30 min and distilled water for an hour. Photograph the gel with a ruler laid alongside the gel so that band position can later be identified on the membrane.

2.4 Add 500 ml denaturation solution to tray and shake as before for 20 min. Replace with fresh denaturation solution and shake for a further 20 min.

2.5 Pour off the denaturation solution and rinse the gel with distilled water. Add 500 ml neutralization solution, shake as before for 20 min, then replace with fresh neutralization and shake for a further 20 min.

Set up the transfer (Figure 49) (Brown 2001)

2.6 Cut a piece of nylon membrane such that it is 3 mm smaller in both dimensions than the gel. Pour distilled water ~0.5 cm deep in glass dish and wet the membrane by placing it on the surface of the water. Allow the membrane to submerge, then leave for 5 min.

2.7 Cut 3 to 5 sheets of Whatman 3MM paper into pieces that are 7 mm smaller in both dimensions than the piece of nylon membrane. This should result in a 1- or 2-mm stack of cut paper.

2.8 Prepare a wick by cutting one piece of Whatman 3MM ~2 cm wider than the width of the gel and 30 to 40 cm long. Place several hundred milliliters of 10× SSC in a large tray. Wet the wick thoroughly in the 10× SSC, put a glass plate over the tray and place wick on plate with both ends of wick hanging over plate into the 10× SSC. Remove air bubbles trapped between the wick and glass plate by rolling a pipette back and forth over wick.

2.9 Lift the gel out of the neutralization solution, allow most of the liquid to drip off the gel and lay gel on top of Whatman 3MM wick. Remove air bubbles trapped
between gel and wick. Remove the nylon membrane filter from its tray and lay it on top of the gel, making sure that the nylon filter does not overhang the gel. Remove trapped air bubbles.

2.10 Flood the surface of the membrane with 10× SSC. Place five sheets of Whatmann 3MM paper on top of the membrane. Make sure that the piece of 3MM paper does not overhang the membrane and remove trapped air bubbles.

2.11 Cut paper towels to the same size as the membrane and stack these on top of the Whatmann 3MM papers to a height of ~4 cm.

2.12 Lay a glass plate on top of the structure and place a weight on top to hold everything in place. Leave overnight.

Figure 49 Transfer pyramid of Southern Blotting.
[Source: From Brown (1993) with slightly modification]

Dissemble the transfer pyramid

2.13 Remove the paper towels and filter papers to recover the membrane. Mark in pencil the position of the wells on the membrane and ensure that the up–down and back–front orientations are recognizable.
Dissemble the transfer pyramid

2.14 Place the membrane on Whatmann 3MM–paper soak with 10× SSC. Wrap the membrane with UV–transparent plastic wrap, place DNA–side–down on a UV transilluminator (254–nm wavelength) and irradiated for 3 min. UV–crosslink the wet membrane without prior washing. After the UV–crosslinking, rinse the membrane briefly in double distilled water and allow to air–dry.

2.15 Use the membrane immediately for prehybridization or store the membrane dry between sheets of Whatmann 3MM paper for several months at room temperature or at 2–8°C.

Prehybridization, hybridizing, and washing the filter

2.16 The hybridization was carried out under high–stringency conditions (at 42°C for the vhh and hhl probes) using DIG High Prime DNA Labeling and Detection Starter kit I (Roche Diagnostics).

2.17 Place the filter in a sealable bag. Add 15 ml of pre–heated DIG Easy Hyb (10 ml/100 cm² membrane) solution and prehybridize filter at hybridization temperature for 30 min in Micro Hybridization Incubator (Robbins Scientific).

2.18 Denature DIG–labeled DNA probe (about 25 ng/ml) by boiling for 5 min and rapidly cooling in ice.

2.19 Add denatured DIG–labeled DNA probe to pre–heated DIG Easy Hyb (3.5 ml/100 cm² membrane) and mix well but avoid foaming.

Note: DIG Easy Hyb containing DIG–labeled DNA probe can be store at −15 to −20°C and can be reused several times when freshly denatures at 68°C for 10 min before use.

2.20 Pour off prehybridization solution and add 6 ml of probe/hybridization mixture to membrane, incubate at appropriate temperature overnight with gentle agitation in hybridization incubator.

2.21 Wash 2× for 5 min each in 2× SSC, 0.1% SDS at room temperature under constant agitation.

2.22 Wash 2× for 5 min each in 0.5× SSC, 0.1% SDS (prewarmed to wash temperature) at 65°C under constant agitation.

Immunological detection

2.23 After hybridization and stringency washes, rinse membrane briefly 5 min in washing buffer.
2.24 Incubate with agitation for 30 min in 100 ml working Blocking solution.

2.25 Incubate with agitation for 30 min in 20 ml Antibody solution.

2.26 Wash 2× for 5 min each in 100 ml Washing buffer.

2.27 Equilibrate 5 min in 30 ml Detection buffer.

2.28 Incubate membrane in 10 ml freshly prepared color substrate solution in an appropriate container in the dark. Do not shake during color development. The reaction is usually complete after 16 h.

2.29 Stop reaction, when desired band intensities are achieved, by washing the membrane for 5 min with 50 ml of sterile ddH₂O or with TE buffer.

Note: If the membrane is to be reprobed. Do not allow the membrane to dry at any time, store in sealed plastic bag with TE buffer to maintain the color. If the membrane is not to be reprobed, dry the membrane at room temperature for storage.

2.30 Results can be documented by photocopying the wet filter or by photography.
Image analysis by the ImageMaster 2-D platinum software

1. Create a new workspace

1.1 Double click the ImageMaster icon to open the program window.
1.2 Click the Workspace tab below the ImageMaster toolbar to display the Workspace window.
1.3 Click the New icon in the Workspace toolbar to create a workspace.
1.4 In the Create New Workspace box, specify the Workspace Name, Location and Comment (Figure 50). Click OK.
1.5 Right click on the Workspace Name and choose New Project from the contextual menu. Enter a Project Name, Location and Comment. Click OK.
1.6 Click on the Save icon in the tool bar of the Workspace window to save workspace.

Figure 50 Windows of workspace and add new project.
2. Handle gels

Gels can be handled individually or simultaneously.

- **Hand tool**: To move gels and drag the gels to the desired location.
- **Magnify tool**: To either zoom in (left mouse button) or zoom out (right mouse button).
- **Region tool**: To select only a portion of the image and define the interesting area.
- **Spot tool**: To select or edit individual spots.

3. Importing a new gel

3.1 Right click on the **Gels** folder (Figure 51) and choose **Add Gels** from the contextual menu.

3.2 In the **Add Gels** box, browse the directory where the image file is located, click **Open** on the selected image.

3.3 In the **Gel Properties** box, choose the **Staining** that was applied to the gel. Click **OK**.

![Image of ImageMaster 2D Platinum workspace](image)

![Image of gel properties window](image)

**Figure 51** Windows of importing a new gel.
4. Adjust contrast

4.1 Select one or more gels.

4.2 Draw a region in one or more gels with the Region tool.

4.3 Choose Show > Gel > Adjust Contrast from the menu (Figure 52) to opens the Image Display Setting window.

4.4 Modify the contrast and brightness of the image by moving the left or right borders of the slider below the histogram or by changing the bending parameter.

4.5 Click OK to apply the contrast adjustments to the selected gels and click File > Save > All Changes.

Figure 52 Windows of gel display setting.

5. Spot detection

5.1 Select all visible gels (CTRL+A) or gels which would like to display.

5.2 Draw a region with the Region tool on one or more selected gels in areas with representative spots.

5.3 Choose View > Spots > Outlined to visualize the spot borders (Figure 53).

5.4 Choose Edit > Spots > Detect.

Figure 53 Windows of displaying spot shape and spot detection.
5.5 Adjust the detection parameters by adjust the Smooth parameter to detect all real spot and correctly split any overlapping ones (Figure 54).

5.6 To estimate the range of parameters to use with the images, Choose View > Global > Cursor Information Window to display the information on spots located at the position of the mouse cursor. Move cursor over some spots that consider being noise or artifacts. Look at the Saliency values for these spots.

5.7 Enter a Saliency value in the spot detection window that is just above that of the spots to be filtered out. All spots with Saliencies lower than the given threshold will be removed.

5.8 In some gels, very small but intense artifacts (for example dust particles) remain detected and cannot be eliminated with the Saliency parameter without removing real spots. Such artifact spots can be removed by setting an appropriate Min Area value (expressed in number of pixels).

5.9 When the detection preview is satisfactory click on OK to detect all spots in the selected gels using the parameter values that were set.

5.10 Choose File > Save > All Changes to save the spot detection results.

Figure 54 Windows of spot detection parameter and cursor information.

6. Editing spots

6.1 Select the spots to be edit by clicking Spot icon.

6.2 Choose Edit > Spots > Edit enabled (Figure 55), icon changed as.

6.3 Edit spots by split, grow, reduce, or merge.

6.4 To delete undesired spot (for example dust particles), select the spot to be deleted and choose Edit > Spots > Delete from the menu.

6.5 Choose File > Save > All Changes to save the edit spot results.
Figure 5.5 Windows of spot editing.

7. Matching gels

Matching gels is a key operation in 2-DE image analysis. The matching algorithm compares two gel images to find pairs of related spots (therefore spots need to be detected first). ImageMaster can match two or more gels. Matching several gels means picking out a Reference Gel and then successively matching each gel with the reference gel. This is done automatically.

All spots that are paired with a given spot in the reference gel form a Group. The spot group is an essential concept in the software. It is the basic element for analyzing spot variations across gels, for producing reports and histograms, as well as for performing statistical and clustering analysis.

7.1 Define Landmarks by using the SHIFT key, select the same spot on all gels with the Spot tool.

7.2 Choose Edit > Annotations > Add Label from the menu.

7.3 Choose the category Landmark. Click OK.

7.4 Supply a name such as L1. Click OK.

7.5 Select the reference gel for matching in the pop-up dialog box (choose a high quality gel with a large number of spots) and click OK.

7.6 Choose Edit > Matches > Match Gels.

7.7 Show the pair vectors between the spots in the displayed gel and the matched spots in the master image by Choose Show > Matches > Show Vectors. Blue vectors are shown between matched spots in the displayed gel and the master gel.

7.8 Choose File > Save > All Changes to save all the modifications.
8. Reports

8.1 Select a region or spot.

8.2 Choose Reports > 3D View to display a 3D View (Figure 56).

![Figure 56 Windows displaying 3D view of spots.](image)

8. Data analysis

8.1 Select all visible gels (CTRL + A) and select all groups by choosing Select > Groups > All.

8.2 Display a 3D view for the corresponding spots on gels and considering the protein differences based on 3D view.

8.3 Choose File > Save.
APPENDIX D
Identification of *Bacillus* spp. by 16S rRNA gene sequence analysis

1. Isolation of *Bacillus* spp. chromosomal DNA

   Genomic DNA was purified using a protocol from Gentra Puregene Yeast/Bact. Kit (QIAGEN) with slightly modifications as follow:

   1.1 Grow the organism in 0.5 ml of LB broth overnight at 30°C with shaking (150 rpm).
   
   1.2 Harvest the cells by centrifugation at 15,000 × g for 5 min.
   
   1.3 Suspend the cell pellet in 500 µl of PBS, pH 7.4 and transfer to a 1.5-ml microcentrifuge tube.
   
   1.4 Vortex and harvest the cells by centrifugation for 4 min.
   
   1.5 Carefully discard the supernatant by pipetting or pouring.
   
   1.6 Suspend the cell pellet in 300 µl of PBS, and pipet up and down.
   
   1.7 Add 50 µl of Proteinase K (20 mg/ml) and 20 µl of Lysozyme (10 mg/ml), mix by inverting 25 times. Incubate for 30 min at 55°C. Centrifuge at 15,000 × g for 3 min and discard the supernatant.
   
   1.8 Add 300 µl of Cell Lysis Solution and pipet up and down to lyse the cells. Then incubate at 80°C for 10 min. Confirm that all cells are lysed.
   
   1.9 Add 1.5 µl RNase A solution, and mix by inverting 25 times. Incubate for 45 min at 37°C.
   
   1.10 Incubate for 1 min on ice to quickly cool the sample.
   
   1.11 Add 100 µl of Protein Precipitation Solution, and vortex vigorously 15,000 × g for 20 s. Centrifuge at 15,000 × g for 3 min.
   
   1.12 Pipet 300 µl of isopropanol into a clean 1.5 microcentrifuge tube and add the supernatant from the previous step by pouring carefully.
   
   1.13 Mix by inverting gently 50 times.
   
   1.14 Centrifuge for 10 min at 15,000 × g and carefully discard the supernatant.
   
   1.15 Add 300 µl of cold 70% ethanol and invert several times to wash the DNA pellet. Centrifuge for 1 min at 15,000 × g and carefully discard the supernatant. Allow to air-dried for up to 15 min.
   
   1.16 Add 100 µl of DNA Hydration Solution and vortex 5 s to mix. Incubate at 65°C for 15 min to dissolve DNA. Incubate at room temperature overnight. Store the stock DNA solution at −20°C until used.
2. Amplification of 16S rRNA gene

To obtain products for 16S rRNA gene sequencing, PCR amplification of extracted DNA was performed with universal primers (Table 20) (Lane 1991). PCR analysis was performed in 20 µl of reaction mixture containing 2 µl of 10× PCR buffer (Promega Corp.), 0.5 µl of template DNA, 1.6 µl of 25 mM MgCl₂, 0.5 µl each of 10 µM 27F and 1492R primers, 0.1 µl of Tag polymerase (Promega Corp.), and 2 µl of 2.5 mM dNTPs. PCR analysis was performed using a Gene Amp PCR thermocycler, and the reaction involved 94°C for 3 min, 35 cycles of 94°C for 45 s, 50°C for 45 s and 72°C for 2 min, followed by 72°C for 5 min. The amplification products were subjected to electrophoresis in 1% agarose gel. PCR products were extracted from gel, purified with QIAquick Gel Extraction Kit (QIAGEN) and submitted to Macrogen Inc. (Seoul, Korea) for single primer extension DNA sequencing with primer 27F (Table 20) and 800R (5’-TACCAGGGTATCTAAATCC-3’) (Lane 1991).

Table 20 Universal primers used for 16S rRNA gene amplification and sequence analysis.
M= A or C; Y= C or T

<table>
<thead>
<tr>
<th>Primers</th>
<th>Primer sequence 5’→ 3’</th>
<th>Product size (bp)</th>
</tr>
</thead>
<tbody>
<tr>
<td>27F</td>
<td>AGAGTTTGATCMTGGCTCAG</td>
<td>1,500</td>
</tr>
<tr>
<td>1492R</td>
<td>TACGGYTACCTTGTTACGACTT</td>
<td></td>
</tr>
</tbody>
</table>

3. DNA sequence analysis

16S rRNA gene sequences were compared with those available in the GenBank using BLAST software (www.ncbi.nlm.nih.gov/BLAST/). Identification to the species level was defined as a 16S rRNA gene sequence similarity of 100% with that of the prototype strain sequence in GenBank.
VITAE

Name Miss Pimonsri Rattanama
Student ID 4803001

Educational Attainment

<table>
<thead>
<tr>
<th>Degree</th>
<th>Name of Institution</th>
<th>Year of Graduation</th>
</tr>
</thead>
<tbody>
<tr>
<td>B.Sc. (Microbiology,</td>
<td>Prince of Songkla University</td>
<td>2005</td>
</tr>
<tr>
<td>Second class honor)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Scholarship Awards during Enrolment

The Royal Golden Jubilee Ph.D. scholarship from the Thailand Research Fund, Bangkok, Thailand

List of Publications and Proceedings


